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RESUMEN 

 

 

 
Los microcontroladores MSP430 contienen una CPU de 16-bits de arquitectura 

RISC de señal combinada de menor consumo energético y proporciona la 

mejor solución para una amplia gama de dispositivos portátiles que requieren 

un bajo consumo de energía. Texas Instruments proporciona toda la 

información requerida sobre las caracteristicas del Microcontrolador MSP430 

incluyendo documentos técnicos, instrumentos, y el software de desarrollo 

correspondiente. 

 

La herramienta de emulación Flash (FET) no solo permite programar al 

microcontrolador si no que también permite verificar el código de usuario en 

tiempo de ejecución, de esta manera se puede comprobar el funcionamiento 

del diseño implementado con el uso del microcontrolador MSP430F2013, 

además se puede efectuar la depuración del código de programa utilizando la 

función de “debug” que esta herramienta incluye. 

 

El presente documento está conformado por cuatro capítulos e incluye la 

sección de anexos. En el primer capítulo se analiza y detalla las características 

más importantes del microcontrolador MSP430F2013 que será utilizado como 

dispositivo central del prototipo de propósito general, además de una breve 

explicación de la herramienta de desarrollo a utilizarse, en este caso el eZ430-

F2013, finalmente se presenta y analiza el diseño de cada uno de los módulos 

que serán implementados como parte del prototipo final.  

 

En el segundo capítulo se describe el software requerido para el 

funcionamiento del prototipo, es decir, se detalla el software creado para la 

interacción entre el PC y el Prototipo y también se detalla el software requerido 

por cada uno de los módulos de hardware diseñados anteriormente. Además 
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se describe el ejemplo aplicativo utilizado para ilustrar el desarrollo del 

prototipo. 

 

En el tercer capítulo se detalla la construcción del prototipo de acuerdo a los 

diseños desarrollados en el capitulo uno así como todas las pruebas 

ejecutadas de acuerdo con el protocolo de pruebas propuesto.  

 

En el cuarto capítulo se presentan las conclusiones y recomendaciones que se 

obtienen de este proyecto. 

 

Finalmente en los anexos se incluye la información que describe en mayor 

detalle algunas características del microcontrolador o del software relacionado 

con el mismo, así como de información relacionada con este proyecto.  



iii 
 

 

 

 

 

PRESENTACIÓN 

 
 

 
 
La razón por la cual se ha desarrollado este proyecto es la de mostrar las 

nuevas tecnologías que están disponibles en el mercado y de las cuales se 

pueden echar mano para implementar diseños que se requieren tanto en la 

industria como en el hogar. 

 

Otra razón del proyecto es la de crear un sistema que permita el control de un 

proceso sin llegar a un costo muy elevado, utilizando herramientas que ofrecen 

mayores facilidades para el desarrollo de cualquier proyecto. 

 

El objetivo del proyecto es construir un prototipo de propósito general utilizando 

el microcontrolador MSP430F2013 de la empresa Texas Instruments, el cual 

permita manipular un proceso que el usuario determine de acuerdo a la 

programación que se establezca sobre el mismo. 

 

Para facilitar esta tarea se ha integrado en el prototipo un Display que indica el 

estado del prototipo y también un teclado con el cual se puede acceder a los 

menús integrados en el. 

 

Para todo ello, se ha desarrollado el software, que permite el manejo de cada 

uno de los módulos del prototipo, y otra parte la compone un programa que 

sirve de interfaz entre el usuario y el prototipo desde un computador 

permitiéndole acceder a muchas más opciones de interacción que simplemente 

utilizar el prototipo como un dispositivo “solitario” 

  

El prototipo tiene 4 entradas analógicas y 4 salidas digitales acopladas a relés. 

El programa en PC puede acceder a la información de cada entrada y también 

puede alterar el estado de las salidas, así como, guardar registros de toda 
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actividad del prototipo. El prototipo permite el almacenamiento de datos de 16 

bits cada 10 minutos, lo que puede resultar muy útil en procesos que requieran 

vigilancia de estado de un sensor. 

 

El programa en el PC permite no solo acceder al prototipo, también permite que 

el prototipo controle el estado del PC, gracias a comandos que el programa 

puede ejecutar de acuerdo al valor que tenga cada entrada y a la configuración 

que el usuario haya realizado sobre cada una. 

 

El prototipo implementado demuestra las amplias posibilidades de aplicación 

de los microcontroladores MSP430F2012 / MSP430F2013 y se espera que 

constituya una guía para aquellos interesados en aprender y desarrollar nuevas 

aplicaciones basados en esta tecnología. 
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CAPITULO 1. DISEÑO CIRCUITAL Y HERRAMIENTAS 

DE HARDWARE  

 

Para el desarrollo del presente trabajo se ha tomado como base la 

documentación técnica del fabricante, en especial los siguientes archivos 

provistos por la empresa Texas Instruments; razón por la que en el desarrollo 

del trabajo no se citan estas referencias: 

 

• slau176.pdf - eZ430-F2013 Development Tool - User's Guide 

• slau012a.pdf – MSP430x3xx User’s Guide 

• slau144e - MSP430x2xx User’s Guide 

• slas491a.pdf 

 

1.1 CARACTERÍSTICAS DE LOS MICROCONTROLADORES DE 

TEXAS INSTRUMENTS 

 

1.1.1  DESCRIPCIÓN GENERAL 

 

Los MCUs (MicroController Unit – Unidad Microcontroladora)  que están 

basados en procesadores tipo RISC (Reduced Instruction Set Computer – Set 

Reducido de Instrucciones para Computadoras) de 16-bits, son la solución 

industrial de menor consumo entre microcontroladores de 8 o 16 bits 

alimentados por baterías, su principal aplicación incluyen la medición, la 

instrumentación portátil y los sensores inteligentes. 

 

La familia de microcontroladores MSP430F2xx (MSP430F2013) permiten 

procesar hasta 16 Millones de Instrucciones Por Segundo (16 MIPS) usando 

voltajes que van entre 1.8 a 3.6 V. Dentro de sus opciones incluyen un 

oscilador de bajo poder integrado en el chip con una variación de ±1 %, 

resistencias internas pull-up/pull-down y opción de chips con un número 

reducido de terminales. 
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La familia del MSP430 de Texas Instruments son microcontroladores de muy 

bajo consumo de energía que constan de varios modelos presentando sets 

diferentes de dispositivos periféricos dirigidos a sectores específicos para 

aplicaciones diversas. La arquitectura esta combinada con cinco modos de bajo 

consumo de energía que es optimizada para lograr una vida extendida de la 

batería en aplicaciones portátiles de medición. El oscilador controlado 

digitalmente (DCO – Digitally Controller Oscillator) permite “despertar” al 

microcontrolador desde los modos de bajo consumo de energía al modo de 

ejecución en menos de 1 us. El dispositivo contiene una CPU (Central 

Processing Unit – Unidad de Procesamiento Central) de 16 bits de arquitectura 

RISC, registros de 16 bits, y generadores de constantes lo que permite mejor 

eficiencia de código.  

 

1.1.2  CARACTERÍSTICAS TÉCNICAS GENERALES 

 

La familia de microcontroladores MSP430x20xx y en especial el 

microcontrolador F2013 poseen las siguientes características técnicas, que se 

indican a continuación y que se presentan en mayor detalle en los literales 

siguientes: 

 

• Rango de consumo de alimentación entre 1.87 a 3.6 Voltios. 

• Tiene un consumo muy bajo de corriente y por lo tanto de potencia: 

o De 220uA en Modo Activo con un voltaje de 2.2 Voltios a una 

frecuencia de trabajo de 1Mhz. 

o De 0.5uA en Modo de Espera (Standby). 

o De 0.1uA en Modo Apagado o de Retención de RAM (OFF). 

• En total posee 5 modos de ahorro de energía. 

• Paso al Modo Activo del Modo de Espera en menos de 1us. 

• Arquitectura del CPU tipo RISC de 16 bits con un Tiempo de Ciclo de 

Instrucción de 62.5ns. 

• Modulo de configuraciones básica de reloj: 

o Reloj interno de hasta 16MHz con 4 frecuencias calibradas en +/-1%. 
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o Oscilador LF (Low Frecuency – Baja Frecuencia) interno de bajo 

consumo. 

o Cristal Oscilador externo de 32KHz. 

o Fuente externa de reloj digital. 

• Contador de 16 bits con 2 registros de captura o comparación. 

• Detector de sobre-voltaje (Brownout Detector) 

• Permite ser programado simultáneamente con otros microcontroladores 

gracias al uso de “tableros” especiales para producción en serie. 

• No se requiere voltaje externo para la programación del microcontrolador 

• Protección del código programado mediante un fusible de seguridad 

• Lógica de emulación integrada en el chip con la interfaz Spy-Bi-Wire 

• Memoria Flash incluida: 2KB + 256B, 128B de Memoria  RAM 

• Disponible en un empaquetado de 14 terminales plástico Small-Outline de 

empaquetado fino (TSSOP) 

• Para el microcontrolador MSP430F2013 (F2013) se tiene: 

o Un conversor Análogo / Digital tipo Sigma – Delta con entradas PGA 

diferenciales y referencias internas. 

o Interface Serial Universal (USI – Universal Serial Interface) que 

soporta SPI (Serial Peripherical Interface) e I2C (Inter-Integrated 

Circuit) 

 

1.1.3  DESCRIPCION DE LA CPU. 

 

Todas las operaciones, así como las instrucciones, son realizadas por el CPU 

del microcontrolador MSP430 como operaciones de registro en conjunción con 

siete modos de direccionamiento para el operando de origen y cuatro modos de 

direccionamiento para el operando de destino. La CPU está integrada con 16 

registros que proveen reducción del tiempo de ejecución de cada instrucción. El 

tiempo que lleva la operación registro-a-registro es de un ciclo del reloj de la 

CPU. Los dispositivos periféricos están conectados a la CPU mediante los 

buses de datos, de dirección y de control, y pueden ser accedidos como si se 

tratara de una dirección de memoria cualquiera, es decir, se puede usar 

cualesquiera de las instrucciones disponibles. 
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1.1.4  REGISTROS DEL MICROCONTROLADOR 

 

El microcontrolador incorpora dieciséis registros de 16 bits. R0 a R3, son 

dedicados como contador de programa (PC - Program Counter), Puntero del 

Stack (SP - Stack Pointer), Registro de estado (SR - Status Register) y un 

Generador de Constantes (CG - Constant Generator) respectivamente. Los 

registros restantes R4 a R15 funcionan como registros de uso general. En la 

figura 1.1 se muestra un diagrama de los registros de la CPU y su 

interconexión. 

 

Figura 1.1: Registros del CPU. (Fuente: Texas Instruments) 

 

1.1.4.1 El Contador de Programa (PC) 

 

El Contador de Programa de 16 bits (PC / R0) contiene la dirección de memoria 

donde se encuentra la siguiente instrucción a ser ejecutada. Cada instrucción 
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requiere un número par de bytes (dos, cuatro, o seis), y el PC es incrementado 

en ese número de bytes. 

 

1.1.4.2 Puntero de Pila (SP) 

 

El puntero de la pila (SP/R1) es usado por el microcontrolador para almacenar 

las direcciones de retorno de llamado de subrutinas e interrupciones. Usa un 

esquema de pre-decremento, post-incremento, en el cual, su mayor ventaja es 

que el elemento que se encuentra en la parte más alta de la pila está 

disponible. Además, el SP puede ser usado por software. El SP es inicializado 

en la RAM por el usuario, y está alineado en direcciones pares. 

 

1.1.4.3 El Registro de Estado (SR) 

 

El registro de estado (SR) contiene los siguientes bits de estado del CPU, los 

cuales son detallados en la tabla 1.1. La figura 1.2 muestra la distribución de 

los bits dentro del registro R2. 

• V   bit de Desbordamiento 

• SCG1   bit 1 de control del generador de reloj del sistema 

• SCG0   bit 0 de control del generador de reloj del sistema 

• OscOff  bit de “Apagado” del Cristal Oscilador  

• CPUOff  bit de “Apagado” de la CPU 

• GIE   bit de “Habilitación” de la Interrupción General (GIE) 

• N   bit “Negativo”  

• Z   bit “Cero” 

• C    bit “Carry” 

 

Bit Descripción 

V 

Bit de Desbordamiento: Activado si el resultado de una operación 

excede el rango de la variable (incluido el signo), válido para 

operaciones “Byte” y “Word”. 

SCG1, 

SCG0 

Estos bits controlan 4 estados de actividad del reloj de sistema y por lo 

tanto influye en el funcionamiento del procesador del sistema. 

OSCOFF 
Si es puesto a 1, el oscilador externo entra en modo de “apagado”, 

todas las actividades cesan, aunque el contenido de la RAM, los 
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registros de los periféricos y los registros en general se mantienen. Salir 

de este modo es posible solo si se habilita las interrupciones externas 

cuando se ha habilitado el bit GIE o usando interrupciones del tipo NMI 

(no enmascarable).  

CPUOFF 

Si es puesto a 1, la CPU entra en modo de “apagado”, la ejecución de 

programa se detiene, el contenido de la memoria RAM, los registros de 

los periféricos y especialmente los periféricos habilitados permanecen 

activos. Salir de este modo es posible usando cualquiera de las 

interrupciones habilitadas. 

GIE 

Si esta puesto a 1, todas las interrupciones enmascarables son 

controladas. Si esta deshabilitado, todas las interrupciones 

enmascarables son ignoradas. El bit GIE es borrado por la interrupción 

y puesto a 1 por la instrucción RETI o por cualquier otra instrucción que 

habilite este bit 

N 

Puesto a 1 si el resultado de una operación es negativo. 

Operación WORD: N es igual al valor del bit 15 del resultado 

Operación BYTE: N es igual al valor del bit 7 del resultado 

Z Puesto a 1 si el resultado de cualquier operación es “0”  

C 
Puesto a 1 si el resultado de una operación produce un “Carry”. 

Algunas instrucciones modifican este bit usando el “inverted zero bits” 

Tabla 1.1: Descripción de los bits de estado (SR). (Fuente: Texas Instruments) 

 

Figura 1.2: Ubicación de los bits de estado en el registro (SR/R2). (Fuente: 

Texas Instruments) 

 

Nota:  los bits de estado V, N, Z y C son cambiados únicamente por ciertas 

instrucciones. En el anexo B.6 se encuentra información adicional de las 

instrucciones y los bits que estas modifican. 

 

1.1.4.4 Los Registros Generadores de Constantes CG1 y CG2 

 

Las seis constantes comúnmente usadas son generadas con los Registros 

Generadores de Constantes R2 y R3, sin requerir una palabra de 16 bits 
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adicional de código de programa. Las constantes son seleccionadas con los 

modos de direccionamiento del registro de origen (As), como se describe en la 

tabla 1.2. 

 

 

Tabla 1.2: Valores de los Generadores de Constantes CG1, CG2. (Fuente: 

Texas Instruments) 

Las ventajas de los Generadores de Constantes son: 

• No requiere de instrucciones especiales 

• No requiere de código adicional para las seis constantes 

• No requiere de código de acceso a memoria para obtener la constante 

El ensamblador usa el generador de constantes automáticamente si una de las 

seis constantes es utilizada como un operando inmediato de Origen. Los 

registros  R2 y R3, cuando son usados en el modo de constantes, no pueden 

ser direccionados explícitamente. 

 

1.1.4.5 Registros de propósito general R4 a R15 

 

Los doce registros, R4 a R15, son registros de propósito general. Todos ellos 

pueden ser utilizados como registros de datos, punteros de dirección, o pueden 

indexar valores y pueden ser accedidos mediante instrucciones de byte o 

palabra como se muestra en la figura 1.3. 
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Figura 1.3: Operaciones Registro-Byte y Byte-Registro. (Fuente: Texas 

Instruments) 

 

1.1.5  MODOS DE OPERACIÓN 

 

El MSP430 tiene un modo activo y cinco modalidades de operación de bajo 

consumo seleccionables mediante software. Una petición de interrupción puede 

activar el dispositivo desde cualquiera de los cinco modos de bajo consumo, 

puede dar servicio a la petición y puede regresar al modo de bajo consumo en 

el que se encontraba el microcontrolador antes de realizarse la interrupción. 
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Los siguientes seis modos de operación pueden ser configurados por software: 

 

• Modo Activo (AM - Active Mode); 

o Todos los relojes están activos 

 

• Modo de bajo consumo 0 (LPM0 – Low Power Mode 0); 

o El CPU esta deshabilitado 

o ACLK (Auxiliary Clock) y SMCLK (Sub-Main Clock) permanecen 

activos. MCLK (Master Clock) esta deshabilitado 

 

• Modo de bajo consumo 1 (LPM1- Low Power Mode 1); 

o El CPU esta deshabilitado 

o ACLK y SMCLK permanecen activos. MCLK esta deshabilitado 

o El generador DC del DCO (Digitally Controller Oscillator) esta 

deshabilitado si el DCO no se usa en el Modo Activo 

 

• Modo de bajo consumo 2 (LPM2- Low Power Mode 2); 

o El CPU esta deshabilitado 

o MCLK y SMCLK están deshabilitados 

o El generador DC del DCO está habilitado 

o ACLK permanece activo 

 

• Modo de bajo consumo 3 (LPM3- Low Power Mode 3); 

o El CPU esta deshabilitado 

o MCLK y SMCLK están deshabilitados 

o El generador DC del DCO está deshabilitado 

o ACLK permanece activo 

 

• Modo de bajo consumo 4 (LPM4- Low Power Mode 4); 

o El CPU esta deshabilitado 

o ACLK esta deshabilitado 

o MCLK y SMCLK están deshabilitados 

o El generador DC del DCO está deshabilitado 
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o El Cristal Oscilador externo es detenido 

 

1.1.6  LA MEMORIA FLASH 

 

La memoria Flash puede ser programada a través del puerto Spy-Bi-

Wire/JTAG, o por el microcontrolador usando su CPU. La CPU puede realizar 

escrituras de un solo byte o una sola palabra en la memoria Flash. Las 

características de la memoria Flash incluyen: 

 

• La memoria Flash tiene n segmentos de memoria principal y cuatro 

segmentos de memoria de información (de A hasta D) de 64 bytes cada 

uno. Cada segmento en la memoria principal tiene un tamaño de 512 bytes. 

EL número de segmentos n depende de cada microcontrolador y en el caso 

del MSP430F2013 n es igual a 4 (2 KB). 

 

• Los segmentos 0 hasta n puede ser borrados en un paso, o cada segmento 

puede ser individualmente borrado. 

 

• Los segmentos de A hasta D pueden ser borrados individualmente, o como 

un grupo con segmentos de 0 a n. Segmentos de A hasta D son llamados 

también como memoria de información. 

 

• El segmento A contiene datos de calibración. Después de un reset el 

segmento está protegido nuevamente contra escritura y borrado. Puede ser 

desbloqueada pero se debe tener cuidado de no borrar este segmento si los 

datos específicos de calibración del dispositivo son requeridos. 

 

1.1.7  LOS DISPOSITIVOS PERIFÉRICOS 

 

Los dispositivos periféricos están conectados al CPU a través de buses de 

datos, de dirección, y de control y pueden ser controlados directamente como si 

se tratara de una dirección de memoria RAM cualquiera. A continuación se 

describen los periféricos existentes en el microcontrolador MSP430F2013. 
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1.1.7.1 El oscilador y el reloj del sistema 

 

El sistema de reloj está controlado por el módulo básico del reloj que incluye 

soporte para un oscilador de cristal de 32.768Hz, un oscilador interno de bajo 

poder de consumo y baja frecuencia, y un oscilador interno digitalmente 

controlado (DCO). El módulo básico de reloj es diseñado para cumplir con 

ambos requisitos: bajo costo del sistema y bajo poder de consumo. El DCO 

interno provee una fuente de reloj de rápido encendido y se estabiliza en 

menos de 1us. Para su correcta calibración se deben usar los valores provistos 

de fábrica que se encuentran en la memoria Flash del segmento A. Para una 

frecuencia específica se necesitan configurar 2 valores, las direcciones de 

memoria que contienen estos valores de calibración específicos para cada 

frecuencia del DCO están indicadas en la tabla 1.3. El módulo básico de reloj 

provee las siguientes señales del reloj: 

 

• El reloj auxiliar (ACLK), Alimentado tanto de un cristal del reloj de 32768Hz 

o del oscilador LF interno. 

 

• El reloj principal (MCLK), que es el reloj de sistema usado por el CPU. 

 

• El reloj sub-principal (SMCLK), que es el reloj del sub-sistema usado por 

los módulos periféricos. 

 

Datos de Calibración del DCO (provisto de fabrica e n la memoria Flash en el 

segmento A) 

Frecuencia del DCO  Registro de calibración  Tamaño  Dirección  

1 MHz CALBC1_1MHz Byte 010FFh 

CALDCO_1MHz Byte 010FEh 

8 MHz CALBC1_8MHz Byte 010FDh 

CALDCO_8MHz Byte 010FCh 

12 MHz CALBC1_12MHz Byte 010FBh 

CALDCO_12MHz Byte 010FAh 

16 MHz CALBC1_16MHz Byte 010F9h 

CALDCO_16MHz Byte 010F8h 

 

Tabla 1.3: Datos de Calibración del DCO.  (Fuente: Texas Instruments) 
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1.1.7.2 El circuito de brownout 

 

El circuito del brownout es implementado para proveer la señal interna correcta 

del reset al dispositivo durante la secuencia de encendido y apagado del 

microcontrolador. En el anexo A.1 se encuentra una descripción del 

funcionamiento de este circuito. 

 

1.1.7.3 Entradas/Salidas Digitales 

 

Hay un puerto de entrada/salida de 8 bits implementado en P1 y otro puerto de 

2 entradas/salidas implementado en P2, sus características son: 

 

• Los bits de todas las entradas/salidas pueden ser programados 

independientemente. 

 

• Cualquier combinación de entrada, salida o condición de interrupción es 

posible. 

 

• Capacidad de selección del flanco para la interrupción en los 8 bits del 

puerto 1 y los 2 bits del puerto 2. 

 

• Acceso de lectura/escritura a los registros de control del puerto es 

soportado por todas las instrucciones. 

 

• Cada entrada/salida tiene una resistencia individual de pull-up/pull-down 

programable. 

 

Mayor información de la descripción técnica del microcontrolador y sus puertos, 

se presenta en el anexo B.1 y el anexo B.2. 
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1.1.7.4 El Temporizador del perro guardián "Watchdog Timer"  (WDT+) 

 

La función primaria del módulo watchdog timer (WDT+) es realizar un reset 

controlado del sistema cuando ocurra un problema en la ejecución del software. 

Si el espacio de tiempo seleccionado caduca, entonces un reset al sistema es 

generado. Si la función del perro guardián no es necesaria en una aplicación, 

entonces el módulo puede ser deshabilitado o configurado como un contador 

de intervalos y puede generar interrupciones en los espacios de tiempo 

seleccionados. 

 

1.1.7.5 El Timer_A2 

 

El Timer_A2 es un temporizador/contador de 16 bits con dos registros de 

captura/comparación. Puede dar soporte a la captura/comparación múltiple, 

salidas PWM, y medidas de intervalos de tiempo. También posee capacidad de 

interrupción. Las interrupciones pueden ser generadas desde el contador en 

condiciones de desborde y de cada uno de los registros de 

captura/comparación. 

 

1.1.7.6 USI (Universal Serial Interface - Interface Serial Universal) 

 

El módulo Interface Serial Universal (USI) sirve para comunicación de datos 

seriales y provee el hardware básico para los protocolos síncronos de 

comunicación como SPI e I2C. 

 

1.1.7.7 Conversor Análogo/Digital Sigma/Delta SD16_A (MSP430x20x3) 

 

El módulo Sigma/Delta SD16_A soporta conversiones análogas/digitales de 16 

bits. El módulo implementa un núcleo sigma/delta de 16 bits y un generador de 

referencias. Además de las entradas analógicas externas, un sensor de VCC 

interno y un sensor de temperatura están también disponibles. El 

MSP430F2013 no posee sensor de temperatura. 
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Un mayor detalle de los periféricos disponibles se puede encontrar en el anexo 

B.2. 

 

1.2 EXPLICACIÓN DE LA HERRAMIENTA DE DESARROLLO 

EZ430-F2013 Y EL MICROCONTROLADOR F2013  

 

1.2.1 BREVE DESCRIPCIÓN DE LA HERRAMIENTA EZ430-F2013 

 

El eZ430-F2013 es una herramienta completa que provee todo el hardware y 

software que permite evaluar el MSP430F2013 y además puede completar un 

proyecto entero en base al mismo. El eZ430-F2013 usa el IAR Embedded 

Workbench Integrated Development Environment (IDE) que provee la 

programación y la emulación completa con la opción de diseñar un sistema 

autónomo o separar la tarjeta que contiene al microcontrolador para integrarlo a 

un diseño existente. El puerto USB del computador provee la energía para 

alimentar el MSP430 de ultra-bajo consumo. 

 

Todos los 14 terminales del MSP430F2013 son accesibles en la tarjeta de 

pruebas MSP-EZ430D para una corrección de errores fácil e interactiva con los 

dispositivos periféricos. Adicionalmente, uno de los terminales digitales de I/O 

está conectado a un diodo emisor de luz para una indicación visual. La figura 

1.4 muestra una fotografía de la herramienta eZ430-F2013, incluido el 

microcontrolador MSP430F2013. 

 

 

Figura 1.4: Imagen del eZ430-F2013. (Fuente: Texas Instruments). 
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1.2.2 CONTENIDO DEL KIT EZ430-F2013 

 

Tiene un eZ430-F2013. El hardware es alojado al interior de un encapsulado 

plástico que puede ser abierto para separar la tarjeta de pruebas MSP-EZ430D 

de la interfaz de depuración MSP-EZ430U. 

 

Un MSP430 Development Tool CD-ROM que contiene varios documentos 

incluyendo los relacionados con el eZ430-F2013: 

 

• El MSP430x2xx Family User's Guide, SLAU144A 

• El MSP-FET430 FLASH Emulation Tool User's Guide, SLAU138C 

• La Guía de Errata MSP-FET430 Emulation Tool User's Guide Errata, 

SLAZ027 

• El EZ430-F2013 User's Guide. 

• IAR Embedded Workbench (Version Kickstart) 

• Herramientas de desarrollo poderosas y fáciles de usar que incluyen: 

 

o El simulador (incluyendo simulación de los dispositivos periféricos 

y las interrupción) 

o El compilador C 

o El ensamblador 

o El editor de enlace 

o Los emuladores (ICE y JTAG) 

o Kits de evaluación 

o El programador del dispositivo 

 

• Las notas aplicativas 

o Código de ejemplo 

 

Es por todo este contenido que el kit permite diseñar cualquier sistema sin 

necesidad de herramientas o programas adicionales. 
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1.2.3 DESCRIPCION TÉCNICA DEL MICROCONTROLADOR 

 
1.2.3.1. Arquitectura 

 

La arquitectura del MSP430 incluye una CPU tipo RISC de 16 bits que se 

interconecta al resto de dispositivos mediante dos buses: El primero es el bus 

de direccionamiento de memoria común (llamado MAB - Memory Address Bus) 

y el segundo es el bus común para datos (llamado MDB - Memory Data Bus), 

estos buses permiten transmitir y recibir datos desde cualquiera de los 

dispositivos integrados en el microcontrolador, tales como: La memoria RAM, 

La memoria Flash, Pórticos 1 y 2, Timer_A2, USI, etc.. Además posee un 

sistema de reloj muy flexible que permite seleccionar de manera muy sencilla la 

fuente de reloj para la CPU y para los dispositivos periféricos. Todos los 

dispositivos periféricos son modulares y están correlacionados entre sí 

mediante los buses MAB y MDB. Las características más importantes de la 

familia MSP430x2xx son las siguientes: 

 

• Tecnología de bajo consumo que extiende la vida de la batería. 

 

• 0.8 uA en modo de reloj en tiempo real 

 

• 250 uA al activarse el micro (ejecuta millones de instrucciones por 

segundo “MIPS”). 

 

• Sistema analógico de gran rendimiento ideal para mediciones de 

precisión. 

 

• Temporizadores/Comparadores con capacidad de interrupción, es decir 

que pueden provocar la generación de interrupciones al alcanzar un 

valor determinado. 

 

• CPU de arquitectura RISC de 16-bits que permite nuevas aplicaciones 

usando una fracción del tamaño de código. 
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• El diseño compacto del núcleo principal reduce el consumo de energía y 

el costo. 

 

• Optimizado para la programación moderna de alto nivel. 

 

• Solamente 27 instrucciones de núcleo y siete modos de 

direccionamiento. 

 

• Capacidad de interrupción-vectorial extensiva. 

 

• La Flash programable en sistema permite cambios al código, 

actualizaciones in situ y adquisición de datos de estado. 

 

En las figura 1.5 se muestra la arquitectura en forma general de los 

microcontroladores de la familia MSP430 y en la figura 1.6 se muestra el 

esquema funcional en bloques del microcontrolador MSP430x20x3, con los 

periféricos específicos de este modelo. 

 

 

Figura 1.5 Arquitectura del MSP430. (Fuente: Texas Instruments) 
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Figura 1.6: Esquema funcional en bloques, MSP430x20x3. (Fuente: Texas 

Instruments) 

 

1.2.3.2. Sistema de reloj 

 

El sistema de reloj es diseñado específicamente para aplicaciones que usan 

baterías. Un reloj auxiliar de baja-frecuencia (ACLK) de 32 KHz es controlado 

directamente. El ACLK puede ser usado tanto para una función de reloj en 

tiempo real como para la función de activado del microcontrolador. Un oscilador 

digitalmente controlado de alta velocidad (DCO) integrado puede generar la 

señal de reloj principal (MCLK) utilizado por la CPU y los dispositivos 

periféricos de alta velocidad. El DCO está activo y estable en menos de 2 µs a 

1 MHz. 

 

Gracias a todas estas características del sistema de reloj, el microcontrolador 

puede operar en dos velocidades diferentes, lo que permite implementarlo en 

aplicaciones tipo “burst”, es decir, aplicaciones que solo en ciertos instantes de 
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tiempo requieren la máxima velocidad de procesamiento, con lo cual se obtiene 

un ahorro significativo de energía al mantener al CPU en estado pasivo el resto 

de tiempo. Las señales de reloj pueden aplicarse de la siguiente manera: 

 

• Reloj auxiliar de baja frecuencia (ACLK) = Modo de espera de muy bajo 

consumo. 

• Reloj principal de alta velocidad (DCO) = Procesamiento de señales de 

alto rendimiento. 

 

1.2.3.3. Emulación integrada 

 

La lógica de emulación reside en el dispositivo mismo y es accedido vía JTAG 

sin necesidad de usar ningún recurso adicional del sistema. 

 

Los beneficios de la emulación integrada son: 

• Desarrollo y depuración con ejecución a máxima velocidad, puntos de 

parada, depuración paso a paso en la aplicación son soportados. 

• El desarrollo en el sistema está sujeto a las mismas características de la 

aplicación final. 

• La integridad de las señales se conserva y no está sujeta a interferencia 

por cableado externo. 

 

1.2.3.4. Espacio de Direccionamiento 

 

Los circuitos MSP430 tienen un espacio de direccionamiento compartido con 

los registros de función especiales (SFRs), dispositivos periféricos, la RAM, y la 

memoria Flash/ROM como se muestra en la figura 1.7. Los datos pueden ser 

accedidos como bytes o palabras. El acceso del código es llevado a cabo 

siempre sobre direcciones pares. El espacio de memoria direccionable es 

actualmente de 128 KB. 
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Figura 1.7: Mapa de memoria. (Fuente: Texas Instruments) 

 

1.2.3.7.1 Memoria Flash/ROM 

 

La dirección inicial de la Flash/ROM depende de la cantidad de memoria 

Flash/ROM presente y varía en cada dispositivo. La dirección final de la 

memoria Flash/ROM es 0x1FFFF. La memoria Flash/ROM puede ser usada 

tanto para código de programa como para datos, pudiendo leerse tablas 

almacenadas directamente de la Flash/ROM sin necesidad de copiarlas a la 

memoria RAM. 

 

La tabla de los vectores de interrupción está colocada dentro de los 16 bytes 

altos de la memoria  Flash/ROM, con el vector de mayor prioridad de 

interrupción ubicado en la dirección más alta que es la 0x1FFFF. Un mayor 

detalle de los vectores de interrupción y sus fuentes se puede encontrar en el 

anexo B.3 
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1.2.3.7.2  Memoria RAM 

 
La memoria RAM inicia en 0x0200h. La dirección final de la memoria RAM 

depende de la cantidad de memoria RAM presente en el dispositivo. Esta 

memoria puede ser usada tanto para código de programa como para datos. 

 
1.2.3.7.3 Módulos Periféricos 

 
Los módulos periféricos están ubicados dentro del mismo espacio de memoria 

que el resto de dispositivos. El espacio de direcciones 0x0100h a 0x01FFh está 

reservado para los módulos periféricos de 16 bits. Estos módulos deben ser 

accedidos usando instrucciones tipo “word”. Si se usa instrucciones tipo “byte” 

solo son accesibles las direcciones pares y el resultado del byte alto es siempre 

“0”. 

 

El espacio de memoria entre 0x0010h y 0x00FFh está reservado para los 

módulos periféricos de 8 bits. Estos módulos deben ser accedidos siempre con 

instrucciones tipo “byte”. En caso de lectura de estos módulos usando 

instrucciones tipo “word” resultaría en datos impredecibles en el byte alto. En 

cambio, en caso de escritura con instrucciones tipo “word”, solo el byte bajo 

será escrito en el registro del modulo periférico, ignorándose el byte alto. Mayor 

información sobre los módulos periféricos y sus registros puede ser encontrado 

en el anexo B.4. 

 

1.2.3.7.4 Registros de funciones especiales 

 

Algunas funciones de los dispositivos periféricos son configuradas en los SFRs. 

Los SFRs están ubicados en los 16 bytes más bajos del espacio de memoria 

RAM y son organizados por byte. Los SFRs deben ser accedidos usando 

instrucciones de byte solamente. En las hojas de datos del archivo 

slau144e.pdf se puede observar los bits de los SFR aplicables para cada 

dispositivo periférico. 
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1.2.3.5. Terminales del dispositivo MSP430x20x3 

 

La figura 1.8 muestra la configuración de los terminales del MSP430x20x3, que 

coincide con el microcontrolador usado en este proyecto, que es el 

MSP430F2013 

 

 

Figura 1.8: Detalle de los terminales del MSP430F2013. (Fuente: Texas 

Instruments). 

 

1.2.3.6. Mejoras de la familia MSP430x2xx  

 

La tabla 1.4 resalta las mejoras realizadas a la familia de microcontroladores 

MSP430x2xx.  

 

Tema Mejora  

Reset (Reinicio) 

• Circuito de Brownout  que permite reiniciar el dispositivo en caso de 

falla en el voltaje se incluye en todos los dispositivos MSP430x2xx 

• Las banderas PORIFG y RSTIFG han sido añadidas a IFG1 para 

indicar la causa de una re-inicialización. 

• Una ejecución de instrucción desde las direcciones de memoria 

0x0000 a 0x01FF reiniciara el dispositivo. 

Watchdog 
Timer 

(Temporizador de 

“Perro guardián”) 

• Todos los dispositivos MSP430x2xx integran el modulo Watchdog 

Timer+ (WDT+). El WDT+ se asegura que la fuente de reloj nunca 

sea deshabilitada. 
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Sistema básico de 
reloj 

• El oscilador LFXT1 tiene condensadores de carga seleccionables en 

el modo de LF 

• El LFXT1 soporta cristales de hasta 16 MHz en el modo de HF 

• El LFXT1 incluye detección de falla de oscilador en el modo de LF 

• los terminales  XIN y XOUT tienen funciones compartidas sobre los 

terminales 20 y 28 del dispositivo 

• El ROSC externo que le caracteriza al DCO no es soportado por 

todos los dispositivos. El software no debe fijar el LSB del registro 

BCSCTL2 en este caso. 

• La frecuencia operativa del DCO ha sido incrementada 

significativamente 

• La estabilidad de temperatura del DCO ha sido mejorada 

significativamente 

Memoria Flash 

• La memoria de información tiene 4 segmentos de 64 bytes cada una. 

• El segmento  A  es bloqueado individualmente con el bit LOCKA 

• Toda la información es protegida contra un borrado masivo con el bit 

LOCKA 

• El borrado de segmento puede ser interrumpido por una 

"interrupción" 

• Las actualizaciones en la memoria flash pueden ser suspendidas por 

una interrupción 

• El voltaje necesario para la programación de la memoria flash ha sido 

bajado a 2.2 V 

• El tiempo necesario para programar/borrar la memoria  ha sido 

reducido 

• Un error de reloj suspende la actualización de la memoria flash 

Entradas y salidas 
Digitales 

• Todos los puertos tienen integrado resistores pull-up/pull-down 

• Las funciones de P2.6 y P2.7 han sido añadidas a dispositivos de 20  

y 28  patillas. Éstas son funciones compartidas con XIN y XOUT. El 

software no debe borrar los bits del P2SELx para estos terminales si 

la operación de cristal oscilador externo es requerida. 

Comparador A 
• Han sido expandidas las capacidades de entrada del Comparador A 

con un nuevo multiplexor de entrada. 

Bajo Consumo 

• El consumo típico en modo LPM3 ha sido reducido casi en un 50 % a 

3 V 

• El tiempo  de inicio del DCO ha sido reducido significativamente 

Frecuencia 
operativa 

• La frecuencia operativa máxima es de 16 MHz a 3.3 V 

BSL 

• Una contraseña incorrecta provoca un borrado masivo de la memoria 

• La secuencia de entrada de BSL es más robusta para prevenir un 

ingreso accidental y un borrado accidental. 

 

Tabla 1.4: Mejoras a la familia MSP430x2xx. (Fuente: Texas Instruments) 
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1.2.3.7. Reinicio e inicialización del sistema 

 

La circuitería de re-inicialización de sistema mostrada en la figura 1.9 obtiene 

las señales de re-inicialización POR y PUC (Power-On Reset y Power-Up 

Clear) del microcontrolador. Diferentes eventos provocan estas señales de re-

inicialización y las diferentes condiciones iniciales existentes dependen de qué 

señal fue generada. 

 

 

Figura 1.9 Circuito esquemático de la generación de las señales POR y PUC. 

(Fuente: Texas Instruments) 

 

La señal de “POR” indica la re-inicialización del dispositivo. La señal “POR” es 

solamente generada por uno de los tres eventos siguientes: 

 

• Suministrar energía al dispositivo (Encender el dispositivo) 

• Una señal de bajo voltaje sobre el terminal RST/NMI cuándo está 

configurado en el modo de re-inicialización 
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• Una condición de bajo voltaje proveniente del Supervisor De Voltaje SVS 

cuando  PORON = 1. 

 

La señal "PUC" es generada siempre que una señal "POR" sea generada, por 

el contrario, una señal "POR" no es generada por una señal "PUC". La señal 

“PUC” es provocada por los siguientes eventos: 

 

• Una señal “POR”  

• Expiración del tiempo de espera del Watchdog cuando se está en modo de 

perro guardián únicamente 

• Violación de la llave de seguridad del temporizador “Watchdog” 

• Violación de la llave de seguridad de la memoria Flash 

• La ejecución de una instrucción desde la sección de memoria de 

periféricos, que se encuentra entre las direcciones de memoria 0h a 01FFh 

 

1.2.3.7.1  Circuito de Brownout (Brownout Reset - BOR) 

 

El circuito de Brownout detecta la existencia de niveles de voltaje bajos como 

los que se encuentran al alimentar el microcontrolador por primera vez. El 

circuito de brownout reinicia el dispositivo provocando una señal “POR” cuando 

la alimentación es aplicada o removida. Los niveles operativos son mostrados 

en la Figura 1.10. 

 

La señal "POR" se pone activa cuando el voltaje de alimentación cruza el nivel 

de VCC inicial - VCC(Start). Este queda activo hasta que el voltaje de 

alimentación cruza el umbral de Voltaje V(B_IT+) y el tiempo de retraso t(BOR) 

transcurre. El tiempo de retraso t (BOR) es adaptable y puede ser más largo 

para una rampa de VCC. El voltaje de histéresis Vhys (B_ IT-) asegura que el 

voltaje de alimentación debe caer por debajo del voltaje  V(B_IT-) para generar 

otra señal POR desde el circuito de reset de brownout. 
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Figura 1.10: Temporización del Brownout. (Fuente: Texas Instruments) 

 

Como el nivel voltaje V(B_IT-) está significativamente encima del nivel de 

voltaje VCC(start) del circuito de POR, el BOR provee la señal de reset en caso 

de existir un corte de energía y VCC no caiga por debajo de VCC(start). En las 

hojas de datos del dispositivo que se encuentran en el anexo B.5 se puede 

encontrar mayores detalles. 

 
1.2.3.7.2 Condiciones iníciales del dispositivo después de un reset de sistema 

 

Después de una señal "POR", las condiciones iníciales del MSP430 son: 

 

• El terminal RST/NMI es configurado en el modo de reseteo. 

• Los terminales de E/S son cambiados al modo de entrada. 

• Los módulos periféricos y registros son inicializados tal y como se describe 

en el respectivo manual. 

• Registro de estado (SR) es inicializado. 

• EL modulo del temporizador Watchdog es activado en modo de "Perro 

Guardián". 

• Se carga al contador de programa (PC) la dirección de memoria donde se 

encuentra el vector de reset (0FFFEh). Si el contenido de memoria del 
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vector de reset es el valor 0FFFFh, el dispositivo será desactivado 

inmediatamente para que el consumo de energía sea mínimo. 

 

1.2.3.7.2.1 Inicialización de software 

 

Después de un reset del sistema, el software del usuario debe inicializar al 

circuito para cumplir con los requisitos de la aplicación, por lo que debe 

realizar, entre otras, las siguientes tareas: 

 

• Inicializar el SP, típicamente con la dirección de inicio de la memoria RAM 

que es 0200h. 

• Inicializar el Watchdog según los requisitos de la aplicación. 

• Configurar los módulos periféricos a los requisitos de la aplicación. 

 

Adicionalmente, las banderas del temporizador Watchdog, falla del oscilador, y  

memoria Flash pueden ser evaluadas para determinar el origen de la 

reinicialización. 

 

1.2.3.8. Condiciones operativas  

 

1.2.3.8.1 Valores absolutos máximos 

 

Tensiones que sobrepasen los valores indicados a continuación podrían 

causar el daño permanente del dispositivo. Estos son valores “extremos” 

solamente, y la operación funcional del dispositivo en éstos o cualquier otra 

condición superior a aquellas mostradas en la sección “Condiciones operativas 

recomendadas" no están implicadas. La exposición del dispositivo a los 

valores máximos absolutos por períodos prolongados podría afectar la 

confiabilidad de dispositivo. 

 

La siguiente lista muestra los valores máximos absolutos: 

 

• Voltaje aplicable entre VCC y VSS: de 0.3 V hasta 4.1 V 
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• Voltaje aplicable en cualquier terminal, referenciado con VSS va desde - 

0.3 V hasta VCC + 0.3 V, a excepción del voltaje necesario para quemar el 

fusible del JTAG (VFB) que si puede ser excedido. 

• Corriente de diodo en cualquier terminal de dispositivo: 2 mA. 

• Temperatura de almacenamiento, Tstg sin programar el dispositivo, va 

desde - 55 ºC hasta 150 ºC 

• Temperatura de almacenamiento, Tstg con el dispositivo programado, va 

desde −40ºC hasta 85ºC.  

 

La máxima temperatura puede ser aplicada durante el proceso de soldado de 

acuerdo con la especificación JEDEC J-ETS-020, las temperaturas de reflujo 

máximas no deben ser más altas que las mostradas en las etiquetadas o 

cajas. 

 

1.2.3.8.2 Condiciones Operativas Recomendadas 

 

La tabla 1.4 muestra una tabla que contiene los valores para permitir que el 

microcontrolador trabaje en optimas condiciones, si alguna de ellas no fuera 

respetada, podría provocar daños personales o daños irreparables al 

microcontrolador. La figura 1.11 muestra el área operativa segura del 

microntrolador con sus correspondientes niveles de voltajes y frecuencias. 

 

Parámetro  Condición  Min Nom Max Unidad  
Voltaje de alimentación VCC durante la ejecución 
de programa  1.8  3.6 V 

Voltaje de alimentación VCC durante la 
programación/borrado de la memoria Flash 

 2.2  3.6 V 

Voltaje de alimentación VSS   0  V 
Rango de temperatura operativo al aire libre, TA  -40º  85º ºC 

Frecuencia del procesador FSYSTEM (frecuencia 
de MCLK máxima) 

VCC=1.8V, 
Ciclo de 
trabajo= 

50% ±10% 

dc  6 

MHz 

VCC=2.7V, 
Ciclo de 
trabajo= 

50% ±10% 

dc  12 

VCC ≥3.3V, 
Ciclo de 
trabajo= 

50% ±10% 

dc  16 
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NOTAS: 1. El CPU del MSP430 es alimentada con la señal de reloj  

directamente de MCLK. Tanto la fase alta como la fase baja del MCLK no 

deben exceder la anchura de pulso de la frecuencia máxima especificada.  

2. Los módulos podrían tener una especificación de reloj de entrada máxima 

diferente. Haga referencia a la especificación del módulo respectivo en la hoja 

de datos. 

Tabla 1.5: Valores recomendados para una operación optima. (Fuente: Texas 

Instruments) 

 

Nota:  La frecuencia mínima del procesador está definida por el reloj del 

sistema. La operación de programado o borrado de la memoria flash requiere 

un mínimo de 2.2V en VCC. 

Figura 1.11: Área operativa segura. (Fuente: Texas Instruments) 

En el anexo B.5 se adjunta las características eléctricas del microcontrolador 

MSP430F2013. 

 

1.3 DEFINICIÓN DE CARACTERÍSTICAS DEL PROTOTIPO. 

 

El prototipo tendrá las siguientes características tanto en Hardware como en 

Software: 
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1.3.1 CARACTERISTICAS DE HARDWARE: 

 

1.3.1.1 Entradas Análogas/Digitales: 

 

El dispositivo contara con 4 entradas Analógicas y su funcionamiento estará 

basado en el conversor A/D Sigma/Delta provisto internamente en el 

microcontrolador MSP430F2013, que para la aplicación será configurado como 

conversor de un solo paso con un voltaje de referencia interno de 1.2V, lo que 

permite ingresar en el terminal únicamente voltajes entre 0 y 0.6V (Vmax = Vref 

/ 2). 

Al disponer de una solo entrada, se usara un multiplexor bidireccional de 

tecnología CMOS que nos permita la multiplicación de las 4 entradas análogas 

respectivas además de permitir reducir el voltaje y hacerlo proporcionalmente, 

consiguiendo a la salida rangos aproximados de entre 0 y 0.6 Voltios para 

voltajes de entrada de 0 a 5 Voltios. Este circuito será detallado más adelante. 

Las entradas serán seleccionadas progresivamente y si se necesita hacerlas 

trabajar como entradas digitales (ON / OFF), se debe realizar la discriminación 

del nivel de transición mediante código de programa, también estas entradas 

no podrán ser usadas mediante peticiones de interrupción. 

 

1.3.1.2 Salidas Digitales para carga AC/DC 

 

El prototipo tendrá 4 salidas independientes programables con posibilidad de 

manejar cargas tanto AC como DC gracias al uso de relés electromecánicos, la 

carga máxima estará determinada por la capacidad del relé, en este caso será 

de: 

• AC 10A 125V 

• AC 6A 250V 

• DC 6A 28V 
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1.3.1.3 Comunicación serial con el PC  

 

El prototipo podrá comunicarse e interactuar con un PC gracias a una interfaz 

RS232 integrada y programada en el microcontrolador, esta interfaz usará el 

puerto serial disponible del PC o en su ausencia podrá utilizar un adaptador 

USB-RS232, el cual permita el manejo de la interfaz serial requerida.  

 

1.3.1.4 Display LCD y Teclado Matricial 

 

Para facilitar el uso del prototipo por parte del usuario, se dispondrá de un 

display tipo LCD de 2 líneas por 16 caracteres cada una (32 caracteres en 

total) y de un teclado matricial de 4 por 4 caracteres (16 teclas en total), lo que 

proporcionara al usuario la facilidad de ingresar a las funciones internas del 

prototipo sin necesidad de usar un PC. 

 

1.3.2 CARACTERÍSTICAS DEL SOFTWARE 

 

En lo referente al software, el prototipo dispondrá para el usuario de todos los 

comandos disponibles tanto en lenguaje ensamblador como en lenguaje C, 

tendrá bloques de programa especiales para la configuración de los periféricos 

instalados en su construcción, estos son las 4 entradas, las 4 salidas, la 

comunicación serial, la adquisición de datos, la visualización de información en 

el display y el escaneo del teclado, entre otras funciones internas especificas 

de este prototipo. 

Además se proveerá de un programa diseñado para interactuar con el prototipo 

desde el PC, permitiendo al PC adquirir datos de las entradas o accionar los 

relés en sus salidas, como ejemplo básico de aplicación.  
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1.4 DISEÑO DEL PROTOTIPO, A NIVEL CIRCUITAL. 

 

A continuación se presentan los esquemas circuitales de cada sección del 

prototipo, además de la explicación de cada una de ellas. En el CD que 

complementa este proyecto se encuentra el directorio “Esquemas Electronicos” 

que contiene todos los archivos creados dentro del programa Altium Designer 

con los diseños de todos los circuitos aquí mencionados. 

 

1.4.1 ESQUEMA CIRCUITAL DE LAS ENTRADAS 

ANALOGAS 

 

El esquema de la figura 1.12 muestra el circuito multiplexor y reductor de 

voltaje de las 4 entradas análogas, en este esquema se indica respectivamente 

la salida multiplexada que va conectada a la entrada del conversor A/D 

Sigma/Delta del microcontrolador, las 4 entradas análogas y los terminales de 

selección de entrada.  

Está basado en el integrado NTE4529B tipo CMOS, Selector de datos Doble de 

4-Canales (8 entradas) Análogas. La reducción de voltaje se la realiza con un 

divisor de tensión formado por 2 resistencias, una de 1K ohmio y otra de 150 

ohmios conectadas en serie a la salida del multiplexor.  

Las salidas del microcontrolador son conectadas directamente a las entradas 

del multiplexor, aunque el voltaje máximo de funcionamiento del 

microcontrolador es de 3V, los circuitos TTL detectan un nivel alto (1L) entre los 

2 y 5 voltios, por lo tanto no se requieren realizar adaptaciones o utilizar 

circuitos de interface en estos valores de salida. 
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Figura 1.12: Esquema electrónico del selector/seguidor de voltaje para las 

entradas Análogas. (Elaborado por el Autor) 

 

1.4.2 ESQUEMA CIRCUITAL DE LAS SALIDAS 

DIGITALES 

 

En este circuito se muestran las 4 salidas digitales que podrían manejar cargas 

tanto en AC como en DC. Para evitar los problemas de diferencia de voltaje y la 

poca corriente permitida en los terminales del microcontrolador, los terminales 

manejan relés conectados a los mismos por medio de transistores que trabajen 

en corte y saturación, es decir, que trabajan como interruptores para accionar 

los relés. La corriente es limitada por la resistencia de 10K ohmios. 

En la figura 1.13 se muestra el esquema eléctrico incluido los valores de los 

elementos usados. 
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Figura 1.13: Esquema eléctrico de las salidas digitales. (Elaborado por el Autor) 
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1.4.3 ESQUEMA CIRCUITAL DEL CONVERSOR TTL A 

RS232, COMUNICACIÓN SERIAL  

 

El circuito mostrado en la figura 1.14 es el que realiza la conversión de niveles 

de tensión entre TTL y RS232, para cumplir con la norma para la comunicación 

serial.  

La señal de salida del microcontrolador (0 a 3V) será aplicada directamente al 

terminal del MAX232 aprovechando que el voltaje mínimo que debe ser 

ingresado para detectarse un nivel alto es de 2V (Ver en el anexo C.1 las 

especificaciones técnicas del integrado MAX232, además del diagrama de 

conexión),  la salida TTL del MAX232 será controlada con una resistencia de 

10k ohmios para permitir la conexión al terminal del microcontrolador y de esta 

manera controlar la corriente y el voltaje máximo que a él llega. Las señales 

RS-232 son conectadas directamente con el puerto serial del PC. 

 

Figura 1.14: Circuito Conversor TTL-RS232. (Elaborado por el Autor) 
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1.4.4 DIAGRAMA DE INTERCONEXIÓN DE CADA 

PERIFÉRICO A CADA UNO DE LOS 

MICROCONTROLADORES 

 

La figura 1.15 muestra los terminales usados de cada uno de los 

microcontroladores y la interconexión realizada con cada uno de los circuitos 

externos necesarios para implementar el prototipo. Se indican también por 

bloques los circuitos anteriormente explicados y la circuitería que cada 

dispositivo requiere para su correcto funcionamiento.  

La comunicación entre cada microcontrolador se la lleva a cabo a través del 

protocolo I2C, que, mediante la utilización de 2 líneas de comunicación permite 

enlazar más un dispositivo al mismo tiempo. 

Para el diseño se ha utilizado 2 familias de microcontroladores, la familia 

MSP430F2013 y la familia MSP430F2012. 
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Figura 1.15: Interconexión de periféricos a los microcontroladores. (Elaborado 

por el Autor) 

 



38 
 

 

1.4.5 FUENTE DE ALIMENTACIÓN 

 

Como su nombre lo indica, la figura 1.16 muestra el circuito utilizado para la 

fuente de alimentación del prototipo, esta fuente entrega los 2 voltajes que se 

requiere tanto para alimentar a los microcontroladores como para alimentar al 

resto de elementos (relés, CI’s, Display, Teclado, etc.). El sistema se alimenta 

con el voltaje de la red pública. 

 

Figura 1.16: Fuente de alimentación del prototipo. (Elaborado por el Autor) 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

CAPITULO 2 
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CAPITULO 2. DESARROLLO DE LOS PROGRAMAS 

 

2.1 DESCRIPCIÓN Y CARACTERÍSTICAS GENERALES DE 

CADA LENGUAJE 

 

Para el desarrollo del presente capitulo se han tomado como base la 

documentación técnica del diseñador de los lenguajes de programación, en 

este caso Microsoft, además de otras fuentes de consulta como 

www.wikipedia.org. Mayor detalle de las fuentes consultadas se encuentra en 

la bibliografía. 

 

2.1.1  DESCRIPCIÓN Y CARACTERÍSTICAS GENERALES DE VISUAL 

STUDIO 2005 

 

Visual Studio 2005 se empezó a comercializar a través de Internet a partir del 4 

de Octubre de 2005 y llegó a los comercios a finales del mes de Octubre en 

inglés. En castellano no salió hasta el 4 de Febrero de 2006. Microsoft eliminó 

el término “.NET”, pero eso no indica que se alejara de la plataforma .NET, de 

la cual se incluyó la versión 2.0. 

 

La actualización más importante que recibieron los lenguajes de programación 

fue la inclusión de tipos genéricos, similares en muchos aspectos a las 

plantillas de C#. Con esto se consigue encontrar muchos más errores en el 

momento de compilación en vez de en tiempo de ejecución, incitando a usar 

comprobaciones estrictas en áreas donde antes no era posible. C++ tiene una 

actualización similar con la adición de C++/CLI como sustituto de C# manejado. 

 

Se incluye un diseñador de implantación, que permite que el diseño de la 

aplicación sea validado antes de su implantación. También se incluye un 

entorno para publicación web y pruebas de carga para comprobar el 

rendimiento de los programas bajo varias condiciones de carga. 
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Visual Studio 2005 también añade soporte de 64-bit. Aunque el entorno de 

desarrollo sigue siendo una aplicación de 32 bits Visual C++ 2005 soporta 

compilación para x86-64 (AMD64 e Intel 64) e IA-64 (Itanium). El SDK incluye 

compiladores de 64 bits así como versiones de 64 bits de las librerías. 

 

Visual Studio 2005 tiene varias ediciones radicalmente distintas entre sí: 

Express, Standard, Professional, Tools for Office, y 5 ediciones Visual Studio 

Team System. Éstas últimas se proporcionaban conjuntamente con 

suscripciones a MSDN cubriendo los 4 principales roles de la programación: 

Architects, Software Developers, Testers, y Database Professionals. La 

funcionalidad combinada de las 4 ediciones Team System se ofrecía como la 

edición Team Suite. 

 

Tools for the Microsoft Office System está diseñada para extender la 

funcionalidad a Microsoft Office. 

 

Las ediciones Express se han diseñado para principiantes, aficionados y 

pequeños negocios, todas disponibles gratuitamente a través de la página de 

Microsoft se incluye una edición independiente para cada lenguaje: Visual 

Basic, Visual C++, Visual C#, Visual J# para programación .NET en Windows, y 

Visual Web Developer para la creación de sitios web ASP.NET. Las ediciones 

express carecen de algunas herramientas avanzadas de programación así 

como de opciones de extensibilidad. 

 

Se lanzó el Service Pack 1 para Visual Studio 2005 el 14 de Diciembre de 

2006. 

La versión interna de Visual Studio 2005 es la 8.0, mientras que el formato del 

archivo es la 9.0. 

 

La ventaja de utilizar este entorno de desarrollo es que Microsoft provee mucha 

información y ejemplos que permiten utilizarlo sin mayores dificultades, además 

permite la reutilización de ensamblados o librerías creadas en versiones 

anteriores, lo cual resultará de mucha utilidad en la implementación del 

programa de interfaz para el usuario. 
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2.1.2  DESCRIPCIÓN Y CARACTERÍSTICAS GENERALES DE VISUAL 

BASIC 2005 

 

El 13 de febrero de 2002, nació oficialmente Visual Basic .NET, junto con el 

resto de la familia de Visual Studio. Visual Basic .NET no era un simple 

“upgrade” del antiguo Visual Basic, era un cambio realmente profundo y radical, 

convirtiéndolo en uno de los lenguajes más poderosos, con características 

avanzadas, como verdadera orientación a objetos, multi-threading, y la 

posibilidad de crear Web Services, entre otras cosas.  

 

La plataforma .NET, base de este nuevo lenguaje, se gesto en Microsoft 

durante algunos años, y formó parte de una estrategia impulsada por esta 

empresa para conquistar el mercado del desarrollo y de internet, y de seguir 

creciendo.  

 

En estos años, la comunidad de Visual Basic ha crecido hasta ser la mayor 

comunidad de desarrolladores de software del mundo. Durante ese tiempo, una 

industria entera de vendedores de componentes creció alrededor de este 

producto. Éste, combinado con la sencilla forma de desarrollar aplicaciones 

para Windows, fueron la base fundamental de la realización de la visión de 

Microsoft para la programación basada en Windows.  

 

Los cambios en Visual Basic .NET están proyectados para:  

• Simplificar el lenguaje y hacerlo más coherente.  

• Agregar nuevas características solicitadas por usuarios.  

• Hacer el código más sencillo de leer y mantener.  

• Ayudar a los programadores a evitar los errores de programación.  

• Crear aplicaciones más sólidas y más sencillas de depurar.  

Visual Basic .NET ofrece numerosas características nuevas y mejoradas, como 

herencia, interfaces y sobrecarga, que lo convierten en un eficaz lenguaje de 

programación orientado a objetos. Ahora se puede crear aplicaciones 

multiproceso y escalables utilizando subprocesamiento múltiple explícito. Otra 

característica nueva de Visual Basic .NET incluye el control estructurado de 
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excepciones, atributos personalizados y compatibilidad con CLS (Common 

Language Specification, Especificación de lenguajes comunes).  

 

CLS es un conjunto de reglas que estandariza cosas como tipos de datos y el 

modo en que se exponen e inter-operan los objetos. Visual Basic .NET agrega 

varias características que aprovechan las ventajas de CLS. Cualquier lenguaje 

compatible con CLS puede utilizar las clases, los objetos y los componentes 

que se crean en Visual Basic .NET, y a su vez Visual Basic puede tener acceso 

a las clases, los componentes y los objetos desde otros lenguajes de 

programación compatibles con CLS sin tener en cuenta diferencias específicas 

del lenguaje como los tipos de datos. Las características de CLS que utilizan 

los programas de Visual Basic .NET son los ensamblados, espacios de 

nombres y atributos.  

 

Visual Basic .NET ofrece numerosas características de lenguaje orientado a 

objetos nuevas o mejoradas como la herencia, la sobrecarga, la palabra clave 

“Overrides”, interfaces, miembros compartidos y constructores.  

 

También se incluyeron el control estructurado de excepciones, delegados y 

varios tipos de datos nuevos. 

 

A continuación en la figura 2.1 se indican las mejoras y las características 

nuevas que se incluyen en esta versión de Visual Basic para Visual Studio 

2005. 
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Figura 2.1: Características y mejoras de Visual Basic 2005. (Elaborado por el 

autor) 

En síntesis, el uso de Visual Basic 2005 en el desarrollo de este proyecto está 

contemplado debido a la facilidad del lenguaje, permite la reutilización de 

ensamblados o librerías escritas en cualquier otro lenguaje compatible, y 

principalmente a que anteriormente ya se han desarrollado proyectos utilizando 

versiones anteriores del mismo lenguaje, lo que facilita el desarrollo de este 

proyecto. 
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2.2 DESCRIPCIÓN Y DESARROLLO DEL CÓDIGO FUENTE DEL 

EJEMPLO DE APLICACIÓN EN EL  MICROCONTROLADOR 

 

2.2.1 DESCRIPCION TÉCNICA DE LOS MÓDULOS PERIFERICOS 

USADOS PARA LA APLICACIÓN PRÁCTICA 

 

2.2.1.1 Set de instrucciones  

 

El set de instrucciones de la familia MSP430 consta de 51 comandos, estos a 

su vez tienen tres tipos de formatos y pueden usar hasta siete modos de 

direccionamiento. Cada instrucción puede operar con datos de tamaño de byte 

o de tamaño de una palabra (2 bytes). 

 

En la tabla 2.1 se muestra un ejemplo de cada formato existente para el uso de 

las instrucciones. 

 

Operandos duales, Origen-Destino Ej: ADD R4,R5 R4 + R5 � R5 

Operandos individuales, Solo Destino Ej: CALL R8 PC � (TOS), R8  � PC 

Salto Relativo, In/condicional Ej: JNE Salte si el bit es igual a 0 

Tabla 2.1: Formatos para las instrucciones (usando “Palabras”, 2 bytes). 

(Fuente: Texas Instrumens) 

 

La lista completa de instrucciones que soporta el CPU del MSP430 se incluye 

en el anexo B.6. 

 

2.2.1.1.1  Modos de direccionamiento 

 

Se dispone de varias maneras de acceder a la dirección de memoria donde se 

ubica cada operando, es así que en cualquier instrucción donde se requiera los 

operandos de Origen y/o Destino, se los puede acceder de varios modos 

diferentes; 7 modos para el operando de Origen y 4 modos para el operando de 

destino. Cualquier combinación de modo de direccionamiento entre el Origen y 
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el Destino es posible en una instrucción. Todo el espacio de memoria es 

cubierto con cualquiera de los modos disponibles. 

 

Los diferentes modos de direccionamiento son seleccionados mediante los bits 

As para el Origen (Addressing mode used for the source - modo de 

direccionamiento elegido para el origen) y los bits Ad para el Destino 

(Addressing mode used for the destination - modo de direccionamiento elegido 

para el destino), estos bits están ubicados en la instrucción que será ejecuta 

por la CPU del microcontrolador. La Tabla 2.2  muestra el valor de los bits As y 

Ad y el modo de direccionamiento respectivo, en cambio, en la tabla 2.3 se 

muestra una lista de los modos de direccionamiento posibles. 

  

As/Ad  Modo de 

direccionamiento 

Sintaxis  Descripción  

00/0 Registro Rn El contenido de los registros son operandos 

01/1 Indexado X(Rn) 
(Rn + X) apunta al operando. X es 

almacenado en la siguiente palabra 

01/1 Simbólico ADDR 

(PC + X) apunta al operando. X es 

almacenado en la siguiente palabra. El 

modo indexado X(PC) es usado. 

01/1 Absoluto &ADDR 

La palabra a continuación de la instrucción 

contiene la dirección absoluta. X es 

almacenada en la siguiente palabra. El 

modo indexado X(SR) es usado. 

10/- Registro indirecto @Rn Rn es usado como puntero al operando 

11/- 
Auto incremental 

indirecto 
@Rn+ 

Rn es usado como puntero al operando. Rn 

es incrementado en 1 para instrucciones 

byte (.B)  y en 2 para instrucciones palabra 

(.W). 

11/- Inmediato #N 

La palabra siguiente a la instrucción 

contiene la constante inmediata N. El modo 

de autoincremento indirecto @PC+ es 

usado. 

 

Tabla 2.3: Modo de operación de direccionamiento Origen/Destino. (Fuente: 

Texas Instrumens) 
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Modo de 

Direccionamiento 

O D Sintaxis  Ejemplo  Operación  

Registro X X MOV Ro, Rd MOV R10, R11 R10 � R11 

Indexado X X MOV X(Rn), Y(Rm) MOV 2(R5), 6(R6) M(2+R5) � M(6+R6) 

Simbólico  (Relativo 

al Contador de 

Programa) 

X X MOV EDE, TONI  M(EDE) � M(TONI) 

Absoluto X X MOV &MEM, 

&TCDAT 

 M(MEM) � M(TCDAT) 

Indirecto X  MOV @Rn, Y(Rm) MOV @R10, 

Tab(R6) 

M(R10) � M(Tab+R6) 

Indirecto auto-

incremental 

X  MOV @Rn+,Rm MOV @R1+,R11 M(R10) � R11 

R10 + 2 � R10 

Inmediato X  MOV #X, TONI MOV #45,TONI #45 � M(TONI) 

NOTA: O = Origen, D = Destino 

Tabla 2.2: Descripción de los modos de direccionamiento. (Fuente: Texas 

Instrumens) 

 

2.2.1.2 Las Interrupciones 

 

Las prioridades de interrupción son fijas y están definidas de acuerdo al orden 

de los módulos en la cadena de conexión como se muestra en la Figura 2.2. 

Mientras más cercano está un módulo de la CPU/NMIRS, más alta es la 

prioridad. Las prioridades de interrupción definen qué interrupción es ejecutada 

cuando más de una interrupción se genera simultáneamente. 

 

Hay tres tipos de interrupciones: 

• Inicialización del Sistema (Reset) 

• NMI No Enmascarable (No Maskable Interrupt) 

• Enmascarable 
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Figura 2.2: Prioridad de interrupción. (Fuente: Texas Instruments) 

 

A continuación, en la figura 2.3 se muestra un resumen de los tipos de 

interrupciones existentes en el microcontrolador,  

 

 

Figura 2.3: Resumen de los tipos de interrupciones existentes en el 

microcontrolador. (Elaborado por el autor) 
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Los vectores de interrupción, así como el vector de reset del microcontrolador 

están ubicados en el rango de direcciones de 0FFFFh a 0FFC0h. Cada vector 

de interrupción contiene la dirección de 16 bits de la rutina de servicio de 

interrupción respectiva. 

 

Si el vector de reset (localizado en dirección 0FFFEh) contiene el valor 0FFFFh 

(por ejemplo, porque la memoria flash no está programada), entonces el 

microcontrolador entrará en el modo de bajo consumo LPM4 inmediatamente 

después de ser energizado. 

 

La tabla completa con las fuentes de interrupción (Vectores de interrupción) del 

MSP430F2013 se incluye en el anexo B.3.  

 

Cuando un dispositivo periférico genera una interrupción y los bits tanto de 

habilitación de interrupción del dispositivo como el bit GIE están habilitados, la 

rutina de servicio de interrupción es ejecutada, esto para las interrupciones 

enmascarables. Para las interrupciones no-enmascarables solamente debe 

setearse el bit de habilitación respectivo para que la interrupción 

correspondiente  pueda ser llamada y ejecutada. En la figura 2.4 se muestra un 

resumen de la secuencia requerida para realizar el procesamiento de cada 

interrupción. 

 

Procesamiento de la 

interrupción

Aprobación de la 

Interrupción

La latencia de interrupción es 6 

ciclos de la CPU, inicia con la 

aprobación de una solicitud de 

interrupción y dura hasta el inicio 

de la ejecución de la primera 

instrucción de la rutina de servicio 

de la interrupción

Retorno de la rutina 

de servicio de 

interrupción

La rutina de servicio de interrupción 

se termina con la instrucción RETI 

(Retorno desde la rutina de 

interrupción). Regresar desde la 

interrupción toma 5 ciclos de la CPU

Interrupciones 

Anidadas

Las interrupciones anidadas se 

generan cuando el bit GIE es 

habilitado dentro de una rutina de 

servicio de interrupción. Cuando la 

interrupción anidada esta activada, 

cualquier interrupción que ocurra 

durante una rutina de servicio de 

interrupción detendrá dicha rutina, 

sin considerar las prioridades de 

interrupción.

 

Figura 2.4: Procesamiento de la interrupción. (Elaborado por el autor) 
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2.2.1.3 Espacio de Direccionamiento 

 

2.2.1.3.1 La memoria Flash / ROM 

 

La dirección de inicio de la memoria Flash/ROM depende de la cantidad de 

memoria presente y varía dependiendo del dispositivo. La dirección final de la 

memoria es 0x0FFFF. La memoria Flash puede ser usada tanto para código de 

programa o para datos. Tablas de "Palabras" (2 bytes) o tablas de 1 byte 

pueden ser almacenadas y usadas en la memoria Flash/ROM sin la necesidad 

de copiar estas tablas en la memoria RAM antes de usarlas. 

 

En la Tabla 2.4 se muestran las direcciones de memoria para los dispositivos 

de la familia MSP430f201X 

 

Memoria  Tamaño  Direcciones  

Principal: Vector de interrupción Flash 32 bytes 

0FFFFh – 0FFC0h 

Principal: Memoria para código (Memoria Flash Total: 2KB 

menos 32 bytes usados para vectores de interrupción) 

Flash 0FFFFh – 0F800h 

Memoria de información Tamaño 256 Byte 

010FFh – 01000h 

RAM Tamaño 128 Byte 

027Fh – 0200h 

Periféricos De 16-bits 

De 8-bits 

De 8-bits (SFR) 

01FFh – 0100h 

0FFh – 010h 

0Fh – 00h 

Nota: SFR (Special Function Register – Registro de función especial) 
 

Tabla 2.4: Organización de la memoria (MSP430F201x). (Fuente: Texas 

Instruments) 

 

2.2.1.3.2 La memoria RAM 

 

La memoria RAM empieza en la dirección 0x0200. La dirección final de la RAM 

depende de la cantidad presente en cada dispositivo. La memoria RAM puede 

ser usada tanto para el código de usuario (programas) como para datos y 

variables. 
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Para los dispositivos MSP430F201X la memoria RAM disponible es de 128 

bytes, siendo la dirección final 0x027F. 

 

2.2.1.3.3 Dispositivos Periféricos Modulares 

 

Los dispositivos periféricos modulares están asignados dentro del mismo 

espacio de direccionamiento que el resto de la memoria.  

 

El espacio de direcciones de 0x0100 a 0x01FF es reservado para los 

dispositivos periféricos modulares de 16 bits. Cada módulo debe ser accedido 

utilizando instrucciones de palabra. Si, al contrario, se utilizaran instrucciones 

de byte, solamente las direcciones pares están permitidas (acceso solo al byte 

bajo), en este caso el byte alto del resultado es siempre 0.  

 

El espacio de direcciones de 0x0010 a 0x00FF está reservado para los 

dispositivos periféricos modulares de 8 bits. Estos módulos deben ser 

accedidos con instrucciones de byte. Peticiones de lectura a estos módulos 

usando instrucciones de palabra resulta en datos inesperados en el byte alto. 

Si un dato de palabra (16 bits) es escrito en un módulo de 1 byte (8 bits), 

solamente el byte bajo es escrito en el registro del dispositivo periférico, 

haciendo caso omiso del byte alto. 

 
2.2.1.3.4 Registros de función especial (SFRs) 

 

La mayoría de los bits de habilitación de las interrupciones correspondientes a 

cada dispositivo modular están reunidos en la parte más baja del espacio de 

memoria, esto es de 0x0000 a 0x000F. Los bits en estos registros no 

asignados a un propósito funcional muestran que ciertos módulos no están 

físicamente presentes en el dispositivo.  

 

En la Figura 2.5 se encuentran los registros especiales de habilitación de 

interrupción (0x0000,  0x0001) y en la Figura 2.6 están los bits que representan 

las banderas de interrupción (0x0002,  0x0003), de los dispositivos 
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MSP430F201X. En la figura 2.7 esta la leyenda para interpretar la simbología 

que se encuentra en cada gráfico. 

 

 

 

WDTIE:  Habilitación de la interrupción del módulo Watchdog Timer en modo de temporizador. Inactivo si 

el módulo esta en modo Watchdog. Activo si el módulo Watchdog Timer es configurado como 

contador de intervalos (Temporizador). 

OFIE:  Habilitación de la interrupción por fallo del oscilador. 

NMIIE:  Habilitación de la interrupción No-enmascarable (NMI/RST). 

ACCVIE:  Habilitación de la interrupción por violación de acceso a la memoria Flash. 

 

Figura 2.5: Registros de habilitación de interrupción (direcciones 0h y 01h). 

(Fuente: Texas Instruments) 

 

WDTIFG: Bandera activada en caso de desbordamiento del módulo Watchdog Timer en el modo Watchdog 

o por violación de la clave de seguridad usada en la configuración del módulo. Reseteada al 

energizar el microcontrolador o al dar la condición de Reset en el terminal RST/NMI cuando está 

configurado en modo de reset. 

OFIFG: Bandera activada en caso de fallo del oscilador. 

RSTIFG: Bandera de interrupción de reset externo. Puesto a 1 al existir una condición de reset en el terminal 

RST/NMI cuando está configurado en el modo de reset. Reseteada al energizar el 

microcontrolador. 

PORIFG: Bandera de la interrupción denominada Resetear al encender (Power-On Reset). Activada al 

energizar el microcontrolador. 

NMIIFG: Bandera activada a través del terminal RST/NMI cuando está configurada en el modo NMI. 

 

Figura 2.6: Banderas de interrupción (direcciones 02h y 03h). (Fuente: 

Texas Instruments) 
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Leyenda: 

rw:    El bit puede ser leído y escrito. 

rw-0,1: El bit puede ser leído y escrito. Es puesto a 0 o 1 por un evento “PUC”. 

rw-(0,1):  El bit puede ser leído y escrito. Es puesto a 0 o 1 por un evento “POR”. 

 SFR (Special Function Register) No presente en el dispositivo. 

Figura 2.7: Leyenda para la interpretación de la simbología descrita en 

las Figuras 2.5 y 2.6. (Fuente: Texas Instruments) 

 

2.2.1.3.5 Organización de datos y valores en la memoria 

 

Los bytes pueden ser ubicados en las direcciones pares o impares. Las 

palabras (2 bytes) pueden ser ubicadas solamente en direcciones pares como 

se muestra en la Figura 2.7. Cuando se usa instrucciones de palabra, 

solamente deben usarse direcciones pares. El byte bajo de la palabra esta 

siempre en una dirección par mientras el byte alto está en la próxima dirección 

impar. 

 

 

Figura 2.7: Organización de bits, bytes, y palabras en la memoria Flash. 

(Fuente: Texas Instruments) 
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2.2.1.4 Configuración y Funcionamiento de los terminales de Entrada/Salida 

Digitales y sus registros 

 

Los terminales de Entrada/Salida digitales deben ser configurados por el 

programa en ejecución. El tipo de configuración, el uso de los registros y la 

operación de estos terminales son discutidos en la figura 2.8, presentando un 

resumen de todos los registros existentes y su significado. 

 

PXSEL PxSEL2 FUNCION

0 0 La función de Entrada/Salida es seleccionada.

0 1 La función principal de módulo periférico es seleccionada.

1 0 Reservado. Vea en la hoja de datos del dispositivo.

1 1 La función secundaria de módulo periférico es seleccionada.

 

Figura 2.8: Registros de configuración de los terminales de Entrada/Salida del 

microcontrolador. (Elaborado por el autor). 

 

Cada terminal en los puertos P1 y P2 tienen la capacidad de interrupción, se la 

puede configurar mediante los registros PxIFG (Port x Interrupt Flag Register), 

PxIE (Port x Interrupt Enable Register), y PxIES (Port x Interrupt Edge Select 

Register). Existe un solo vector de interrupción para todos los terminales de un 

pórtico, y un vector de interrupción por cada pórtico. El registro PxIFG puede 

ser evaluado para determinar el o los terminales que generaron la interrupción. 

En la figura 2.9 se muestra un resumen de los registros utilizados para la 

configuración de las interrupciones en los pórticos 1 y 2. 
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Figura 2.9: Registros utilizados para la configuración de las interrupciones en 

los pórticos 1 y 2. (Elaborado por el autor). 

2.2.1.4.1 Configuración de los terminales sin uso 

 

Los terminales de Entrada/Salida sin usar en el microcontrolador deben ser 

configurados de la siguiente manera:  

• Función seleccionada: “Entrada/Salida” 

• Dirección: Salida 

• Conexión física del terminal: ninguna 

Así se previene una entrada flotante y se reduce el consumo de energía. El 

valor del bit  PxOUT (Port x Output Register) es irrelevante, ya que el terminal 

está desconectado.  

 

Por otra parte, el resistor integrado de pull-up/pull-down puede ser habilitado 

configurando el bit PxREN (Port x Pullup/Pulldown Resistor Enable Register) 

del terminal sin uso para prevenir una entrada flotante. 
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2.2.1.5 El Timer_A2 (Temporizador/Contador) 

 

El Timer_A2 es un temporizador / contador de 16-bits con dos registros de 

captura/comparación. Es implementado en los dispositivos de la familia 

MSP430x20xx. Soporta múltiple captura/comparación, también puede generar 

salidas del tipo PWM (Pulse-Width Modulation- Modulación por ancho de 

pulsos) e intervalos de temporización.   

 

Además tiene una amplia capacidad de generar interrupciones por diferentes 

eventos,  ya sea por el desbordamiento  del contador o por las condiciones de 

cada uno de los registros de captura/comparación.  

 

Entre las características principales del Timer_A2 tenemos: 

 

• Temporizador/contador Asincrónico de 16-bits con cuatro modos de 

funcionamiento 

• La fuente de reloj es seleccionable y configurable 

• Dos registros configurables de captura/comparación 

• Salidas configurables con capacidad PWM 

• Enclavamiento asíncrono de las entradas y salidas 

• Un solo registro de interrupción para una rápida decodificación de todas 

las interrupciones del Timer_A. 

 

En la Figura 2.10 se muestra el diagrama de bloques del Timer_A. 
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Figura 2.10: Diagrama de bloques del Timer_A. (Fuente: Texas Instruments) 

 

2.2.1.6  La memoria Flash 

 

La memoria Flash de la familia MSP430 es direccionable y programable a nivel 

de bit, byte, y palabra. Este módulo posee un controlador integrado que 

controla las operaciones de programado y borrado de la memoria. El 

controlador entre sus características tiene:  

• 4 Registros 

• Un generador de sincronización “timming”  

• Un generador de voltaje para alimentar las operación de borrado y 

programado de memoria. 
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Entre las características del módulo de Memoria Flash del MSP430 tenemos: 

• Generación del voltaje interno necesario para las operaciones de 

programado y borrado de la memoria 

• Programación a nivel de bit, byte o palabra 

• La operación de la memoria Flash requiere de un bajo consumo de 

energía 

• Borrado de la memoria por segmentos o masivamente 

 

2.2.1.6.1 Segmentación de la Memoria Flash 

 
La memoria Flash del MSP430 esta particionada en segmentos. Aunque es 

direccionable y programable a nivel de bit, byte, y palabra, el segmento es la 

porción más pequeña de memoria que puede ser borrada. 

 

La memoria Flash de cada dispositivo está particionada en 2 secciones: la 

sección de memoria principal (Main Memory) y la sección de memoria de 

información (Information Memory). No existe diferencia alguna en la operación 

de ambas secciones, código de programa o datos de usuario pueden ser 

grabados sin problema. La única diferencia es el tamaño total de memoria flash 

y el tamaño del segmento de cada uno. En la familia de microcontroladores 

MSP430F2012 / MSP430F2013 la sección de memoria de información contiene 

4 segmentos de 64 bytes cada uno con un total de 256 bytes, mientras que la 

sección de memoria principal contiene 4 segmentos de 512 bytes cada uno, 

dando un total de 2K bytes de memoria. Entonces, la memoria Flash total es de 

2048 bytes + 256 bytes = 2304 bytes.  

 

En la Figura 2.11 se muestra un ejemplo de segmentación de la memoria flash 

de un dispositivo que tiene 4K bytes de memoria principal + 256 bytes de 

memoria de información, es decir,  posee 8 segmentos de memoria principal y 

4 segmentos de memoria de información. 
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Figura 2.11: Ejemplo de segmentación de la memoria flash de un dispositivo 

con 4K bytes de memoria principal + 256 bytes de memoria de información. 

(Fuente: Texas Instruments) 

 

2.2.1.6.2 Modo de operación de la memoria Flash 

 

EL modo de operación por default de la memoria Flash es de solo lectura. En 

este modo, las operaciones de borrado o escritura no pueden ser iniciadas 

debido a que el generador de sincronización y el generador de voltaje para el 

módulo de la memoria flash están apagados, de esta manera opera 

idénticamente igual a una memoria ROM. 

 

La memoria Flash del MSP430 puede ser programada por el mismo CPU y no 

necesita de voltajes externos adicionales. Para seleccionar los modos de 

escritura o borrado se utilizan los bits BLKWRT (Block Write mode), WRT 

(Write), MERAS (Mass erase), y ERASE. Estos modos pueden ser: 

 

• Escritura por byte o palabra 

• Escritura por bloque 
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• Borrado de segmento 

• Borrado masivo (solo los segmentos de memoria principal) 

• Borrado Total (todos los segmentos de memoria) 

 

Mientras la memoria Flash es programada o borrada se prohíbe la lectura o 

escritura de la misma. Si se requiere que el CPU trabaje mientras se realiza 

una de estas operaciones, se debe ubicar el código en la memoria RAM. 

Cualquier actualización de la memoria Flash puede ser iniciada desde la 

memoria Flash o desde la RAM. 

 
2.2.1.6.2.1 Programación (Escritura) de la Memoria Flash 

 

Los modos de escritura son seleccionados mediante los bits BLKWRT y WRT, 

estos modos están descritos en la Tabla 2.5 

 

BLKWRT  WRT Modo de escritura  

0 1 Escritura de byte o palabra 

1 1 Escritura en Bloque 

Tabla 2.5: Modos de escritura de la memoria Flash. (Fuente: Texas 

Instruments) 

 

Ambos modos de escritura usa una secuencia de peticiones individuales de 

escritura, pero si se usa el modo de escritura en bloque es por lo menos 2 

veces más rápido escribir un bloque completo que escribirlo en modo de byte o 

palabra, debido a que el generador de voltaje permanece encendido todo el 

tiempo que se escribe el bloque y en cambio, en el modo byte o palabra el 

generador continuamente esta encendiéndose y apagándose. Cualquier 

instrucción que modifique la memoria de destino puede usarse para modificar 

la memoria Flash.  

 

Una palabra (byte bajo + byte alto) no debe ser escrita más de 2 veces entre 

ciclos de borrado debido a que esta acción puede provocar daños en la 

memoria Flash. 

 



60 

 

 

El bit BUSY es puesto a 1 mientras la operación de escritura esta activa y es 

puesto a 0 cuando la operación ha finalizado. Si la operación de escritura es 

iniciada desde la RAM, el CPU no debe acceder a la memoria Flash mientras el 

bit BUSY esta activado, de lo contrario, una violación de acceso se producirá, 

el bit ACCVIFG (Access Violation Interrupt Flag) es activado y el resultado de la 

escritura es indeterminado. La operación de escritura puede ser iniciada 

también desde la memoria Flash, en este caso, la sincronización está 

controlada por el módulo de la memoria Flash y la CPU es detenida hasta que 

la petición de escritura finalice. Una vez que la petición ha finalizado, la CPU 

continúa la ejecución del programa con la instrucción siguiente a la petición de 

escritura. 

 

2.2.1.6.3 Controlador de la memoria Flash 

 
Los registros FCTLx (Flash Memory Control Register) son registros de 16 bits 

de lectura/escritura protegidos por contraseña, cualquier acceso sobre estos 

debe usar instrucción de palabra y la petición de escritura debe incluir la 

contraseña 0A5h en el byte alto de la palabra a setear. Cualquier intento de 

escritura en cualquiera de los registros FCTLx con cualquier valor diferente al 

valor 0A5h, es una violación a la clave de seguridad, lo que activa la bandera 

KEYV (Flash Security Key Violation) y dispara el evento PUC de reseteo del 

sistema. 

 

Cualquier intento de lectura en cualquiera de los registros FCTLx dará como 

resultado el valor 096h en el byte alto.  

 

Cualquier intento de escritura en el registro FCTL1 durante una operación de 

borrado o escritura provoca una violación de acceso y activa el bit ACCVIFG. 

Escribir sobre FCTL1 está permitido en el modo de escritura en bloque cuando 

el bit WAIT esta puesto a 1, pero cualquier intento de escritura sobre FCTL1 en 

el mismo modo de escritura en bloque cuando el bit WAIT esta puesto a 0 

produce una violación de acceso y activa el bit ACCVIFG. De igual manera, 

cualquier intento de escritura en FCTL2 cuando el bit BUSY esta puesto a 1 es 
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una violación de acceso. Cualquiera de los registros FCTLx pueden ser leídos 

mientras el bit BUSY esta puesto a 1, esto no provoca una violación de acceso. 

 

2.2.1.6.4 Interrupciones del controlador de la memoria Flash 

 
El controlador de la memoria Flash dispone de dos Fuentes de interrupción, 

KEYV y ACCVIFG. 

 

La bandera ACCVIFG es activada cuando una violación de acceso ocurre. 

Cuando al bit ACCVIE (Flash Memory Access Violation Interrupt Enable) se lo 

habilita consecutivamente después de una operación de borrado o escritura de 

la Flash, la activación de la bandera ACCVIFG genera una petición de 

interrupción. La bandera ACCVIFG alimenta el vector de interrupción no 

enmascarable, es por esto que no es necesario que el bit de interrupción 

general este activado para que se ejecute la interrupción. También puede ser 

verificado por el programa del usuario para chequear si existe o no una 

violación de acceso a la memoria Flash, pero siempre debe ser puesta a 0 por 

el programa en ejecución. 

 

La bandera de violación a la clave de seguridad KEYV es activada cuando 

cualquiera de los registros del controlador de la memoria Flash son escritos con 

una contraseña incorrecta, cuando esto ocurre, el evento PUC es generado 

reiniciando de inmediato el microcontrolador. 

 

2.2.1.7 Interfaz de comunicación serial universal, trabajando en modo I2C 

 

La Interfaz de comunicación serial universal (Universal Serial Comunication 

Interface)  es un módulo que soporta múltiples modos de comunicación serial. 

Diversos módulos USCI pueden soportar varios modos de comunicación serial. 

Cada módulo USCI es denominado con una letra diferente, así, el módulo 

USCI_A es diferente al módulo USCI_B. Si en un microcontrolador se dispone 

de más de un módulo USCI del mismo tipo, se diferenciaran entre sí por un 

número, por ejemplo si un dispositivo tiene dos módulos USCI_A, el primer 
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módulo será el USCI_A0 y el segundo será el USCI_A1. Los modos de 

comunicación soportados por cada tipo de módulo USCI son: 

 

Módulo USCI_Ax: 

• Modo UART 

• Tipo pulso para comunicaciones IrDA 

• Detección automática de la velocidad de transmisión en comunicaciones 

LIN 

• Modo SPI 

 

Módulo USCI_Bx: 

• Modo I2C 

• Modo SPI 

 

2.2.1.7.1 Introducción al módulo USCI: Modo I2C 

 
En el modo I2C (Inter-Integrated Circuit), el módulo USCI provee una interfaz 

entre el microcontrolador MSP430 y los dispositivos compatibles con I2C 

conectados mediante el método de bus serial I2C de 2 líneas. Componentes 

externos enlazados al bus I2C transmiten o reciben datos seriales desde y 

hacia el módulo USCI a través de la interfaz I2C de 2 líneas. 

 

Las características del modo I2C incluyen: 

• Cumple con las especificaciones descritas en la Philips Semiconductors 

I2C specification v2.1. 

• Soporta los modos de direccionamiento de 7 bits y de 10 bits. 

• Llamado general. 

• Señales de START, RESTART, STOP. 

• Modo Multi-Master para la transmisión y recepción de datos. 

• Modo Esclavo para la transmisión y recepción de datos. 

• Soporta el modo estándar que provee velocidades de hasta 100kbps o el 

modo “fast” que soporta hasta 400kbps. 

• Frecuencia programable en el Modo Master. 
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• Diseñado para un bajo consumo de energía. 

• En modo esclavo, se detecta la señal de START que permite salir de 

cualquier modo de bajo consumo de energía. 

• Permite la operación del esclavo en modo LPM4. 

 
El modo I2C soporta cualquier dispositivo Master o Esclavo I2C compatible. En 

la Figura 2.12 se muestra un ejemplo de un bus I2C, cada dispositivo es 

reconocido por una dirección única y puede operar tanto como trasmisor y 

como receptor. Un dispositivo enlazado al bus I2C puede ser considerado 

como Master o Esclavo cuando realiza una transferencia de datos. El 

dispositivo Master inicia la transferencia de datos  y genera la señal de reloj 

SCL (Serial Clock). Cualquier dispositivo direccionado por el Master puede ser 

considerado un Esclavo. 

 

Los datos en el bus I2C son comunicados usando la línea SDA (Serial Data) 

con la señal de reloj generada en SCL. Estas líneas son bidireccionales y 

deben estar conectadas a una referencia positiva mediante una resistencia de 

pull-up. Cabe anotar que los terminales SDA y SCL de los microcontroladores 

MSP430 no deben ser conectados a voltajes de referencia mayores al voltaje 

de alimentación del dispositivo. 

 

 

Figura 2.12: Diagrama de conexión del bus I2C. (Fuente: Texas Instruments) 

 

2.2.1.7.2 Datos seriales en el bus I2C 

 

El dispositivo Master genera un pulso de reloj para cada bit que transfiere. El 

modo I2C opera con bytes (8 bits) y transfiere el bit más significativo primero, 
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como se muestra en la figura 2.13. El primer byte que sigue a la condición 

START consiste en la dirección de 7 bits del esclavo y el bit de 

Lectura/Escritura (R/W). Cuando el bit R/W es cero, el Master transmite datos 

al esclavo, en cambio, cuando R/W es uno, el Master recibe datos desde el 

Esclavo. El bit ACK (Acknowledgement) es enviado desde el receptor después 

de cada byte en la novena señal de reloj en la línea SCL.  

 

 

Figura 2.13: Transferencia de datos en el módulo I2C. (Fuente: Texas 

Instruments) 

 

Las condiciones de START y STOP son generadas por el dispositivo Master, la 

condición START es una transición de alto a bajo en la línea SDA mientras la 

línea SCL está en nivel alto y la condición de STOP es una transición de bajo a 

alto en la línea SDA mientras la línea SCL está en nivel alto. El bit de bus 

ocupado, UCBBUSY (Bus Busy), se activa después de la condición START y 

se lo borra luego de la condición STOP. Los datos en la línea SDA deben estar 

estables durante el periodo en que la señal de reloj SCL está en nivel alto como 

se muestra en la Figura 2.14. Los estados de nivel alto y bajo solo pueden ser 

cambiados cuando la línea SCL se encuentra en nivel bajo, de otro modo las 

condiciones de START o STOP pueden generarse. 

 

 

Figura 2.14: Transferencia de bits en el bus I2C. (Fuente: Texas Instruments) 
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En el modo I2C el módulo USCI puede operar de 4 maneras, en la figura 2.15 

se muestra un resumen de los modos de operación posibles en el módulo I2C. 

 

 

Figura 2.15: Modos de operación del módulo I2C. (Elaborado por el autor) 

 
Si dos o más dispositivos Master transmiten la condición de START 

simultáneamente sobre el bus I2C, el procedimiento de arbitraje es invocado. 

En la Figura 2.16 se muestra el procedimiento de arbitraje entre 2 dispositivos 

Master. Este procedimiento usa el dato que se encuentra presente en cada uno 

de los buffers de salida de los dispositivos contendores. El primer Master que 

necesitara setear la línea SDA en nivel alto será sobrescrito por aquel que 
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generara un nivel bajo en la misma línea. El procedimiento de arbitraje da la 

ventaja al dispositivo que transmita los datos binarios de menor valor. El 

dispositivo Master que pierde la contienda pasa automáticamente a modo de 

I2C Esclavo como Receptor y activa la bandera de “Perdida del arbitraje” 

UCALIFG (Arbitration Lost Interrupt Flag). En el caso de que 2 o más 

dispositivos envíen los mismos bytes iniciales, el arbitraje continua con los 

subsecuentes bytes transmitidos. 

 

 

Figura 2.16: Procedimiento de arbitraje entre dos dispositivos Master. (Fuente: 

Texas Instruments) 

 
Si el procedimiento de arbitraje esta en progreso y uno de los dispositivos 

Master genera la condición de START repetitivo o de STOP en la línea SDA, 

los dispositivos que están involucrados en el arbitraje deben enviar la condición 

de START repetitivo o de STOP en la misma posición. El arbitraje no está 

permitido entre: 

• Una condición de START repetitivo y un bit de datos. 

• Una condición de STOP y un bit de datos. 

• Una condición de START repetitivo y una condición de STOP. 

 

2.2.1.7.3 Interrupciones del módulo USCI en modo I2C 

 
El modo USCI en modo I2C tiene 2 vectores de interrupción. El primero está 

asociado con las banderas de interrupción de transmisión y recepción y el 

segundo vector de interrupción  está asociado con las banderas de interrupción 

de los cuatro tipos estados. Cada bandera de interrupción tiene su propio bit de 

habilitamiento de la interrupción. Cuando una interrupción es habilitada y el bit 
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GIE esta activado, la bandera de interrupción generara un pedido de 

interrupción. Las transferencias que realice el controlador DMA (Direct Memory 

Access)  son controladas por las banderas UCBxTXIFG (Transmit Interrupt 

Flag) y UCBxRXIFG (Receive Interrupt Flag) en los dispositivos que poseen el 

controlador DMA. 

 
 
2.2.2 DESCRIPCION Y DESARROLLO DE LA APLICACIÓN PRÁCTICA Y 

LOS MÓDULOS NECESARIOS PARA SU FUNCIONAMIENTO 

 

El desarrollo de la aplicación busca mostrar todas las capacidades que el 

prototipo posee, pero para que la aplicación pueda funcionar se necesita que el 

prototipo tenga una serie de programas y funciones que permiten al prototipo 

comunicarse entre sus componentes y evitan que el usuario tenga que realizar 

las mismas configuraciones necesarias para el funcionamiento del mismo. 

 

En la primera parte se explicará y detallará el funcionamiento de cada uno de 

los módulos requeridos por el prototipo para su funcionamiento, los protocolos 

creados para las comunicaciones internas mediante I2C y la comunicación al 

PC mediante RS-232 estará incluida en el anexo E.  

 

La segunda parte mostrará el ejemplo que se utilizó mientras se desarrollaba el 

prototipo, con el cual se pudo comprobar el correcto funcionamiento de cada 

uno de los módulos.   

 

Debido a que el código fuente de cada módulo es demasiado extenso, no se 

encuentran incluidos en los anexos, se encontraran ubicados en el CD-ROM o 

soporte magnético adjunto al material impreso de este proyecto. 

 

2.2.2.1  Módulos del prototipo: explicación de los programas  

 

El prototipo consta de 4 módulos y cada uno de ellos realiza una función bien 

definida. Debido al número de entradas/salidas que posee cada integrado y al 
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número de periféricos que se necesitan integrar al prototipo, se dividió el 

funcionamiento de cada dispositivo.  

 

Para la comunicación entre cada uno de ellos se usará el protocolo I2C, que es 

un protocolo de comunicación serial que utiliza dos líneas, la primera envía 

desde un dispositivo Master la señal de reloj y la segunda línea es usada para 

transmitir/recibir los bytes correspondientes.  

 

Se escoge implementar este protocolo debido a que los microcontroladores 

usados en el prototipo tienen el hardware necesario para llevar a cabo la 

comunicación I2C. 

 

Los módulos implementados son: 

 

1. Comunicación RS-232, Conversión Análogo/Digital y multiplexacion de 

las entradas analógicas (Master) 

2. Manejo del Display LCD (Esclavo Display) 

3. Decodificación del Teclado (Esclavo Teclado) 

4. Salidas Digitales y almacenamiento de datos  (Esclavo Salidas) 

 

Las direcciones I2C esclavo utilizadas por el dispositivo Master para la 

comunicación son: 

 

• Dirección I2C del esclavo Teclado: 0x011h, en decimal: 17 

• Dirección I2C del esclavo Display:  0x012h, en decimal: 18 

• Dirección I2C del esclavo Salidas   0x013h, en decimal: 19 

 

En la figura 2.17 se resumen los módulos que integran el prototipo de acuerdo 

a la comunicación I2C que utiliza. 
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Figura 2.17: Resumen de los módulos que conforman el prototipo. (Elaborado 

por el autor) 

 

2.2.2.1.1  Módulo 1: Comunicación RS-232, Conversión Análogo/Digital y 

multiplexación de las entradas análogas 

 

La idea principal de este módulo es la de proporcionar al prototipo la capacidad 

de comunicarse con el PC mediante la interfaz RS-232, así mismo, permite el 

uso de 4 entradas análogas multiplexadas y seleccionadas secuencialmente 

por el microcontrolador. Debido a que este módulo tendrá que interactuar 

directamente con el PC se lo seleccionó como el dispositivo Master para la 

comunicación I2C. La librería utilizada tanto para el dispositivo Master como 

para los dispositivos Esclavos fue encontrada en la página web del fabricante. 

Cabe señalar que la librería proporcionada por el fabricante para los 

dispositivos Esclavos fue modificada por que la misma contenía un error en el 

código fuente. En la figura 2.18 se resumen las partes más importantes del 

código fuente diseñado para este módulo. 
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Módulo 1: Comunicación RS-

232, Conversión Análogo/

Digital y multiplexacion de las 

entradas análogas

Funcion GUAR_DAT_I2C

Esta subrutina permite enviar el dato de 2 bytes que 

será almacenado en la memoria Flash del dispositivo 

esclavo “Salidas”. Indica al dispositivo el comando a 

ejecutarse, en este caso el de guardar el valor en 

memoria flash, y a continuación envía los 2 bytes 

correspondientes al valor a almacenar.

Función TXLCDMEN

se encarga de enviar el comando para presentar un 

mensaje predeterminado en pantalla o de enviar los 

datos para presentarlos en pantalla

Subrutinas de comunicación I2C: TransmitCall y 

ReceiveCall

Estas subrutinas permiten enviar/recibir hacia/desde 

el esclavo un bloque de bytes. La dirección del 

esclavo, el número de bytes al igual que la dirección 

de memoria de lectura/escritura de los datos debe 

indicarse antes de invocarse esta función. La 

sintaxis de ambas funciones es similar y solo varia 

en el sentido de la comunicación. Tanto para la 

transmisión o la recepción, el dispositivo Master se 

asegura que la comunicación sea exitosa, caso 

contrario intenta indefinidamente comunicarse hasta 

conseguirlo.

Subrutinas de transmisión de datos seriales al 

PC: TX_Byte y TX_WORD

Las funciones TX_Byte y TX_WORD permiten 

transmitir  uno y dos bytes de datos hacia el PC 

respectivamente. La función TX_WORD consiste en 

repetir 2 veces la función TX_Byte para cada uno de 

los bytes a ser transmitidos, siendo estos bytes 

organizados en forma de palabra “Word” que consta 

de 16 bits.

Vector de interrupción 

TIMERA0_VECTOR, subrutina TA0_ISR

Permite iniciar la recepción de un byte 

proveniente del PC. El Timer_A2 que se 

encuentra en modo de captura utiliza uno 

de los pines del microcontrolador como 

entrada de la señal, la interrupción se da 

cuando la señal de entrada genera una 

transición de nivel alto a bajo, es decir un 

flanco negativo, luego el programa verifica 

el estado de la señal a la mitad de cada bit 

transmitido. Este proceso se lo realiza para 

los 8 bits enviados desde el PC. Al 

finalizar, se analiza el byte recibido 

mediante la función Deco_Byte que 

ejecutara la función requerida en el 

microcontrolador.

Activar o desactivar la sobre-

escritura de las salidas desde el PC

Se setea una bandera interna que 

indica al dispositivo si el estado de las 

salidas es configurado desde el PC o 

desde el programa del usuario.

Borrado de la memoria Flash 

capturada

Se envía un comando que indica al 

esclavo “Salidas” que debe borrar la 

memoria flash de datos. Una vez 

enviada la instrucción se confirma al 

PC enviando el “Código de fin de 

borrado”.

Envío de la memoria capturada

El envío se realiza usando la función PetEnvioMem que primero detiene la ejecución del resto 

de interrupciones y luego obtiene los valores guardados en la memoria Flash del esclavo 

“Salidas” y los enviar directamente hacia el PC, lo que asegura una rápida transmisión y permite 

regresar al funcionamiento normal del microcontrolador una vez finalizada la transferencia de 

datos. Lo primero que se envía es el total de bytes guardados en la memoria, indicando así al 

PC cuantos bytes tiene que esperar a receptar. La función Total_Mem_Capt consulta al esclavo 

“Salidas” el valor de memoria total capturada, el valor que el esclavo devuelva es almacenado 

en la variable  MemUsada

Recepción del código del PC:

Significa que hay enlace entre el PC y 

el Prototipo. Se envía el código del 

Micro como respuesta y a 

continuación se envía la información 

del estado del dispositivo, tanto de las 

entradas como de las salidas. La 

función encargada de la transmisión 

es TX_TODO_PC

Seteo del valor de las Salidas desde 

el PC

El valor de las salidas es recibido 

desde el PC y seteado para ser 

enviado al esclavo “Salidas”, lo que 

permite cambiar el estado de acuerdo 

al valor enviado por el PC.

Vector de interrupción 

WDT_VECTOR, 

subrutina WDT_ISR

Ejecuta el conteo para 

varios temporizadores 

internos, lo que permite 

al dispositivo ejecutar 

diferentes tareas en 

tiempos diferentes.

ProgramaM

La subrutina o función 

ProgramaM permite 

ejecutar el código que 

realiza las siguientes 

tareas:

Convertir la señal analógica 

de los 4 canales de entrada 

en valores digitales. 

La conversión es la misma 

para cada entrada, solo 

cambia el código para la 

selección de la entrada.

Ejecutar el código de 

usuario.

Este código está integrado 

bajo la subrutina 

CODIGO_USER y debe ser 

escrito por el usuario.

Configurar el estado de las 

salidas digitales con los 

nuevos valores.

De ser el caso, debe 

configurar con el valor 

sobrescrito desde el PC. El 

envió de los datos se lo hace 

mediante el protocolo I2C al 

esclavo “Salidas” usando la 

función TransmitCall

Verificar el menú de usuario 

del prototipo.

El menú del prototipo tiene las 

siguientes opciones, 

organizadas por niveles:  Nivel 0: 

Controlador V1.0 - A-Memoria X-

Fin, Nivel 1: Memoria Total -

Memoria Usada, Nivel 2: 

Controlador y PC - ! 

CONECTADOS !. El nivel 2 no 

se puede acceder mediante el 

teclado del prototipo, solo es 

mostrado cuando el 

microcontrolador ha detectado el 

enlace con el PC, además, se 

bloquea la selección desde 

teclado del menú.

Subrutina inicial (RESET)

Inicializar Puntero

Detengo el reloj de vigilancia y lo configuro como un 

contador de intervalos por interrupción

Conversor A/D Sigma/Delta, se escoge un voltaje de 

referencia interno de 1.2 Voltios y el reloj de trabajo 

será el SMCLK, la entrada analógica es la A2+/-, el 

conversor trabaja en modo de “Single Conversión” y 

el resultado es presentado en formato unipolar, es 

decir, a 0 voltios el valor binario será 0 y al máximo 

voltaje el valor binario será 65535

Para la comunicación RS-232 el microcontrolador 

utilizara el Timer_A2, tanto en modo de captura como 

en modo de modulación de ancho de pulso (PWM). 

El registro CCTL1 será utilizado para la transmisión 

mientras que el registro CCTL0 será usado para la 

recepción.

La función RX_Ready permite configurar al 

dispositivo para recibir un byte proveniente del puerto 

serial del PC, es decir que, configura el Timer_A2 en 

modo de captura.

Habilito la bandera de interrupción general

 

Figura 2.18: Resumen del modulo 1: Comunicación RS-232, Conversión 

Análogo/Digital y multiplexación de las entradas análogas. (Elaborado por el 

autor) 
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2.2.2.1.2  Módulo 2: Manejo del Display LCD 

 

EL manejo del display se lo realiza mediante 4 líneas de datos y 3 líneas de 

control, de esta manera podemos trabajar con el mismo microcontrolador sin 

necesidad de reemplazarlo con uno de mayores prestaciones. En este modo de 

trabajo,  el dato de 8 bits se envía en 2 secuencias de 4 bits. 

 

EL módulo permite inicializar el display, controlar el apagado o encendido del 

Led de Backlight del display para permitir el ahorro de energía además de que 

está diseñado para comunicarse con otros dispositivos mediante el uso del 

protocolo I2C en modo Esclavo.  

 

Los comandos que dispone mediante el protocolo I2C sirven para ejecutar la 

gran mayoría de comandos propios del display y también otros propios del 

funcionamiento interno del prototipo. 

 

Debido a que está configurado en modo I2C esclavo, cualquier dispositivo 

externo que desee controlarlo simplemente deberá conocer su dirección y los 

comandos respectivos. 

 

Para el funcionamiento del prototipo, este módulo incluye en su memoria 

mensajes que son mostradas al usuario dependiendo de los eventos que 

ocurran en el prototipo.  

 

En la figura 2.19 se resumen las partes más importantes del código fuente 

diseñado para este módulo. 
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Figura 2.19: Resumen del modulo 1: Módulo 2: Manejo del Display LCD. 

(Elaborado por el autor) 

 

2.2.2.1.3  Módulo 3: Decodificación del Teclado Matricial 4 * 4 

  

Este módulo se encarga de la decodificación del teclado, detecta la presión de 

1 o más teclas simultáneamente y queda en espera hasta que el dispositivo 

Master pida la(s) tecla(s) presionada(s). El escaneo se realiza por barrido 

primero de las filas y después de las columnas, permitiendo detectar varias 

teclas presionadas simultáneamente. Cada tecla presionada es codificada con 

valores ASCII que representan los números y letras graficados en el teclado, a 

excepción de la tecla asterisco (*) y numeral (#), que se representan con las 

letras E y F respectivamente. 
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El módulo está configurado en modo I2C Esclavo, de esta manera se puede 

acceder a este módulo si se conoce su dirección I2C esclavo. Para el envió de 

las teclas presionadas, primero envía el numero de teclas detectadas y a 

continuación envía una tras otra las teclas decodificadas.  

 

Al igual que el anterior módulo configurado en modo I2C esclavo, solo existe 

una función externa para el uso de la librería de comunicación I2C, esta es 

TI_USI_I2C_SlaveInit que configurara el dispositivo con la dirección I2C 

esclavo 0x011h. En la figura 2.20 se muestra un resumen de las principales 

características del programa que compone el módulo. 

 

 

Figura 2.20: Resumen de la principales características del programa que 

integra el módulo. (Creado por el autor) 
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2.2.2.1.4  Módulo 4: Salidas Digitales y almacenamiento de datos 

 

Este módulo permite controlar las salidas digitales y además permite almacenar 

datos en la memoria flash interna del microcontrolador. Está configurado en 

modo I2C esclavo para poder comunicarse con los otros módulos existentes en 

el prototipo. Los comandos I2C que puede recibir permiten: El control del 

estado de cada una de las salidas, almacenar un dato de 2 bytes en memoria, 

recuperar la información almacenada en memoria, borrar la memoria Flash de 

datos del dispositivo y verificar la cantidad de bytes utilizados por los datos 

almacenados en la memoria Flash. 

 

En las figuras 2.21.a y 2.21.b se resumen las partes más importantes del 

código fuente diseñado para este módulo. 

 

 

Figura 2.21.a: Resumen del Módulo 4: Salidas Digitales y almacenamiento de 

datos – Subrutinas RESET, TxCallback y StartCallback. (Elaborado por el 

autor). 
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RxCallback

Función que es llamada al recibirse un byte desde el dispositivo Master. El byte 

recibido es entregado al programa principal para su análisis y al finalizar la función 

debe indicarse si se mantiene o no el estado de bajo consumo de energía en el que 

se encuentra la CPU. Dentro de esta función se implementa la decodificación del 

byte para ejecutar cada una de las subrutinas necesarias para cumplir con los 

comandos establecidos. Las funciones implementadas son

BorradoMem

Subrutina que realiza el borrado 

de la memoria Flash de 

captura. Borra 2 segmentos de 

512 bytes memoria flash 

respaldando previamente el 

valor de los vectores de 

interrupción que se encuentran 

en el segundo segmento a 

borrarse. Los vectores de 

interrupción ocupan en total 32 

bytes de memoria, la cual debe 

colverse a restaurar una vez 

terminado el ciclo de borrado.

BorrarSegFlash

Permite borrar un segmento de 

la memoria Flash. El segmento 

es seleccionado al indicarse o 

la dirección inicial del 

segmento o una dirección que 

contenga al segmento. La 

subrutina desbloquea la 

memoria Flash y setea el bit 

de borrado de la misma.

EnvDatosCap

Función que permite el envió de toda la 

memoria Flash capturada. Indica al puntero 

general la dirección de memoria donde inicia 

la memoria Flash utilizada para la captura de 

datos. El dispositivo master entonces 

realizara la petición byte a byte de los valore 

almacenados en la memoria hasta completar 

el total de bytes capturados, información que 

obtuvo al ejecutar la petición de “memoria 

total capturada”

EnvTotalMemUsa

Esta subrutina envía el total de 

memoria usada por los datos de 

usuario. El envió se  efectúa 

indicando la locación de memoria 

en donde se encuentran los datos 

a ser enviados, entonces el 

dispositivo master realizara la 

petición de los bytes requeridos.

EscFlash16

subrutina que 

desbloquea la memoria 

Flash para permitir su 

escritura. Finalizada la 

escritura se la vuelve a 

bloquear.

GuardarDato

Permite al microcontrolador 

almacenar un dato de 2 bytes en 

la memoria flash. La función 

verifica que el dato a guardar no 

tenga el valor 0xFFFFh, que de 

ser el caso, se disminuirá en uno 

para almacenar el valor 

0xFFFEh. La función 

EscFlash16 tiene el código 

necesario para permitir escribir 

un valor de 2 bytes en la 

memoria Flash.

SalidasFunc

Configura el estado de las salidas 

dependiendo del valor recibido desde 

el dispositivo master. El código 

recibido desde el dispositivo master 

es: 0000DCBA donde D, B, C y A es 

el estado de las salidas 4, 3, 2 y 1 

respectivamente. La subrutina 

primero setea en 1 las salidas cuyo 

código así lo indique y segundo setea 

en 0 las salidas con igual código.

 

Figura 2.21.b: Resumen del Módulo 4: Salidas Digitales y almacenamiento de 

datos – Subrutina RxCallback. (Elaborado por el autor). 

 

2.2.2.2  Ejemplo usado en el desarrollo del prototipo  

 

El ejemplo utilizado en el desarrollo del prototipo, permite en forma general 

verificar el funcionamiento de cada una de las entradas y salidas existentes en 

el prototipo, la idea principal es utilizar cada una de las entradas como un 

interruptor para cada una de las salidas.  

 

El encendido o apagado de cada salida se la realiza discriminando el valor 

obtenido luego de la conversión, este valor digital puede ser: 

 

• A 0 Voltios de entrada, el valor digital será 0 

• A 5 Voltios de entrada, el valor digital será 65535 
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Con estos datos se estableció un valor de escala media,  32767, con el cual se 

indicaba que a valores de entrada menores o iguales la salida correspondiente 

estará apagada y valores superiores la salida estará encendida, con esto las 

entradas estarán trabajando como si se trataran de entradas digitales. 

 

El ejemplo también determina que el valor a ser almacenado cada 10 minutos 

en la memoria Flash será el valor que la entrada 4 tenga en ese momento.  

 

2.2.2.2.1 Variables, Constantes, Registros y Banderas que el usuario puede 

utilizar 

 

Aunque el código interno de trabajo del prototipo consume gran cantidad de 

recursos del microcontrolador, los recursos que se han logrado liberar están 

disponibles para que el usuario los utilice. A continuación se entrega una lista 

con todos los recursos disponibles para el usuario. 

 

• Variables con valores que el usuario puede utilizar 

 

� La tabla 2.5 muestra el nombre de las variables con el resultado de la 

conversión digital de las entradas 

 

Nombre Longitud Descripción 

&ENTRADA_A  2 bytes Valor de la entrada A 

&ENTRADA_B 2 bytes Valor de la entrada B 

&ENTRADA_C 2 bytes Valor de la entrada C 

&ENTRADA_D 2 bytes Valor de la entrada D 

Tabla 2.5: nombre de las variables con el resultado de la conversión 

digital. (Elaborada por el autor). 

 

� La Variable “DatGuardar” debe contener el valor a ser almacenado en la 

memoria Flash, este valor debe tener una longitud de 2 bytes (1 

palabra) 
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� La variable &Temporal1 puede ser utilizada como una variable temporal, 

cuyo contenido será válido mientras no se termine la ejecución del 

código de usuario. 

 
� Memoria RAM disponible para el usuario: 8 bytes. 

 
� Los registros de la CPU que el usuario puede utilizar sin ninguna 

restricción como registros no-volátiles, son los registros R5, R6, R7, R8, 

R9, R10, R11. Estos registros de 2 bytes de longitud serán alterados 

solo cuando el prototipo sea desconectado de la red eléctrica. 

 
� El usuario puede afectar el estado de las salidas directamente, para ello, 

debe utilizar la variable &Banderas y establecer el estado que requiera 

sobre una o más entradas, la manera de hacerlo es mediante las 

instrucciones “BIS”, “BIC”, “BIT” y el nombre de la salida. He aquí 

algunos ejemplos: 

 
o Activar la Salida 1 y la Salida 3  

BIS #SALIDA_1+ SALIDA_3, &Banderas 

 

o Desactivar la Salida 2  

BIC #SALIDA_2, &Banderas 

 

o Verificar el estado de la Salida 4  

BIT #SALIDA_4, &Banderas 

JC Salida_activada   ; La salida esta activada, ejecuto el código respectivo 

; Salida desactivada   

 

� El usuario también tiene acceso a 4 banderas de estado dentro de la 

variable &Banderas, estas banderas son: BandUsu_1, BandUsu_2, 

BandUsu_3, BandUsu_4, cuyas equivalencias son:  

 

; BandUsu_1       EQU      1000h 

; BandUsu_2       EQU      2000h 

; BandUsu_3       EQU      4000h 
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; BandUsu_4       EQU      8000h 

 

2.2.2.2.2 Programa demostrativo 

 

Como se indico antes, el programa permite utilizar las entradas como 

interruptores del estado de la respectiva salida, el código fuente está indicado a 

continuación: 

;/////////////////////////////////////////////////////////////////////////////// 

CODIGO_USER;                  Código de Usuario (INICIO) 

;/////////////////////////////////////////////////////////////////////////////// 

mov.w &ENTRADA_D,DatGuardar  

cmp   #32767,&ENTRADA_A     ; comparo la entrada con la mitad de la escala 

jc    SET_1_A 

bic.b #SALIDA_1,Banderas    ; apago la salida 

jmp   ENT_B 

SET_1_A      bis.b #SALIDA_1,Banderas    ; enciendo la salida             

ENT_B        cmp   #32767,&ENTRADA_B     ; comparo la entrada con la mitad de la escala 

jc    SET_1_B 

bic.b #SALIDA_2,Banderas    ; apago la salida 

jmp   ENT_C 

SET_1_B      bis.b #SALIDA_2,Banderas    ; enciendo la salida             

ENT_C        cmp   #32767,&ENTRADA_C    ; comparo la entrada con la mitad de la escala 

jc    SET_1_C 

bic.b #SALIDA_3,Banderas    ; apago la salida 

jmp   ENT_D 

SET_1_C    bis.b #SALIDA_3,Banderas    ; enciendo la salida             

ENT_D       cmp   #32767,&ENTRADA_D     ; comparo la entrada con la mitad de la escala 

jc    SET_1_D 

bic.b #SALIDA_4,Banderas    ; apago la salida 

jmp   FIN_USER 

SET_1_D   bis.b #SALIDA_4,Banderas    ; enciendo la salida             

;/////////////////////////////////////////////////////////////////////////////// 

FIN_USER    ret;                          Código de Usuario (FIN) 

;/////////////////////////////////////////////////////////////////////////////// 
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2.3 DESCRIPCIÓN Y DESARROLLO DE CLASES Y LIBRERÍAS 

PARA EL PROGRAMA ESPECIAL DE CONTROL ENTRE EL 

PC Y EL PROTOTIPO 

 

La interfaz que el usuario podrá utilizar para interactuar con el prototipo será 

escrita en su mayor parte en el lenguaje Visual BASIC 2005. La descripción de 

las librerías creadas específicamente para la implementación de este programa 

serán analizas y explicadas posteriormente, además, podrán ser escritas en 

otros lenguajes integrados en la herramienta Visual Studio 2005 u otras versión 

es anteriores. 

 

Debido a que el código fuente de cada módulo es demasiado extenso, no se 

encuentran incluidos en los anexos, se encontraran ubicados en el CD-ROM o 

soporte magnético adjunto al material impreso de este proyecto. 

 

2.3.1 RESUMEN DE LOS ENSAMBLADOS DLL CREADOS PARA LA 

INTERFAZ DEL USUARIO 

 

Los ensamblados o DLL’s que acompañan a la aplicación principal llamada 

“interfaz” son: 

 

• Dialogos_Folder_File 

• Manejo de archivos 

• Simulacion Teclas: Este ensamblado consta de 2 DLL, creados en Visual 

Studio 2002. Estos son: 

o Simulacion CPP.dll 

o DLL_String.dll 

 

2.3.1.1 Ensamblado/Librería Dialogos_Folder_File  

 

Esta librería contienen las ventanas de dialogo más utilizadas por los usuarios, 

estas ventanas permiten seleccionar archivos para su apertura, para su 

guardado, selección de carpetas, etc. El nombre de la clase de la cual debe 
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crearse una instancia es “clsDialogos”. En la figura 2.22 se muestran las 

funciones que el ensamblado pone a disposición del usuario. 

 

Ensamblado/Librería Dialogos_Folder_File, 

Clase “clsDialogos”

Función Abrir_Archivo

Muestra la ventana que permite 

seleccionar archivos para su 

apertura, pero permite 

únicamente seleccionar uno 

solo. Los argumentos 

requeridos son los mismos que 

los utilizados por la función 

Abrir_Archivos

Función Abrir_Archivos

Permite abrir varios 

archivos al mismo tiempo, 

entregando al usuario la 

lista de los archivos 

seleccionados. Como 

argumentos debe 

entregarse los siguientes

Titulo: Titulo que se 

muestra al usuario en la 

ventana. 

Dir_ini: Directorio inicial de 

búsqueda. 

Filtro: Indica que tipos de 

archivos podrá seleccionar el 

usuario dentro de la ventana.

Función Browse_Carpeta

esta función permite buscar 

una carpeta dentro de los 

directorios del PC, como 

repuesta entrega la dirección 

en el disco duro de la carpeta 

seleccionada. Los argumentos 

utilizados por esta función son

Titulo_descripcion: Titulo 

que tendrá la ventana ser 

mostrada al usuario. 

Dir_ini: Directorio desde el 

cual se iniciara la búsqueda 

de la carpeta. Argumento 

Opcional

mostrar_crear_carpeta: indica 

si la función debe mostrar o no 

el botón “Crear Nueva 

Carpeta” en la ventana 

respectiva.

Función Guardar_Archivo

Permite indicar la ruta donde 

se almacenara el archive del 

usuario. Los argumentos son 

los mismos que los utilizados 

por la función Abrir_Archivos. 

El valor de retorno el nombre 

de archivo incluido la ruta 

completa

 

Figura 2.22: Funciones existentes en el ensamblado “Dialogos_Folder_File”. 

(Elaborado por el autor) 

 

2.3.1.2 Ensamblado/Librería Manejo de archivos  

 

Este ensamblado permite la manipulación de archivos, es decir, permite la 

escritura o lectura de datos de usuario, datos de programa, guardar o leer 

configuraciones, etc. También permite realizar la copia de archivos así como 

verificar la existencia física de un archivo en el disco duro. El nombre de la 

clase es “clsManejoArchivo”. En la figura 2.23 se describen las funciones 

existentes en esta clase. 
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Ensamblado/Librería 

Manejo de archivos, Clase 

“clsManejoArchivo”

Funcion Guardar_Objeto

Permite Guardar en un archivo 

las variables y constantes 

utilizadas por el programa, 

están organizadas en forma de 

“arrays”, es decir, vectores. 

Todas las variables son 

contenidas en un “ArrayList”, el 

cual es almacenado en el 

archivo seleccionado. Al igual 

que la función anterior requiere 

los mismos argumentos, con la 

diferencia de que el archivo 

será escrito con los nuevos 

datos.

Función Borrar_archivo

Permite eliminar 

permanentemente un 

archivo del disco duro. La 

función entregara “True” si 

se borro correctamente el 

archivo, caso contrario 

entregara “False”. Como 

argumento debe enviarse 

la ruta completa del 

archivo incluido su 

nombre.

Función Copiar_archivo

Función que permite copiar 

un archivo, como 

argumentos requiere:

Archivo_origen: 

nombre y ruta del 

archivo a copiar.

Archivo_Destino: 

nombre y ruta del 

archivo donde se 

copiaran los datos. 

Argumento Opcional 

reemplazar: indica 

que, en caso de existir 

el archivo de destino 

está o no permitido 

sobrescribirlo. 

Función 

File_Directory_exist

Verifica si un directorio o un 

archivo existe en el disco 

duro. Como argumento debe 

enviarse o la ruta del 

directorio o el nombre y la 

ruta del archivo. Si existe, se 

entregara “True”, caso 

contrario se entregara 

“False”.

Función Guardar_Archivo_Configuraciones

Permite almacenar variables y sus valores en un archivo de configuraciones con el formato descrito 

anteriormente. Las variables deben estar enlistadas en un vector del tipo “String” y sus valores en otro 

vector del mismo tipo. Para indicar el inicio de un segmento de variables debe guardarse el nombre del 

segmento en el nombre de la variable y en su valor. Por ejemplo: 

Variable(0)=”Campo” 

Valor(0)=”Campo” 

Variable(1)=”Variable1” 

Valor(1)=”Patricio Rangles” 

Con los datos entregados de la manera descrita en el ejemplo, se obtendrá el siguiente archivo de 

configuraciones: 

[Campo] 

Variable1=Patricio Rangles 

Al igual que en la función anterior, los argumentos son los mismos y el resultado depende de la existencia 

o no de problemas al guardar el archivo, la diferencia radica en que el archivo servirá para guardar la 

configuración.

Función Info_Archivo

Entrega la información 

completa de cualquier archive 

que se requiera, la 

información es entregada en 

una variable del tipo FileInfo. 

Como argumento se debe 

enviar la ruta completa del 

archivo incluido su nombre.

Función Info_Directorio

Entrega toda la información 

asociada a un directorio. La 

información es entregada 

en una variable del tipo 

DirectoryInfo. Como 

argumento se debe enviar 

la ruta del directorio.

Función Leer_Archivo_Configuraciones

Esta función permite leer un archivo de 

configuraciones que tenga el siguiente 

formato: '[Campo] 'Variable1=Valor1 

'Variable2=Valor2 Como argumentos debe 

enviarse los siguientes: Si existe cualquier 

error durante el proceso de lectura, la 

función entregara “False” como respuesta, 

caso contrario, entregara “True”.

Archivo: Nombre del archivo de 

configuraciones.

Nombre_Variable(): Lista del tipo “String” 

que contendrá el nombre de las variables 

encontradas, el valor correspondiente a cada 

variable se encontrara en la lista 

Valor_Variable().

Valor_Variable(): Lista del tipo “String”, 

contiene el valor de la variable 

correspondiente.

Función Leer_Objeto

Permite leer un archivo de datos 

diseñado para almacenar variables 

y sus valores. Los valores leídos 

son almacenados en un “ArrayList”. 

Si la lectura es exitosa, devuelve 

“True”, caso contrario devuelve 

“False”. Como argumentos deben 

enviarse los siguientes:

Archivo: Nombre del archivo que 

se desea abrir.

Objeto: Lista tipo “ArrayList” en 

donde se almacenaran los datos 

recogidos desde el archivo.

Función Obtener_Valor_Variable

Permite extraer el valor 

almacenado de una variable, 

conocido el nombre del “grupo de 

configuraciones” y el archivo donde 

se las almaceno. Los argumentos 

requeridos son los siguientes: o 

Archivo, Grupo_Config, 

Nombre_Var. Como respuesta la 

función entregara el valor asignado 

a la variable en formato de texto, 

este valor debe ser convertido al 

tipo de variable correspondiente.

Subrutina WinFileCopy

permite copiar un archivo, los 

argumentos necesarios son el 

nombre del archivo de origen y 

el nombre de archive de destino, 

SourceFile y DestFile.

Figura 2.22: Funciones existentes en la librería “clsManejoArchivo”. (Elaborado 

por el autor) 

 

2.3.1.3 Simulación Teclas  

 

Para ejecutar la simulación de teclado, es decir, para permitir que el programa 

simule la “presión” o pulsación de teclas, se ha creado 2 ensamblados o 

librerías que entre sí complementan toda la funcionalidad necesaria para que el 

usuario pueda ejecutar la simulación de presión de una o varias teclas 

combinadas o no. Debido a que en Visual Studio 2002, los comandos 

necesarios para llevar a cabo la simulación de teclado en Visual Basic no están 

disponibles, se recurrió al lenguaje de programación C++ que si los incluye, 

creándose el ensamblado “Simulacion CPP.dll”, también, debido al limitado 
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número de comandos existentes en C++ para el manejo de cadenas de 

caracteres, es necesaria la creación del ensamblado DLL_String.dll que facilita 

en gran medida esta tarea. 

 

Ambos ensamblados están diseñados para trabajar en conjunto, especialmente 

el ensamblado Simulación CPP.dll, que requiere que el ensamblado 

DLL_String.dll esté presente siempre. A continuación se detallan las funciones 

y subrutinas presentes en cada uno de los ensamblados 

 

2.3.1.3.1 Ensamblado/Librería DLL_String 

 

Para crear una nueva instancia de este ensamblado debe utilizarse el nombre 

de su clase que es “clsString”, esta clase está dividida en 2 secciones: la 

primera agrupa las funciones que permiten la manipulación de cadenas de 

texto, mientras que la segunda parte agrupa las funciones que entregan la 

información sobre las teclas existentes en el sistema para su simulación. En las 

figuras 2.24.a y 2.24.b se presentan las funciones existentes en este 

ensamblado. 

 

 

Figura 2.24.a: Funciones existentes en la librería DLL_String, clase clsString. – 

Sección Manejo de cadenas de texto (Elaborado por el autor) 
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Figura 2.24.b: Funciones existentes en la librería DLL_String, clase clsString. – 

Sección Manejo de cadenas de texto (Elaborado por el autor) 

 

2.3.1.3.2 Ensamblado/Librería Simulacion CPP.dll 

 

El código del ensamblado esta desarrollado en el lenguaje C++ debido a la 

facilidad que ofrece el mismo para manipular el hardware del sistema. El 

nombre de la clase es “clsSend_Keys”. En las figuras 2.25.a 2.25.b se 

muestran las funciones y subrutinas a las que el usuario puede acceder una 

vez instanciada la clase. 

 

Ensamblado/Librería 

Simulacion CPP.dll, Clase 

“clsSend_Keys”

Constructor clsSend_Keys()

Constructor por defecto de la clase. 

Configura los parámetros necesarios 

para permitir el uso de la clase.

Subrutina Presionar_Modificadores

Pulsa o presiona los modificadores seteados con 

las funciones Set_M_Ctrl, Set_M_Alt, 

Set_M_Shift, Set_M_Win. Se debe utilizar la 

funcion “Soltar_Modificadores”  para indicar al 

sistema que las teclas virtuales han sido 

“Soltadas”.

Subrutina Presionar_Tecla

Permite indicar al sistema que la tecla 

seleccionada está siendo “pulsada”. Debe 

utilizarse la subrutina “Soltar_Tecla” para 

indicar el estado contrario, es decir, indicar al 

sistema que la tecla ha sido “Soltada”.

Subrutina Send_Tecla_Especial

Permite enviar una sola tecla identificada por el 

codigo respectivo. El codigo de la tecla virtual debe 

ser enviado como el argumento “Tecla_Especial” de 

la función. Al finalizar la simulación, la subrutina 

genera un retardo en la ejecución del programa.

Subrutina Set_Retardo_entre_tecla

Setea el tiempo de espera o retardo 

en milisegundos que se empleara al 

enviar más de una tecla virtual 

consecutiva. El argumento requerido 

es Valor_ms.

 

Figura 2.25.a: Funciones y subrutinas a las que el usuario puede acceder una 

vez instanciada la clase “clsSend_Keys”. (Elaborado por el autor) 
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Figura 2.25.b: Funciones y subrutinas a las que el usuario puede acceder una 

vez instanciada la clase “clsSend_Keys” - Continuación. (Elaborado por el 

autor) 

 

2.3.2 INTERFAZ PARA LA INTERACCION CON EL USUARIO 

 

Para que el usuario pueda acceder a todas las características implementadas 

en el prototipo de propósito general, es necesario que disponga de un 

programa que sea capaz de proporcionarle todas las facilidades de manejo de 

estas características.  

 

La interfaz Prototipo – PC esta implementada de tal manera que permite al 

usuario manipular el prototipo y recoger toda la información que este puede 

entregar con un mínimo de conocimientos de programación. El usuario puede 

realizar seguimientos al estado de las salidas, como a los valores de las 

entradas, también puede acceder a la memoria de datos del prototipo 

permitiéndole extraer toda la información almacenada.  

 

En la figura 2.26 se describen los elementos existentes en el programa 

desarrollado. 
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Figura 2.26: Menús y elementos existentes en el programa desarrollado. 

(Elaborado por el autor) 

 

En el menú Herramientas se integran los siguientes módulos: 

• Interfaz de Interacción 

• Administrador de memoria Flash:  

• Visor del puerto serial 

 

En el menú Configuración, se agrupan las siguientes configuraciones 

disponibles del programa: 

• Configuración  Puerto Serial 

• Configuración  Entrada 

• Configuración  Registro Salidas 

 

A continuación se describen cada una de las opciones disponibles en el menú 

principal. 
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2.3.2.1 Interfaz de Interacción 

 

El módulo interfaz de interacción permite al usuario interactuar directamente 

con el prototipo. En la figura 2.27 se describen las características que el 

programa presenta al usuario. 

 

 

Figura 2.27: Características generales del módulo Interfaz de interacción. 

(Elaborado por el autor) 

 

2.3.2.2 Administrador de Memoria Flash 

 

Este módulo permite administrar la memoria flash que se está utilizando dentro 

del prototipo para la adquisición de datos. El módulo además integra las 

opciones normales para manejar archivos del tipo texto, es decir, permite 

guardar y abrir archivos de datos almacenados anteriormente, con la única 

limitante de que no permite editar los datos recogidos desde el prototipo. En la 

figura 2.28 se resumen las funcionalidades y características de este módulo. 
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Figura 2.28: Características del módulo  Administrador de Memoria Flash. 

(Elaborado por el autor). 

 

2.3.2.3 Visor del puerto serial 

 

Este módulo permite visualizar los datos enviados desde el programa al 

prototipo y también los bytes recibidos desde el prototipo. El módulo fue 

utilizado como una herramienta de depuración mientras se desarrollaban el 

resto de programas y opciones. Para su uso, debe iniciarse uno de los 2 

módulos descritos anteriormente y este debe iniciar la comunicación con el 

microcontrolador. En la figura 2.29 se muestra el módulo Visor del puerto serial 

mientras se ejecutaba el módulo “Interacción PC - Microcontrolador”. 
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Figura 2.29: Visualización de datos del puerto serial mientras se ejecuta la 

interacción entre el PC y el prototipo. (Elaborado por el autor) 

 

La ventana de este módulo permite solo la visualización de datos. El único 

comando disponible para el usuario es el botón “Borrar todos los valores” que 

inicializa la ventana a su estado inicial. Esta herramienta solo visualiza los 

datos recibidos y enviados dentro del programa principal, no se puede utilizar 

para visualizar los datos transferidos en otros programas. 

 

2.3.2.4 Configuración  Puerto Serial 

 

Hace referencia a las configuraciones requeridas por el puerto serial. Estas 

configuraciones serán utilizadas por todos los módulos que existen en la 

aplicación. En la figura 2.30 se muestra el cuadro de dialogo y las opciones a 

configurarse 

 

 

Figura 2.30: Cuadro de dialogo “Configuración del puerto serial” y sus 

opciones. (Elaborado por el autor) 

2.3.2.5 Configuración  Entrada 



89 

 

 

 

En este menú se puede acceder a la configuración de cada una de las 

entradas, al igual que lo permite el botón “Configuración” que existe en la 

sección “Entradas” del módulo “Interacción PC – microcontrolador”. La 

configuración de cada entrada permite seleccionar al usuario el tipo de entrada 

que se utiliza en el prototipo, es decir, permite indicar al programa como debe 

tratar la información que proviene desde las entradas del prototipo. 

 

Dependiendo del tipo de entrada seleccionado por el usuario, el programa 

permite acceder a varias opciones, la opción ninguno permite dejar la entrada 

sin ninguna configuración. Los tipos de entrada existentes son: 

 

• Sensor 

• ON/OFF – Pulsador 

 

También existe la posibilidad de registrar en un archivo los valores de cada 

entrada enviados por el microcontrolador, esto mediante la opción “Registro” 

del cuadro de dialogo “Configuración de entrada”, las opciones que se pueden 

encontrar son detalladas en la figura 2.31. En la figura 2.32 se muestra las 

opciones existentes para el tipo de entrada Sensor y en la figura 2.33 para el 

tipo de entrada ON/OFF – Pulsador.  
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Figura 2.31: Detalle de la configuración de las entradas. (Elaborado por el 

autor) 

 

 

Figura 2.32: Opciones del tipo de entrada “Sensor”. (Elaborado por el autor) 
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Figura 2.33: Opciones del tipo de entrada “ON/OFF – Pulsador”. (Elaborado por 

el autor) 
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En la figura 2.34 se muestran los tipos de comandos existentes para el tipo de 

entrada “ON/OFF – Pulsador”, incluyendo las opciones que posee cada una de 

ellas. Con estas opciones es posible ejecutar la mayoría de programas 

existentes en el PC, o, también, es posible ejecutar combinaciones de teclas 

específicas para ejecutar una acción pre-configurada en el PC. 

 

Simulación de 

Teclas
Línea de 

comandos

En esta versión del programa están disponibles 

2 comandos para su ejecución, estos son:

Simulación de Teclas

Línea de comandos

Para acceder a  las opciones que permiten añadir, 

eliminar o editar cada uno de los comandos, debe 

presionarse el botón derecho del mouse sobre la 

lista de comandos o sobre el comando requerido

Este comando permite al usuario 

“Simular” la pulsación de teclas, esto 

quiere decir que el usuario puede 

realizar cualquier acción que 

normalmente requiera la pulsación de 

una o más teclas ya sean como “tecla 

de acceso rápido” o pulsando una 

tecla a continuación de otra. EL 

programa también permite la 

pulsación de teclas “Especiales” como 

por ejemplo “Teclas Multimedia”, 

teclas de función (F1 a F12), teclas de 

control del cursor (Flecha izquierda, 

derecha, arriba, abajo, avance de 

pagina, retroceso de pagina), entre 

otras. También se incluyen los 

botones del mouse, tanto izquierdo 

como derecho

Opción Tecla de sistema: Permite elegir una tecla específica de entre una lista de teclas presentadas con su 

descripción. Esta lista incluye todas las teclas no alfanuméricas e inclusive teclas no disponibles en ciertos teclados.

Opción Tecla(s) de usuario: Permite al usuario ingresar caracteres alfanuméricos que se deseen presionar. Pueden 

ingresarse cualquier número de caracteres y estos pueden ser cualquier caracter disponible en el teclado. 

Opción Código de tecla especial (en Hexadecimal): Permite al usuario ingresar el código hexadecimal de la tecla que 

se desea presionar. Aunque con las 2 opciones anteriores están cubiertas todas las teclas existentes actualmente, se 

deja esta opción habilitada en caso requerir ingresar un código especifico.

Opción Modificadores/HotKeys: permiten seleccionar que teclas de control serán presionadas para generar una tecla 

de acceso rápido. Los modificadores disponibles son: Alt, Ctrl, Mayúsculas y Tecla Windows. Puede utilizarse todos los 

modificadores al mismo tiempo, siempre y cuando cumplan con una tecla de acceso rápido.

El comando “Línea de comandos” 

permite ejecutar cualquier 

programa que se encuentre en el 

disco duro, además se permite 

añadir parámetros opcionales que 

muchos ejecutables soportan

Comandos disponible para 

el tipo de entrada ON/OFF –

Pulsador

Figura 2.34: Tipos de comandos existentes para el tipo de entrada ON/OFF – 

Pulsador. (Elaborado por el autor) 

 

2.3.2.6 Configuración  Registro Salidas 

 

Esta configuración permite establecer los valores requeridos por el programa 

para almacenar los cambios de estados de cada una de las salidas. En la figura 
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2.35 se muestra el cuadro de dialogo “Configuración del registro” con las 

opciones que el usuario puede cambiar. 

 

 

Figura 2.35: de dialogo “Configuración del registro” y sus opciones. (Elaborado 

por el autor) 

 

2.4 PROGRAMACIÓN DEL MICROCONTROLADOR 

 

2.4.1 DESCRIPCION DE LA HERRAMIENTA DE EMULACION FLASH 

(FLASH EMULATION TOOL- FET)  

 

Texas Instruments ofrece varias herramientas de emulación Flash según los 

diferentes requisitos. En la Tabla 2.6 se detallan las herramientas existentes y 

sus características generales. 

 

Característica  eZ430-

F2013 

eZ430-

RF2500 

MSP-

FET430UIF 

MSP-

FET430PIF 

Soporta todos los dispositivos MSP430 basados 

en memoria Flash (F1xx, F2xx, F4xx, F5xx) 
  X X 

Soporta únicamente los dispositivos 

MSP430F20xx 
X    

Soporta únicamente los dispositivos 

MSP430F20xx/F21x2/F22xx 
 X   

Permite “quemar” el fusible de protección   X  

Voltaje ajustable en el dispositivo de prueba   X  

Voltaje ajustado a 2.8V en el dispositivo de prueba    X 

Voltaje ajustado a 3.6V en el dispositivo de prueba X X   

JTAG de 4 hilos   X X 

JTAG de 2 hilos (*) X X X  

Aplicaciones UART  X   
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Soportado por CCE X X X X 

Soportado por IAR X X X X 

(*) La interfaz de debug JTAG de 2 hilos también es denominada como interface Spy-Bi-Wire (SBW) 

Tabla 2.6: Características de la Herramienta de emulación Flash 

 

2.4.1.1 Instalación del Software 

 

En el CD de instalación se incluye la versión más reciente del software al 

momento del lanzamiento del producto, pero se recomienda buscar en la 

página WEB (http://focus.ti.com/docs/toolsw/folders/print/iar-kickstart.html) la 

última versión disponible para su descarga. 

 

Una vez descargada la última versión disponible (o usando la versión contenida 

en el CD), se procede con la instalación del programa. Para el desarrollo de 

este proyecto se usara el IAR Embedded Workbench KickStart for MSP430 

V5.0, descargado desde la pagina WEB. 

 

Los pasos a seguir para instalarlo son los siguientes: 

 

1) Ejecutamos el instalador, en este caso ejecutamos el archivo 

FET_R513.exe que se encuentra comprimido dentro del archivo 

slac050t.zip, descargado desde la WEB.  

 

2) Al ejecutar este archivo aparece un cuadro de dialogo, en el se debe 

seleccionar el botón SETUP. 

 

3) Aparece el instalador del entorno IAR. Como siguiente paso, presionamos 

NEXT en la pantalla que nos presenta el ordenador. 

 

4) Seguimos los pasos necesarios hasta que la instalación sea completada. Al 

finalizar la instalación, aparecerá una pantalla en la que presionaremos 

“Finish” y seguido de esto se mostrará una página WEB con notas sobre la 

versión que acabamos de instalar, así como enlaces útiles con más 

información sobre esta tecnología. 
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Esta aplicación y sus controladores son compatibles con las siguientes 

plataformas: 

 

Aplicación: Windows® 98, Windows 2000, Windows ME, Windows NT 4.0, 

Windows XP, y Windows Vista ya sea de 32 o 64 bits.  

 

Controladores: La interface FET USB trabaja solamente con Windows 2000, 

Windows XP, y Windows Vista, todas estas en sus versiones de 32 bits. 

 

2.4.1.2 Instalación del Hardware MSP-EZ430-F2013 

 

1. Conecte la interfaz de depuración MSP-EZ430-F2013 a un puerto USB del 

PC. 

 

2. Windows debe reconocer el hardware como "MSP-FET430UIF JTAG Tool". 

El nombre del dispositivo puede variar dependiendo la versión del mismo. 

 

3. El Asistente de Hardware inicia automáticamente y se abre la ventana 

denominada "Asistente para hardware nuevo encontrado", en esta ventana 

debe seleccionarse la opción “No por el momento” para evitar que busque 

el controlador en el internet. Haga clic en siguiente. 

 

4. En la ventana siguiente se debe escoger la opción “Instalar 

automáticamente el software (recomendado)” Al dar clic sobre el botón 

"Siguiente" el Asistente de Hardware intentará encontrar el controlador en 

el sistema. Si el controlador fuese encontrado, entonces se puede 

continuar con el paso 8. En caso de no encontrarse, presione "Regresar" y 

continúe con el paso 5. 

 

5. Seleccione la opción "Instalar desde una lista o ubicación específica 

(avanzado)".  
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6. Seleccione la opción “Incluir esta ubicación en la búsqueda” y seleccione el 

directorio donde están localizados los controladores, que por defecto es 

“C:\ Archivos de programa\ IAR Systems\ Embedded Workbench 5.0\ 430\ 

drivers\ TIUSBFET\ WinXP”. 

 

7. El Asistente muestra un mensaje indicando que el controlador apropiado ha 

sido encontrado. 

 

8. Note que Windows XP muestra una advertencia de que el controlador que 

se quiere instalar no está certificado por Microsoft. Ignore esta advertencia 

y presione "Continuar de cualquier manera”. 

 

9. El Asistente mostrara un mensaje indicando que se ha finalizado la 

instalación del software para el "Adaptador MSP-FET430UIF (TI USB FET)" 

o "MSP430 Application UART". 

 

10. Después de cerrar el Asistente de nuevo Hardware encontrado, Windows 

automáticamente reconocerá otro dispositivo de Hardware llamado "MSP-

FET430UIF - Serial Port". 

 

11. Dependiendo de la versión actual del sistema operativo, los controladores 

correspondientes pueden ser instalados automáticamente o puede ser que 

el Asistente de Nuevo Hardware encontrado se reabra. Si el Asistente se 

presentara solicitando información, entonces repita los pasos descritos 

arriba. 

 

2.4.1.3 Probando el IAR Embedded Workbench y el MSP-ez430-F2013: 

Parpadeando el LED 

 

En el siguiente ejemplo se demuestra el uso del FET con el programa 

introductorio equivalente al ejemplo introductorio del lenguaje C "¡Hola 

Mundo!". Una aplicación que produce el “parpadeo” del LED es escrita y 

descargada al FET, que finalmente reproducirá la aplicación desarrollada. 
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A continuación se describen los pasos que deben seguirse para reproducir el 

ejemplo: 

 

1. Inicie el IAR Embedded Workbench (Menu Inicio → Programas → IAR 

Systems → IAR Embedded Workbench KickStart for MSP430 V4 → IAR 

Embedded Workbench). 

 

2. Haga clic en el menú File → Open Workspace con lo que se abre el cuadro 

de dialogo que permite abrir el siguiente archivo: C:\ Archivos de Programa\ 

Embedded Workbench 5.0\ 430\ FET_examples\ Flashing the LED.eww. 

Una vez seleccionado el archivo la ventana del área de trabajo se abre. 

 

3.  A continuación de un clic sobre la etiqueta al pie de la ventana del área de 

trabajo que corresponde a su dispositivo MSP430 (MSP430xxxx) y el 

lenguaje que se desea usar (ensamblador o C), como se muestra en la 

Figura 2.36. 

 

 

Figura 2.36: Selección del área de trabajo del ejemplo demostrativo “Flashing 

the LED”, lenguaje seleccionado es C. (Elaborado por el autor). 

 

4. Ahora de un clic en el menú Project → Options → FET Debugger → Setup 

→ Connection para seleccionar el puerto apropiado. Las opciones posibles 

son:  

a. Usar el Texas Instruments LPT-IF para el FET de interfaz de puerto 

paralelo (MSP-FET430PIF)  

b. Usar el Texas Instruments USB-IF para el de interfaz USB (MSP-

FET430UIF) que también sirve para el MSP-eZ430-F2013. 
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Para este caso deberá seleccionarse la interfaz USB-IF como se muestra 

en la Figura 2.37 

 

 

Figura 2.37: Selección del puerto USB-IF para la comunicación con el 

dispositivo de pruebas ez430-F2013. (Elaborado por el autor). 

 

5. Luego de un clic en el menú Project → Rebuild All para recompilar el 

código fuente. Se puede mirar el código del ejemplo haciendo doble clic en 

el nombre del proyecto, y después haciendo doble clic en el archivo fuente 

requerido. En la Figura 2.38 se muestra la selección del comando “Rebuild 

All” del menú Project. 

 

 

Figura 2.38: Recopilación del proyecto 
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6. Como siguiente paso, de un clic en el menú Project → Debug para iniciar el 

depurador C-SPY. C-SPY borra primero la memoria Flash del 

microcontrolador para luego descargar el programa compilado en la 

memoria Flash del dispositivo. Cabe indicar que el dispositivo depurador 

eZ430-F2013 debe estar correctamente conectado al puerto USB del PC 

para que la descarga del programa sea realizada correctamente. En el 

anexo B.7 se incluye las preguntas y respuestas a los problemas más 

comunes (FAQ) en caso de que C-SPY sea incapaz de comunicarse con el 

dispositivo. En la Figura 2.39 se muestra la selección del comando Debug 

para iniciar la depuración del ejemplo en el microcontrolador. 

 

 

Figura 2.39: Iniciar la depuración mediante C-SPY 

 

7. Una vez cargada la aplicación en la memoria Flash del microcontrolador de 

un clic en el menú Debug → Go para iniciar la aplicación. El diodo emisor 

de luz debería brillar intermitentemente. 

 

8. Para detener la depuración del programa de un clic en el menú Debug 

→ Stop Debugging, así se termina con la depuración en C-SPY, y se 

regresa al IAR Embedded Workbench. 

 

9. Para salir completamente del programa, de un clic en el menú File → Exit. 
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2.4.1.4 Documentación y fuentes de consulta para los dispositivos de la familia 

MSP430 

 

Las fuentes primarias de información del MSP430 son los datos específicos del 

dispositivo y la guía de usuario. 

 

Las versiones más actuales de estos documentos disponibles a la hora de 

producción son incluidas en el CD-ROM que se entrega conjuntamente con la 

herramienta de depuración eZ430-F2013. El sitio Web del MSP430 

(www.ti.com/msp430) provee a los usuarios de las versiones más recientes de 

estos documentos. 

 

La documentación en formato PDF que describe cada una de las herramientas 

del IAR (el Workbench/C-SPY, el ensamblador, el compilador C, el editor de 

enlace, y las librerías) se encuentran en las carpetas “common\doc” y “430\doc” 

dentro del directorio de instalación. Los suplementos de estos documentos, por 

ejemplo la información de última hora,  están disponibles en formato HTML en 

los mismos directorios. El archivo “430\doc\readme_start.htm” provee un punto 

de partida conveniente para navegar la documentación del IAR. 

 

En los archivos del tipo “.htm” que se encuentran localizados a todo lo largo del 

árbol de directorios del KickStart, está contenida la mayor parte de información 

actualizada y suplementa a los archivos PDF. Además, la documentación del 

KickStart está disponible mediante la ayuda en línea. 

 

Los archivos denominados “Léeme primero” (README FIRST) tanto del IAR 

como de TI además del documento SLAU138K.pdf pueden ser encontrados en 

el Menú Inicio → Programas → IAR Systems → IAR Embedded Workbench 

KickStart for MSP430 V4. En la Tabla 2.7 está el detalle de la información 

existente al momento del lanzamiento de la herramienta de desarrollo eZ430-

F2013 
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Herramienta  Guía del usuario  Información más a ctualizada  

Workbench/C-SPY EW430_UsersGuide.pdf Readme.htm, ew430.htm, cs430.htm, 

cs430f.htm 

Ensamblador EW430_AssemblerReference.pdf A430.htm, a430_msg.htm 

Compilador EW430_CompilerReference.pdf Icc430.htm, icc430_msg.htm 

Librería C  Clibrary.htm 

Enlazador y Librería Xlink.pdf Xlink.htm, xman.htm, xar.htm 

 

Tabla 2.7: Archivos de ayuda e información correspondientes a cada 

herramienta. (Fuente: Texas Instruments) 

 

2.4.2 FLUJO DE DESARROLLO  

 

El desarrollo de este sub-capitulo está basado en la información obtenida al 

fabricante, principalmente la información encontrada en el archivo 

“slau138k.pdf”, en el cual esta detallado el flujo de desarrollo que debe seguirse 

para programar los microcontroladores de la familia MSP430.  

 

2.4.2.1  Visión general 

 

Las aplicaciones pueden ser desarrolladas en lenguaje ensamblador y/o C 

usando el Workbench y son depuradas usando el C-SPY. El depurador C-SPY 

trabaja como una sola pieza integrada al Workbench. Sin embargo, es más 

conveniente hacer la distinción entre el ambiente de desarrollo de código 

(Workbench) y el ambiente de depuración C-SPY. El C-SPY puede ser 

configurado para operar con la Herramienta de Emulación Flash (FET – Flash 

Emulation Tool), es decir con un dispositivo real MSP430 o con un simulador 

informático del dispositivo.  

 

El término KickStart se usa para referirse al Workbench y al C-SPY 

colectivamente. Las herramientas de desarrollo del software KickStart son un 

producto del IAR. 

 

 

 



102 

 

 

2.4.2.2  Usando el ambiente de desarrollo KickStart 

 

El ambiente de desarrollo KickStart es de función limitada y posee las 

siguientes restricciones:  

 

• El compilador del lenguaje C no genera un archivo de lista de código de 

ensamblado. 

• El editor de enlace asocia un máximo de 4K bytes de código en lenguaje C, 

pero puede enlazar una cantidad ilimitada de código ensamblador. 

• El simulador introduce un máximo de 4K bytes de código. 

 

Una versión completa y sin restricciones de las herramientas de desarrollo 

puede ser adquirida en IAR. Un set de función media – llamado "Baseline", con 

una limitante en el tamaño de código C de 12K bytes y operaciones básicas en 

coma flotante está disponible en IAR. Consulte el sitio Web de IAR (www.iar.se) 

para obtener mayor información. 

 

2.4.2.3  Los Ajustes del Proyecto 

 

Los ajustes requeridos para configurar el ambiente de desarrollo (Workbench) y 

el ambiente de depuración (C-SPY) son numerosos y detallados. Revise los 

ajustes de proyecto de los ejemplos que se incluyen al instalar el software tanto 

para lenguaje C como para lenguaje ensamblador, se puede acceder a los 

ajustes del proyecto haciendo clic en el menú Project → Options con el nombre 

del proyecto seleccionado. Use estos ajustes de proyecto como plantillas al 

desarrollar sus proyectos. Note que si el nombre de proyecto no se encuentra 

seleccionado cuando los ajustes son realizados, entonces estos ajustes serán 

aplicados al archivo que se encuentre seleccionado.  

 

A continuación se explican los ajustes de proyecto recomendados o que son 

requeridos por la herramienta de desarrollo. El menú de acceso para cada 

opción se muestra entre paréntesis. 
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• Especifique el dispositivo o microcontrolador que será usado para las 

pruebas (General Options → Target → Device). 

• Habilite el tipo de proyecto a desarrollar, puede usar solo lenguaje 

ensamblador o convinar el lenguaje C y ensamblador (General Options 

→ Target → Assembler-only project). 

• Posibilite o no la generación de un archivo de salida “ejecutable” (General 

Options → Output → Output file → Executable). 

• Para depurar de manera más sencilla un proyecto hecho en lenguaje C, 

deshabilite la optimización (C/C++ Compiler → Optimizations → Size 

→ None). Esto provee de mejor soporte para la depuración. 

• Habilite la generación de la información de depuración a la salida del 

compilador (C/C++ Compiler → Output → Generate debug information). 

• Especifique la ruta donde se encuentra el preprocesador del lenguaje C 

(C/C++ Compiler → Preprocessor → Include Paths). 

• Habilite la generación de la información de depuración a la salida del 

ensamblador (Assembler → Output → Generate Debug Info). 

• Especifique la ruta donde se encuentra el preprocesador del ensamblador 

(Assembler → Preprocessor → Include Paths). 

• Para depurar el proyecto usando C-SPY, especifique un formato compatible 

en el menú Linker → Output → Format → Debug information for C-SPY, ya 

sea que utilice módulos de control de rutinas o use un módulo de emulación 

de entrada/salida. 

• Especifique la ruta donde se encuentre cualquiera de las bibliotecas usadas 

(Linker → Config → Search paths). 

• Especifique el controlador que usara con C-SPY. Seleccione la opción 

Project → Options → Debugger → Setup → Driver → FET Debugger para 

usar la depuración en el FET (por ejemplo con el dispositivo MSP430). 

Seleccione "Simulator" para realizar la depuración en el simulador 

integrado. Si el FET Debugger es seleccionado, use la opción Project 

→ Options → FET Debugger → Setup → Connection para seleccionar el 

tipo de puerto apropiado: Texas Instruments LPT-IF para el FET de 
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Interface paralela (MSP-FET430PIF) o Texas Instruments USB-IF para el de 

interfaz USB (MSP-FET430UIF) que sirve también para el eZ430. 

• Habilite el archivo "Device Description" (Debugger → Setup → Device 

description file → Override default). Este archivo indica al depurador C-SPY 

las características específicas del dispositivo que usara para la depuración. 

Este archivo depende del microcontrolador especificado en el dispositivo de 

pruebas. 

• Habilite el borrado de la memoria principal y la memoria de Información 

antes de que se envié el código del programa al microcontrolador (FET 

Debugger → Download → Erase main and Information memory). 

• Para maximizar el desempeño durante la depuración, deshabilite los puntos 

de interrupción Virtuales (FET Debugger → Breakpoints → Use virtual 

breakpoints) y también deshabilite todos los puntos de interrupción del 

sistema (FET Debugger → Breakpoints → System breakpoints on). 

 

Para configurar un proyecto rápidamente puede usar las configuraciones de 

fabrica usando el botón “Factory settings” que permite configurar el proyecto a 

un estado utilizable de manera rápida. 

 

A continuación se describen los pasos que pueden ser usados para configurar 

rápidamente un proyecto. Note que en la ficha General Options no se tiene un 

botón de seteo de valores por defecto. 

 

1. Especifique el dispositivo o microcontrolador de pruebas (General Options 

→ Target → Device). 

 

2. Habilite un proyecto en lenguaje ensamblador o un proyecto que convine 

lenguaje C y lenguaje ensamblador (General Options → Target Assembler-

only project). 

 

3. Habilite la generación del archivo de salida ejecutable (General Options 

→ Output → Output file → Executable). 
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4. Acepte los ajustes de fábrica para el compilador (C/C++ Compiler → Factory 

Settings). 

 

5. Acepte los ajustes de fábrica para el ensamblador (Assembler → Factory 

Settings). 

 

6. Acepte los ajustes de fábrica para el enlazador (Linker → Factory Settings). 

 

7. Acepte los ajustes de fábrica para el depurador C-SPY (Debugger 

→ Factory Settings). 

 

8. Escoja la opción de depuración en el microcontrolador (Debugger → Setup 

→ Driver → FET Debugger). 

 

9. Especifique el puerto activo usado para interconectarse con el FET, si es el 

depurador de puerto paralelo LPT1 escoja la opción FET Debugger 

→ Setup → Connection → Texas Instruments LPT-IF o especifique el puerto 

USB (FET Debugger → Setup → Connection → Texas Instruments USB-IF) 

si se va a utilizar la herramienta de depuración eZ430-F2013. 

 

2.4.2.4  Creando Un Proyecto Desde Cero 

 

A continuación se indican las instrucciones paso a paso necesarias para crear 

un proyecto ya sea en lenguaje ensamblador o en lenguaje C desde cero, 

permitiendo luego descargar la aplicación y correrla en el MSP430F2013 

usando la herramienta de depuración eZ430-F2013.  

 

1. Inicie el ambiente de desarrollo Embedded Workbench Kickstart, haciendo 

clic en el Menú Inicio → Programas → IAR Systems → IAR Embedded 

Workbench KickStart for MSP430 V4 → IAR Embedded Workbench. 

 

2. Cree un nuevo archivo de texto (File → New → File). 
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3. Ingrese el código de programa en el archivo de texto. Use los archivos del 

tipo “.h” para simplificar el desarrollo del código de programa. KickStart está 

provisto de archivos que definen los registros y los nombres de los 

terminales para cada microcontrolador. Estos archivos pueden simplificar 

enormemente la tarea de desarrollo del código de programa. Estos archivos 

están ubicados en el directorio “C:\ Archivos de Programa\ Embedded 

Workbench 5.0\ 430\ inc”. Para incluir el archivo .h correspondiente al 

dispositivo de pruebas en el código escrito se utiliza la sintaxis #include 

“msp430xyyy.h”. Adicionalmente, los archivos .io430xxx.h son provistos y 

optimizados para ser incluidos en el código de programa cuando se usa 

lenguaje C. 

 

4. Guarde el archivo de texto con el código de programa (File → Save). Es 

recomendable que los archivos del tipo ensamblador sean guardados con 

un sufijo ".s43" y los archivos del tipo C sean guardados con el sufijo ".c". 

 

5. Cree una nueva área de trabajo (File →New → Workspace). 

 

6. Cree un nuevo proyecto (Project → Create New Project). Seleccione la 

opción Tool chain y a continuación MSP430, luego en Project Templates 

seleccione Empty project y de un click en OK. Especifique un nombre de 

proyecto y de clic en "Save". 

 

7. Añada el  archivo de texto que contiene el código de programa al proyecto 

(Project → Add Files). Seleccione el archivo correspondiente y de un clic en 

"Open". Alternativamente, puede hacer doble clic en el archivo para añadirlo 

al proyecto. Para añadir archivos de lenguaje ensamblador al proyecto debe 

cambiar el tipo de archivo presentado por default en el dialogo “Add Files” 

que es  “C/C++”. Para ver archivos del tipo ensamblador “.s43”, seleccione 

“Assembler Files” en el menú contextual “Files of type”. 

 

8. Guarde toda el área de trabajo (File → Save Workspace). Especifique un 

nombre para el área de trabajo y de un clic en "Save". 
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9. Configure ahora las opciones del proyecto (Project → Options). Para cada 

una de estas sub categorías: General Options, C/C++ Compiler, Assembler, 

Linker, Debugger, aceptar los valores por defecto con las siguientes 

excepciones: 

• Especifique el tipo de microcontrolador o dispositivo de pruebas (General 

Options → Target → Device). 

• Habilite el tipo de proyecto ya sea solo en lenguaje ensamblador o en 

lenguaje C y ensamblador combinados (General Options → Target 

→ Assembler-only project). 

• Habilite la generación del archivo de salida ejecutable (General Options 

→ Output → Output file → Executable). 

• Para realizar la depuración sobre el FET (por ejemplo el MSP430), de un 

clic en el menú Debugger → Setup → Driver → FET Debugger. 

• Especifique el puerto que se usara para interactuar con el FET (FET 

Debugger → Setup → Connection). 

 

10. Compile el proyecto (Project → Rebuild All). 

 

11. Depure la aplicación creada usando el C-SPY (Project → Debug). Esto 

inicia el depurador C-SPY que toma el control del dispositivo de pruebas, 

borra su memoria, luego la programa con la aplicación, y finalmente reinicia 

el microcontrolador o dispositivo de pruebas. 

 

En el anexo B.7 se encuentra la lista de las preguntas más frecuentes, en la 

sección A.3 en el FAQ de Debugging se pueden ver casos en que C-SPY 

no pudiera comunicarse con el dispositivo y que se debe hacer en los 

mismos. 

 

12. Para iniciar la aplicación haga clic en Debug → Go. 
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13. Para detener la aplicación haga clic en Debug → Stop Debugging, esto 

detiene el depurador C-SPY saliendo del mismo y permite regresar al 

Workbench. 

 

14. Si desea salir del Workbench haga clic en File → Exit. 

 

2.4.2.5  Administración de la pila “stack” del microcontrolador y los 

archivos .xcl 

 

El tamaño que se reserva para la pila puede ser cambiado a través del cuadro 

de diálogo que se encuentra en las opciones del proyecto (General Options 

→ Stack/Heap) o a través de la modificación directa de los archivos de control 

de enlazador “.xcl”. Estos archivos son introducidos al enlazador y contienen 

sentencias que controlan la asignación de memoria del dispositivo (memoria 

RAM, memoria flash). Para mayor información sobre los archivos “.xcl” vea la 

documentación XLINK de IAR. Los archivos “.xcl” se suministran con el FET y 

se encuentran en el directorio C:\ Archivos de Programa\ Embedded 

Workbench 5.0\ 430\ config\ lnk430xxxx.xcl. En este archivo se define un 

segmento re-localizable (RSEG) llamado CSTACK. CSTACK es usado para 

definir la región de la memoria RAM que será usada para la pila de sistema 

dentro de programas escritos en lenguaje C. El segmento CSTACK también 

puede ser usado en programas escritos en lenguaje ensamblador (MOV.W 

#SFE(CSTACK), SP ). CSTACK está definido para extenderse desde la última 

ubicación de la memoria RAM por un espacio de 50 bytes. 

 

Existen otras sentencias en el archivo “.xcl” que definen otras regiones de 

memoria re-localizables que son asignadas desde la primera ubicación de la 

memoria RAM hacia la parte inferior de la pila. Es crítico notar lo siguiente: 

 

• Los archivos “.xcl” proporcionados con el FET reservan 50 bytes de la 

memoria RAM para la pila, indistintamente si esta cantidad de espacio de 

pila es requerido en realidad o si es suficiente para la aplicación. 
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• No existe ninguna rutina de comprobación de la pila. La pila puede rebosar 

los 50 bytes reservados y posiblemente sobrescribir los otros segmentos de 

memoria. Ningún error es presentado en caso de que esto suceda. 

 

Además, los archivos “.xcl” proporcionados pueden ser modificados para 

cambiar el tamaño de la pila de acuerdo a las necesidades de la aplicación. 

Para esto modifique la variable D_STACK_SIZE=xx que permite reservar xx 

bytes para la pila. Note que el archivo “.xcl” también reserva 50 bytes para la 

pila denominada "heap" en caso de ser requerido, por ejemplo, por la función 

“malloc()”. 

 

2.4.2.6  Cómo generar el archivo .txt de Texas Instruments (y otros formatos 

de archivo) 

 

El enlazador del Kickstart puede ser configurado para generar archivos en el 

formato “.txt” de TI para usarlos con los programadores GANG430 y PRGS430. 

Si desea cambiar el formato, simplemente haga clic en el menú Project 

→ Options → Linker → Output → Format → Other → msp430-txt. Los formatos 

para Intel™ y Motorola™ también son soportados y pueden ser seleccionados. 

 

Para mayor información, consulte en el anexo B.7, en la sección A.2 del FAQ, 

bajo el subtítulo de “Program Development”. 

 

2.4.2.7  Visión general de los programas de ejemplo 

 

Los programas de ejemplo para los dispositivos MSP430 se encuentran en el 

directorio C:\ Archivos de Programa\ Embedded Workbench 5.0\ 430\ 

FET_examples. Cada carpeta contiene códigos de ejemplo en lenguaje 

ensamblador y lenguaje C. 

 

El archivo denominado “Flashing the LED.eww” organiza el código de 

demostración convenientemente en un solo espacio de trabajo. Este contiene 

el código de programa en lenguaje ensamblador y en lenguaje C para cada una 
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de las familias de dispositivo MSP430. Las versiones de depuración y “release” 

son proporcionadas en cada uno de los proyectos. 

 

El archivo “contents.htm” organiza y documenta convenientemente los 

ejemplos que se encuentran en dicha carpeta. 

 

Existen ejemplos adicionales que pueden ser encontrados en la página de 

inicio del MSP430 bajo el nombre de “Code Examples”. 

 

Tome en cuenta que algunos ejemplos requieren de un cristal oscilador externo 

de 32KHz conectado en el terminal LXFT1, y que no todos los FETs están 

provistos de este terminal. 

 

2.4.2.8  Como usar C-SPY 

 

En el anexo B.8 se encuentra una lista completa y la descripción de cada uno 

de los menús específicos del FET. Aquí se analizara las principales funciones 

del depurador  C-SPY, comenzando por los puntos de interrupción. 

 

2.4.2.8.1 Tipos de puntos de interrupción 

 

El mecanismo de punto de interrupción usa un número limitado de recursos de 

depuración integrado en el dispositivo, específicamente, n registros de punto de 

parada como se indica en la Tabla 2.8 Cuando se setean n o menos puntos de 

parada, la aplicación avanza a la velocidad máxima de dispositivo, es decir, 

ejecuta el código en tiempo real. Cuando se utiliza mas de los n puntos de 

parada disponibles en hardware y está activado el uso de puntos de parada 

virtuales (FET Debugger → Breakpoints → Use virtual breakpoints), la 

aplicación se ejecuta con el control del PC anfitrión. El sistema funciona a una 

velocidad mucho menor pero brinda puntos de parada de software ilimitados, 

es decir, no se ejecuta la aplicación en tiempo real. Durante este modo, el PC 

repetidamente ejecuta un paso en el microcontrolador e interroga el dispositivo 

después de cada operación para determinar si se llego o no a un punto de 

parada. 
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Tanto la dirección de memoria del código como el valor de una variable pueden 

ser usadas como puntos de parada. Ambos requieren de dos puntos de parada 

físicos del MSP430 cada uno. 

 

JTAG de 

4 hilos 

Spy-By-

Wire de 

2 hilos 

# de 

breakpoints 

Rango de 

breakpoints 

Control de 

reloj 

Secuenciador 

de estado 

Seguidor 

de 

memoria 

X X 2 --- X --- --- 

--- No disponible  X Disponible 

Tabla 2.8: Número de “Breakpoints” en el microcontrolador MSP430-f20xx y 

otras características de emulación. (Fuente: Texas Instruments) 

 

2.4.2.8.2 Usando los “Breakpoints” o puntos de parada 

 

Si el depurador C- SPY es iniciado con más de los n puntos de parada 

disponibles en hardware y los puntos de parada virtuales están deshabilitados, 

un mensaje informa al usuario de que solamente n puntos de parada de tiempo 

real son posibles y uno o más de los puntos de parada restantes son 

desactivados. Note que el Workbench permite setear cualquier número de 

puntos de parada, sin considerar la configuración de los puntos de parada 

virtuales en C-SPY. Entonces si los puntos de parada virtuales están 

desactivados, un máximo de n puntos de parada pueden ser seteados dentro 

del C-SPY. 

 

Para poder resetear el microcontrolador temporalmente se requiere de un 

punto de interrupción, esto si la opción Project → Options → Debugger 

→ Setup → Run To está activada. Para mayor información revise en el anexo 

B.7, en la sección de FAQ, Debugging #32.  

 

El comando "Run To Cursor " (Ejecutar hasta el cursor) requiere de un punto 

de parada temporalmente. Por consiguiente, solamente n - 1 puntos de parada 

puede estar activos cuando se ejecuta este comando, esto si los puntos de 

parada virtuales se encuentran desactivados. Mayor información se encuentra 
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en el anexo B.7, en la sección FAQ, Debugging #33. Entonces, si mientras se 

procesa un punto de parada, una interrupción se activa, el depurador C-SPY se 

detiene en la primera instrucción de la rutina de servicio de la interrupción. 

Sobre este tema, se puede ver más información en el anexo B.7, en la sección 

FAQ, Debugging #26. 

 

2.4.2.8.3 Usando “Single Step” 

 

Cuando se depura un programa escrito en lenguaje ensamblador: 

 

• Los comandos "Step Over", "Step Out", y "Next Statement" funcionan de la 

misma manera que "Step Into"; esto es, la instrucción en curso es ejecutada 

a la máxima velocidad. 

 

• Una operación de un solo paso de una instrucción "CALL" (llamado a 

subrutina), detiene la ejecución en la primera instrucción de la función 

solicitada.  

 

• Para realizar el comando Step Over en una llamada de función "CALL" y 

permitir que se ejecute este comando a la máxima velocidad disponible, se 

reemplaza este comando, primero ubicando un punto de parada después de 

la instrucción "CALL" y luego usando el comando GO que permite ir al punto 

de interrupción en tiempo real. 

 

Cuando se depura un programa escrito en lenguaje C: 

 

• El comando “Single Step” permite ejecutar la próxima instrucción presente 

en el código de programa. Por lo tanto, es posible ejecutar “Single Step” 

sobre una referencia de función. Si es posible, un punto de parada en el 

dispositivo es ubicado después de la referencia de función, y finalmente un 

se ejecuta el comando GO de manera implícita. Esto causa que la función 

sea ejecutada en tiempo real. Si ningún punto de parada en hardware está 

disponible, La función es ejecutada con el control del PC, es decir a menor 

velocidad.  
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• El comando “Step Into” es soportado. 

 

• El comando “Step Out” es soportado. 

 

Cuando se trabaja dentro del Modo Desensamblado “Disassembly mode” (View 

→ Disassembly): 

 

• Una operación “Single Step” en una instrucción que no sea CALL ejecuta la 

instrucción a la velocidad máxima del dispositivo, es decir se ejecuta en 

tiempo real. 

 

• Una operación “Single Step” en una instrucción que sea CALL coloca, de 

ser posible, un punto de parada físico en el microcontrolador después de la 

instrucción de llamada, y a continuación ejecutara el comando GO. La 

función requerida es ejecutada en tiempo real. Si ningún punto de parada 

físico en el microcontrolador está disponible antes de ejecutar el comando 

GO, la función se ejecuta con la ayuda del PC. En cualquiera de los dos 

casos, la ejecución del programa se detiene en la instrucción siguiente a la 

instrucción CALL. 

 

Es posible cambiar a “Single Step” solamente cuando las declaraciones de 

código están presentes. Los puntos de parada deben ser usados cuando se 

ejecuta una aplicación en la cual no exista cierto código fuente, por ejemplo, 

poner el punto de parada después de una instrucción CALL que ejecute una 

función para la que no exista código fuente, y luego ejecutar el comando GO 

hasta llegar al punto de parada en tiempo real. Si, durante una operación 

“Single Step”, una interrupción es activada, la instrucción en curso es finalizada 

y el depurador C-SPY se detiene ante la primera instrucción de la rutina de 

servicio de interrupción. En el anexo B.7, en la sección FAQ, Debugging #26, 

se puede encontrar mayor detalle. 
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2.4.2.8.4 Como usar la ventana de vigilancia de variables “Watch Windows” 

 

El mecanismo de vigilancia de variables del depurador C-SPY permite que las 

variables en C sean monitoreadas durante la sesión de depuración. Aunque 

originalmente no fue diseñado para hacerlo, el mecanismo de vigilancia de 

variables puede ser extendido para monitorear variables del lenguaje 

ensamblador. 

 

Suponga que las variables a vigilar están definidas en la RAM, por ejemplo: 
 

RSEG DATA16_I  ; Segmento de memoria RAM 
varword ds 2   ; 2 bytes por palabra. 
varchar ds 1   ; 1 byte por carácter. 
 

En el depurador C-SPY: 

 

1. Abra la ventana de vigilancia de variables (View → Watch). 

2. Haga clic en el menú Debug → Quick Watch. 

3. Para vigilar una variable del tipo “varword”, escriba en la descripción 

(Expression box): (__data16 unsigned int *) varword 

4. Para vigilar una variable del tipo “varchar”, escriba en la descripción 

(Expression box): (__data16 unsigned char *) varchar 

5. Haga clic en el botón “Add Watch”. 

6. Cierre la ventana de vigilancia rápida “Quick Watch”. 

7. Para la entrada creada, haga clic en el símbolo "+" para exhibir el contenido 

(o el valor) de la variable vigilada. 

 

Para cambiar el formato de la variable exhibida (por: default, binario, octal, 

decimal, hexadecimal, carácter), seleccione la variable deseada, haga clic con 

el botón derecho del mouse y luego seleccione el formato deseado. El valor de 

la variable exhibida puede ser cambiado seleccionándolo, y luego ingresando el 

nuevo valor. 

 

En el lenguaje C, las variables pueden ser vigiladas seleccionándolas y luego 

arrastrándolas y soltándolas en la ventana de vigilancia de variables. 
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Ya que los dispositivos periféricos del MSP430 usan mapeo de memoria, es 

posible extender el concepto de vigilar variables a vigilar dispositivos 

periféricos. Sea cuidadoso ya que pueden provocarse efectos no deseados 

cuando los dispositivos periféricos son leídos o escritos por el depurador C-

SPY. Para mayor información, consulte el anexo B.7, sección FAQ, Debugging  

#24. 

 

Los registros del núcleo del CPU pueden ser especificados para vigilancia 

precediendo su nombre con "#", por ejemplo: #PC, #SR, #SP, #R5. 

 

Las variables vigiladas dentro de la ventana son actualizadas únicamente 

cuando el depurador C-SPY obtiene el control del microcontrolador, por 

ejemplo al alcanzar un punto de parada o al ejecutar el comando “Single Step”. 

 

Aunque los registros pueden ser monitoreados usando la ventana de vigilancia 

de variables, usar la ventana específica para visualizar los registros (View → 

Register) es el método más recomendado. 

 

 

 



 
 

 

 

 

 

 

 

 

 

 

CAPITULO 3 
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CAPITULO 3. CONSTRUCCIÓN Y PRUEBAS 

 

3.1  DESARROLLO DEL PROTOCOLO DE PRUEBAS 

 

3.1.1  DESCRIPCIÓN GENERAL 

 

El protocolo de pruebas implementado para este proyecto tiene como propósito 

verificar la funcionalidad del prototipo y sus principales características. La 

verificación inicial se llevará a cabo mientras el prototipo se encuentre 

implementado en protoboard, una vez comprobado su funcionalidad al igual 

que la funcionalidad del programa para el PC, se procederá a la construcción 

del prototipo diseñando los respectivos circuitos impresos y montando todo el 

sistema en su respectiva caja. Para finalizar, se comprobará que la 

construcción del prototipo no tenga problemas. Todos los resultados obtenidos 

serán organizados en el subcapítulo Resultados Experimentales. 

 

3.1.1.1  Pruebas del prototipo,  hardware y software 

 

Las pruebas del prototipo comprenden la verificación del funcionamiento de 

cada uno de los módulos que lo componen con su respectivo código de 

programa. En el presente caso, existen 4 módulos, 3  de ellos utilizan la 

comunicación I2C en modo esclavo mientras que el dispositivo llamado 

“Entradas” trabaja en modo I2C Máster. Debido al tipo de comunicación y a la 

forma como están configurados, las pruebas deben realizarse con todos los 

módulos interconectados, caso contrario el prototipo no funcionará 

correctamente. 

 

Los módulos han sido desarrollados pensando en la implementación de futuras 

soluciones, lo que permite reutilizarlos en diferentes diseños siempre y cuando 

se utilicen los protocolos de comunicación I2C implementados en cada uno de 

ellos y que se encuentran en el anexo E.1. Algunas pruebas se desarrollarán 

con un dispositivo I2C Máster diferente al dispositivo llamado “Entradas” debido 
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a que este no utiliza todas las funcionalidades que ofrecen los diferentes 

esclavos. 

 

Las pruebas a llevarse a cabo en cada uno de los módulos son las siguientes: 

 

• Modulo Display:  

� Inicialización del esclavo “Display” 

� Inicialización del Display conectado al modulo 

� Control de encendido /apagado de la luz de BackLight del Display 

� Respuesta a los comandos I2C enviados por el dispositivo Máster 

 

• Modulo Teclado 

� Inicialización del esclavo “Teclado” 

� Barrido/Escaneo del teclado 

� Identificación de las teclas presionadas 

� Respuesta a los comandos I2C enviados por el dispositivo Máster 

 

• Modulo Salidas 

� Inicialización del modulo “Salidas”  

� Inicialización del estado de la memoria Flash 

� Activación de las salidas 

� Manejo de la memoria Flash para almacenamiento de datos 

� Respuesta a los comandos I2C enviados por el dispositivo Máster 

 

• Modulo Entradas 

� Comunicación RS-232 con el PC 

� Selección de entrada 

� Conversión Analógica / Digital 

� Espacio disponible en la memoria del dispositivo para la implementación 

del programa del usuario. 

� Manejo de la comunicación I2C  

 

• Prototipo en general 
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� Envío de datos AL PC 

� Envió de la memoria Flash al PC  

� Recepción del estado de las salidas (Sobre escritura) 

� Cambio de mensaje en el Display al existir enlace con el PC 

 

3.1.1.2  Pruebas del programa diseñado para la interacción usuario - 

prototipo 

 

Las pruebas que se realizaran al programa de interacción Usuario –Prototipo 

tienen como objetivo verificar el correcto funcionamiento de cada una de las 

opciones que el programa presenta al usuario, se verificará desde la creación 

de un nuevo documento que almacene la interacción, hasta ver si es posible 

salir de la aplicación sin guardar algún cambio en particular, lo que evita perder 

cambios que pueden resultar de vital importancia para el usuario. 

 

Las pruebas verificarán que el funcionamiento del programa sea normal y que 

el usuario no tenga ningún inconveniente en utilizarlo, ya sea interactuando con 

el prototipo o simplemente accediendo al contenido de la memoria flash del 

mismo. 

 

Las pruebas que se aplicarán a la interfaz del usuario para verificar que 

cualquier posibilidad de error estén contemplados son: 

 

• Configuraciones del programa,  mensajes de error y  advertencias al usuario  

• Comunicación con el prototipo, retardos y posibles desconexiones 

• Interpretación de los datos recibidos y presentación de los mismos al 

usuario 

• Funcionamiento de las opciones configuradas por parte del usuario para la 

interacción del programa con el prototipo. 

• Almacenamiento en archivos de los datos enviados por el prototipo hacia el 

PC. 
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3.2  IMPLEMENTACION DEL PROYECTO 

 

La implementación del proyecto se efectuará en 3 etapas, a saber: 

 

• Desarrollo del prototipo en Protoboard  

• Ensamblado y construcción del prototipo 

• Instalación del software creado para la interacción Usuario – Prototipo. 

 

En la etapa de desarrollo también se ejecutó el diseño de los programas 

requeridos para el funcionamiento del mismo, estos programas están 

explicados en el capítulo 2 y corresponde al código requerido por cada módulo 

del prototipo y también al software que permite la interacción entre el PC y el 

Prototipo.  

 

3.2.1  DESARROLLO DEL PROTOTIPO EN PROTOBOARD 

 

La implementación del prototipo en protoboard permite verificar posibles 

problemas y errores tanto en las conexiones como en el código de programa a 

instalarse en cada uno de los microcontroladores.  

 

Siguiendo los diagramas esquemáticos presentados en el capítulo 1, se 

presenta en la figura 3.1 una imagen fotográfica del prototipo armado en 

protoboard y funcionando. La fuente de alimentación se encuentra en una 

protoboard más pequeña pero junto al proyecto principal. 
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Figura 3.1: Imagen fotográfica del prototipo armado en protoboard. 

 

Como se puede observar, no se ha utilizado el microcontrolador provisto en la 

herramienta EZ430-F2013, en su lugar se ha utilizado dispositivos de la misma 

familia (MSP430-F201X) cuyo encapsulado es de diferente presentación. 

 

La programación de estos dispositivos se la realiza con la misma herramienta 

EZ430-F2013, lo que cambia es el conector con el que se los puede programar. 

En la figura 3.2 se muestra una fotografía con el programador desarrollado para 

este tipo de encapsulado incluido el programador original EZ430-F2013 y el 

microcontrolador del fabricante TI. En el anexo F.1 se incluye el diagrama 

esquemático que se utilizó para crear el programador. 
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Figura 3.2: Fotografía en la que se muestra el programador desarrollado para 

este tipo de encapsulado incluido el programador EZ430-F2013 y el 

microcontrolador del fabricante TI. 

 

3.2.2  ENSAMBLADO Y CONSTRUCCIÓN DEL PROTOTIPO 

 

3.2.2.1  Diseño de los circuitos impresos 

 

Para ejecutar la construcción del prototipo se requiere del diseño de los 

circuitos impresos, estos diseños fueron desarrollados con el programa Altium 

Designer versión Winter 09. El diseño del circuito impreso de cada modulo 

desarrollado anteriormente ha sido diseñado por separado y su interconexión 

se la realizara al finalizar la construcción. En las figuras 3.4, 3.5, 3.6 y 3.7 se 

muestran los gráficos con cada uno de los diseños que serán implementados 

para cada uno de los módulos que integran el prototipo. La fuente de 

alimentación será implementada en un circuito impreso con perforaciones 

previamente fabricadas. En el CD que complementa este proyecto se 

encuentra el directorio “PCB” que contiene todos los archivos creados dentro 

del programa Altium Designer y que permiten la impresión de todos los circuitos 

impresos aquí mencionados. 
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Figura 3.4: Diseño del circuito impreso para el modulo Teclado. (Elaborado por 

el autor). 
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Figura 3.5: Diseño del circuito impreso para el modulo Display. (Elaborado por 

el autor). 
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Figura 3.6: Diseño del circuito impreso para el modulo Salidas. (Elaborado por 

el autor). 
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Figura 3.7: Diseño del circuito impreso para el modulo Entradas. (Elaborado por 

el autor). 

3.2.2.2  Elaboración de los circuitos impresos 
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Para la elaboración de cada uno de los circuitos impresos se utilizó papel de 

transferencia térmica para plasmar el grafico del circuito, mientras que para el 

grabado químico de las plaquetas de circuito impreso se utilizó “cloruro de 

hierro (III)” o “cloruro férrico”. En la figura 3.8 se muestra una foto con los 

circuitos impresos listos para ser atacados por el cloruro de hierro (III). Estos 

diseños fueron implementados usando “Papel de transferencia térmica” y 

posteriormente corrigiendo las respectivas fallas manualmente con un 

marcador indeleble.  

 

 

Figura 3.8: Foto con los circuitos impresos listos para ser atacados por el 

“cloruro de hierro (III)”. 

 

Una vez finalizado el “ataque” a las plaquetas, se obtienen los circuitos 

impresos listos para la ubicación de los elementos correspondientes. En la 

figura 3.9 se muestra una fotografía con los circuitos impresos listos para su 

soldado. 
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igura 3.9: Circuitos impresos listos para la ubicación de elementos. 

 

3.2.2.3  Soldado de los elementos y conexión de los módulos 

 

El soldado de los elementos se lo realiza siguiendo los diagramas 

esquemáticos utilizados para el diseño de los circuitos impresos. Para evitar 

que las pistas de cobre se oxiden, se las estaña completamente. En la figura 

3.9 se muestran las soldaduras realizadas a los elementos de cada modulo 

además de las pistas totalmente estañadas, y en la figura 3.10 se muestran los 

elementos en sus respectivas ubicaciones. 

 

 

 

 

 

 

 

 

 

 

 

Figura 3.9: Soldaduras de los elementos. 
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Figura 3.10: Ubicación de los elementos. 

 

En los diseños realizados para cada uno de los circuitos impresos se anticipó la 

necesidad de interconectar los módulos entre sí, es por esto que el circuito 

impreso correspondiente al modulo “Entradas”, es el encargado de soportar 

todas las interconexiones necesarias de los módulos. En la figura 3.11 se 

muestra la interconexión entre todos los módulos del prototipo incluido la fuente 

de alimentación, mientras se está probando su funcionalidad. 
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Figura 3.11: Interconexión de todos los módulos y pruebas de funcionamiento. 

 

3.2.2.4  Diseño de la carcasa del prototipo 

 

La carcasa o caja del prototipo será fabricada en madera, pero el diseño podrá 

ser replicado tanto en metal como en plástico. El diseño inicial será realizado 

sobre cartón, ya que este material permite su fácil manipulación y puede 

soportar los dispositivos construidos de manera temporal, permitiendo observar 

el resultado final del diseño con relativa facilidad. En la figura 3.12 se muestra 

una fotografía con el diseño en cartón de la carcasa a construirse, incluido los 

cables externos, y en la figura 3.13 se muestra una fotografía del prototipo 

finalizado. 
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Figura 3.12: Diseño en cartón de la carcasa 

 

 

Figura 3.13: Prototipo finalizado. 

 

3.2.3  INSTALACIÓN DEL SOFTWARE CREADO PARA LA INTERACCIÓN  

USUARIO – PROTOTIPO 

 

 A fin de lograr la instalación del software requerido para la interacción del 

usuario con el prototipo, en el CD que acompaña este proyecto se incluye la 

carpeta “Instaladores\Interfaz usuario”,  dicha carpeta contiene el archivo 

“Interfaz.exe” que permitirá ejecutar la instalación del programa mencionado. 
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Para poder ejecutar este programa y permitir la comunicación con el prototipo, 

los siguientes requisitos deben ser cumplidos: 

 

• Disponer de por lo menos 100 MB de espacio disponible en disco duro 

 

• Tener un puerto serial disponible  y correctamente configurado (Se puede 

utilizar un conversor USB – RS-232) 

 

• Correr en el PC uno de los siguientes sistemas Operativos: Windows 2000 

Service Pack 3; Windows 98; Windows 98 Second Edition; Windows ME; 

Windows Server 2003; Windows XP Service Pack 3, Windows Vista SP1  

 

• Tener instalado Microsoft .NET Framework, versión 2.0. Este paquete de 

instalación se incluye en el CD anexo al proyecto en el directorio 

“Instaladores\extras” con el nombre “dotnetfx.exe” 

 
Además, para permitir la programación del microcontrolador con el código de 

usuario especifico para cada aplicación, debe ejecutarse el programa 

“FET_R513.exe” que corresponde al Instalador del “IAR Embedded Workbench 

for MSP430 V4.11A Kickstart”, este archivo se encuentra en el CD adjunto al 

proyecto en la carpeta “Instaladores\Programador TI”. Los requisitos de esta 

herramienta están descritos en el capítulo 2. EL código fuente que permite 

realizar todos los cambios necesarios al programa del usuario y que debe 

editarse utilizando el programa antes mencionado se encuentra en la carpeta 

“Codigo Fuente\Tesis Micro TI V1.0” 

 

Para mayor información, en el capítulo 2 se detalla la utilización del programa 

de interacción usuario – prototipo, al igual que el uso de la herramienta para la 

programación del microcontrolador. 
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3.3  RESULTADOS EXPERIMENTALES 

 

Al igual que en el capítulo construcción y pruebas, los resultados 

experimentales se han divido en 2 etapas, cada una resume en su respectiva 

tabla el resultado obtenido por las pruebas realizadas.  

 

La tabla 3.1 muestra la información respectiva a cada prueba y el resultado 

obtenido el experimentar sobre cada uno de los módulos y en la tabla 3.2 se 

indican los resultados al ejecutar el protocolo de pruebas del programa de 

interacción Usuario - Prototipo.  

 

Nótese que existen comprobaciones que pueden calificarse únicamente como 

Satisfactoria o insatisfactoria mientras que otras se presentaran como una 

escala de aprobación, en aquellas que se precise entregar un valor concreto se 

incluirá la unidad de medida correspondiente. 

 

Modulo Tipo de prueba Resultado Observaciones 
Display Inicialización del 

esclavo “Display” 
Correcto Ninguna 

Display Inicialización del 
Display conectado al 
modulo 

Correcto Ninguna 

Display Control de encendido 
/apagado de la luz de 
BackLight del Display 

Correcto Comando no utilizado por el prototipo 

Display Respuesta a los 
comandos I2C enviados 
por el dispositivo Máster 

Correcto Algunos comandos no son utilizados 
por el prototipo 

Teclado Inicialización del 
esclavo “Teclado” 

Correcto Ninguna 

Teclado Barrido/Escaneo del 
teclado 

Correcto Soporta detección de varias teclas, esta 
característica no es utilizada por el 
prototipo 

Teclado Identificación de las 
teclas presionadas 

Correcto Ninguna 

Teclado Respuesta a los 
comandos I2C enviados 
por el dispositivo Máster 

Correcto Ninguna 

Salidas Inicialización del 
modulo “Salidas” 

Correcto Ninguna 

Salidas Inicialización del estado 
de la memoria Flash 

Correcto Ninguna 

Salidas Activación de las salidas Correcto Ninguna 
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Salidas Manejo de la memoria 
Flash para 
almacenamiento de datos 

Correcto Ninguna 

Salidas Respuesta a los 
comandos I2C enviados 
por el dispositivo Máster 

Correcto Ninguna 

Entradas Comunicación RS-232 
con el PC 

Satisfactoria Debido al procesamiento interno el 
prototipo puede no detectar el envió de 
información 

Entradas Selección de entrada Correcto Ninguna 

Entradas Conversión Analógica / 
Digital 

Satisfactoria Si la entrada es conectada directamente 
a GND (Tierra),  se detecta una 
pequeña fluctuación en el valor 
convertido y no se entrega un valor 
“cero” como es lo esperado 

Prototipo Espacio disponible en la 
memoria del dispositivo 
para la implementación 
del programa del 
usuario. 

Satisfactoria La memoria disponible en cada 
microcontrolador es de 
aproximadamente 2KB, el código de 
programa principal debe incluirse 
dentro del dispositivo Master llamado 
Entradas, este dispositivo incluye la 
librería para la comunicación I2C 
Master entre otras secuencias de 
programa, lo que deja un espacio de 
memoria “reducido” para el código de 
programa de usuario  

Prototipo Manejo de la 
comunicación I2C 

Correcto Ninguna 

Prototipo Envío de datos AL PC Correcto Ninguna 
Prototipo Envió de la memoria 

Flash al PC 
Correcto Ninguna 

Prototipo Recepción del estado de 
las salidas (Sobre 
escritura) 

Satisfactoria Para asegura la recepción del comando 
de sobre escritura por parte del 
prototipo, el PC debe enviarlo por 
duplicado. 

Prototipo Cambio de mensaje en el 
Display al existir enlace 
con el PC 

Correcto Ninguna 

Prototipo Consumo Máximo de la 
fuente de 3.4V DC 

10mA Corriente consumida por los 
microcontroladores 

Prototipo Consumo total de 
corriente DC del 
prototipo (Máxima 
carga) 

380mA Ninguna 

Prototipo Consumo de corriente 
DC de los relés 
(activados todos al 
mismo tiempo) 

240mA Voltaje de alimentación de los Relés: 
5V  

Prototipo Voltaje de alimentación 5V, 3.4V Se requiere de 2 voltajes debido a que 
los microrontroladores pueden 
alimentarse con un voltaje máximo de 
3.6 V 
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Prototipo Consumo total de 
corriente AC del 
prototipo (Máxima 
carga) 

616mA Ninguna 

Prototipo Voltaje de entrada AC 
medido (Secundario 
Transformador) 

12.99V Ninguna 

 

Tabla 3.1: Resultados obtenidos sobre el Prototipo. (Elaborada por el autor). 

 

Tipo de prueba Resultado Observaciones 
Configuraciones del 
programa,  mensajes de 
error y  advertencias al 
usuario 

Satisfactorio Los errores encontrados en el desarrollo del 
programa han sido controlados aunque no se 
descarta la posibilidad de encontrarse nuevos. Las 
advertencias al usuario que le indican el cierre de la 
aplicación sin guardar cambios, configuraciones 
equivocadas o incorrectas, entre otras, están 
desarrolladas correctamente.  

Comunicación con el 
prototipo, retardos y 
posibles desconexiones 

Satisfactorio La comunicación entre el PC y el prototipo se 
realiza sin ningún problema, una vez que el 
prototipo logra recibir el código respectivo. El 
usuario al utilizar el modulo de manejo de memoria 
Flash debe a veces repetir la petición de “envío de 
memoria” o de “borrado de memoria” debido a que 
el microcontrolador no detecta el comando 
correspondiente. 

Interpretación de los 
datos recibidos y 
presentación de los 
mismos al usuario 

Correcto Ninguna 

Funcionamiento de las 
opciones configuradas 
por parte del usuario 
para la interacción del 
programa con el 
prototipo. 

Satisfactorio Las funciones descritas en el capítulo 2 están 
implementadas y son fácilmente accesibles al 
usuario, pero,  el programa podría incluir mayores 
funcionalidades que le permitan controlar de mejor 
manera las salidas del prototipo, por ejemplo, 
mediante un programa de usuario específico que 
interprete el valor de cada entrada. 

Almacenamiento en 
archivos de los datos 
enviados por el 
prototipo hacia el PC 

Correcto Ninguna 

 

Tabla 3.2: Resultados obtenidos sobre el programa de interacción Usuario – 
Prototipo. (Elaborada por el autor). 

 

 



 
 

 

 

 

 

 

 

 

 

 

CAPITULO 4 
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CAPITULO 4. CONCLUSIONES Y RECOMENDACIONES 
 

La realización de este proyecto ha dejado diferentes conclusiones y 
recomendaciones: 

 

4.1 CONCLUSIONES 

 

• EL microcontrolador MSP430F2013 de acuerdo con el fabricante fue 

diseñado para ser usado en aplicaciones del tipo instrumental, es decir, 

para realizar mediciones y conversiones de señales, es por este motivo que 

tiene un bajo número de pines y que su consumo de energía es bajo. Este 

microcontrolador se ha adaptado perfectamente a este proyecto ya que se 

ha aprovechado la comunicación I2C disponible en el mismo. 

• Al utilizar la conversión Análogo digital Sigma/Delta se puede aprovechar 

los 16 bits que se entregan como resultado de la conversión, esto permite 

tener un rango más amplio de valores y por tanto conseguir mayor precisión 

en el uso de sensores. 

• El seleccionar las entradas analógicas utilizando el multiplexer ayuda a 

mantener el uso de un número bajo de pines, que de otra manera 

necesitaría utilizar las entradas análogas integradas en el microcontrolador, 

lo que limitaría el número de entradas disponibles. 

• La ayuda prestada por la herramienta “Flash Emulation Tools” es muy 

importante porque permite verificar cualquier problema que se presente en 

el prototipo durante su desarrollo, facilitando su construcción e 

implementación. 

• El prototipo trabaja de manera muy estable sin necesidad de estar 

conectado con el PC, lo que lo convierte en un dispositivo muy versátil al 

momento de aplicarlo en un proceso específico. 
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• El trabajo del prototipo en conjunto con el PC permite tener disponibles 

muchas más opciones al usuario para controlar un proceso. El programa 

desarrollado incluye herramientas para manipular los datos enviados desde 

el prototipo y así extender la funcionalidad del mismo. 

• El manejo de la comunicación I2C puede resultar complejo, pero aplicando 

las librerías provistas por la empresa Texas Instruments y comprendiendo el 

modo de trabajo del protocolo en su aspecto general puede facilitar la 

construcción e implementación de cualquier diseño en forma modular. 

• Los menús integrados en el prototipo son reducidos debido principalmente 

al espacio disponible en la memoria Flash de cada microcontrolador. Si se 

desea aumentar las funcionalidades debe utilizarse un dispositivo de la 

familia MSP430 que posea mayor memoria.   

• La respuesta que el PC espera a continuación de que se haya enviado un 

comando al prototipo puede tener problemas debido a los retardos que 

sufre al procesar todas las subrutinas requeridas para ejecutar el código de 

usuario incluido las funciones propias del mismo. Es por este motivo que el 

PC debe enviar más de una petición para asegurar la recepción del 

comando por parte del prototipo. 

 

4.2 RECOMENDACIONES 

 

• Al implementar un diseño es recomendable informarse bien utilizando toda 

la información del fabricante, especialmente las hojas de errata, lo que 

permitirá aplicar de manera conveniente el microcontrolador y así evitar 

problemas en la implementación. 

• Las entradas del conversor A/D sigma/delta del F2013, al usarse divisores 

de voltaje o similares, debe procurarse el uso de resistencias relativamente 

bajas (menores a 1000 ohmios), el uso de resistencias demasiado altas 

impide la circulación de la corriente mínima necesaria para el conversor, 
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esto provoca una lectura errónea del voltaje, es decir, a bajos voltajes y 

altas resistencias el conversor asume la escala máxima. 

• El uso del conversor Sigma / Delta incorporado en el microcontrolador 

MSP430F2013 proporciona una mayor precisión de la señal de entrada 

debido a que utiliza 16 bits, es así que es recomendable usar dicho 

conversor que utilizar el conversor A/D incluido en el microcontrolador 

MSP430F2012 que es de 12 bits. 

• Si se utiliza la herramienta de depuración mientras el diseño a verificarse 

tenga conectada su propia alimentación, debe evitarse que ambos voltajes 

sean suministrados al diseño al mismo tiempo. Es preferible desconectar la 

alimentación provista por la herramienta “Flash Emulation Tool” hacia el 

microcontrolador que se está depurando, de esta manera se evita posibles 

daños en la misma.. 

• Debido al tamaño de memoria Flash disponible en cada microcontrolador  

(2KB) y ya que se debe integrar la librería necesaria para la comunicación 

I2C entre otras sub-funciones, la memoria total disponible para el 

almacenamiento de datos en el prototipo es de 992 bytes. Si, en la memoria 

se almacenan los datos enviados en grupo de 2 bytes cada 10 minutos, el 

tiempo total (sin interrupciones) que puede almacenar datos el prototipo 

será de 3 días, 10 horas y 40 minutos, por lo que es recomendable extraer 

estos datos antes de que la memoria se llene. 

• Dado que las características que poseen los microcontroladores de la 

familia MSP430F2012 y MSP430F2013 en lo que respecta al número de 

pines es limitada, es recomendable utilizar el protocolo I2C para 

intercomunicar los diferentes módulos que pueden constituir un diseño en 

especial y de esta manera permitir un mejor uso de cada uno de los pines. 

• Para mayor detalle sobre cualquier aspecto del microcontrolador 

MSP430F2012 y MSP430F2013, se recomienda consultar los manuales 

provistos por la empresa Texas Instruments. Este siempre será un 

excelente punto de partida para cualquier diseño que se desee implementar 
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• Al utilizar el módulo de administración de memoria Flash, en caso de recibir 

una notificación desfavorable (Sin respuesta del prototipo), es 

recomendable realizar un nuevo intento hasta conseguir una respuesta 

favorable desde el prototipo. 

• EL uso de los microcontroladores y de herramientas programáticas como 

Visual Studio se ha vuelto muy necesario en aplicaciones prácticas en el 

área técnica, por lo que es recomendable que los graduandos investiguen 

sobre estas tecnologías y las apliquen en proyectos similares. 
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GLOSARIO 
 
 
ACLK : Auxiliary Clock (Reloj Auxiliar). ACLK puede ser escogido como 

LFXT1CLK o VLOCLK mediante software. ACLK está dividido en  factores de 

1, 2, 4, o 8 según se requiera. ACLK es escogido por software en módulos 

individuales periféricos. 

 

Byte : Conjunto de 8 bits que representan un valor decimal de 0 a 255 o un 

carácter en general 

 

DCOCLK : Digitally Controlled Oscillator Clock. Señal de reloj proveniente del 

oscilador controlado digitalmente que se encuentra integrado en el modulo 

básico de reloj 

  

Display : Periférico de visualización de datos que permite mostrar información 

al usuario. Este término se usa para denominar a los visores de caracteres de 

pequeño tamaño 

 

Deshabilitado : Estado en el cual un dispositivo esta desconectado o apagado. 

Si se trata de un bit, este tendrá el valor binario “0” o el nivel lógico necesario 

para “desactivar” la función asociada. 

 

Habilitado : Estado en el cual un dispositivo está conectado o encendido. Si se 

trata de un bit, este tendrá el valor binario “1” o el nivel lógico necesario para 

“activar” la función asociada. 

 

JEDEC: Asociación de Tecnología de Estado Sólido (Solid State Technology 

Association), antiguamente Joint Electron Device Engineering Council, es la 

rama de la EIA (Electronic Industries Alliance) para la estandarización de la 

ingeniería de semiconductores. 

 

LFXT1CLK : Low / High Frecuency External Clock (Reloj externo de Baja/Alta 

frecuencia). Oscilador de baja/alta frecuencia que puede ser usado con 

cristales de reloj de vigilancia de frecuencia baja o puede utilizar fuentes de 
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reloj externas de 32,768 Hz, o puede utilizar cristales estándar, resonadores, o 

fuentes de reloj externas entre los 400 KHz hasta los 16 MHz 

 

MCLK : Master Clock (Reloj Maestro). MCLK es escogido mediante software de 

una de estas fuentes: LFXT1CLK, VLOCLK, o DCOCLK. MCLK es dividido 

para 1, 2, 4, o 8 según sea necesario. MCLK es usado por la CPU y el sistema. 

 

Microcontrolador : Dispositivo electrónico que contiene una CPU, memoria, 

módulos periféricos y permite ser programado para realizar tareas especificas. 

 

Operando : Dato binario de 8 o 16 bits que se utiliza como parte de un 

comando dentro del código ensamblador en la programación de cada 

microcontrolador. Este dato puede servir para un operando de origen como 

para un operando de destino y depende de la instrucción utilizada 

 

Oscilador : Dispositivo electrónico que genera un tren de pulsos a una 

frecuencia especifica 

 

Pin : Patilla metálica presente en el microcontrolador. Por lo general establecen 

conexión con dispositivos o funciones internas del mismo 

 

Periférico : Dispositivo que realiza la tarea específica para la cual fue diseñado. 

Por lo general debe interactuar con señales físicas provenientes del exterior o 

en otros casos debe generarlas. 

 

Reset, reseteo, resetear : Acción de “poner en estado inicial” un dispositivo, o 

en el caso de un dato (bit, byte, word) configurarlo con el valor predeterminado, 

que por lo general es “0”. 

 

Reinicialización : Conjunto de acciones que permiten al dispositivo volver a 

iniciar su funcionamiento. En el caso de  un dato (bit, byte, word) funciona igual 

que realizar un Reset 

 



140 

 

RISC: Reduced Instruction Set Computer. Es una filosofía de diseño de CPU 

para computadoras y microcontroladores que está a favor de conjuntos de 

instrucciones pequeñas y simples que toman menor tiempo para ejecutarse.  

 

Set, seteo, setear : Acción de “activar” un dispositivo, o en el caso de un dato 

(bit, byte, word) configurarlo con el valor que indique su estado de “activación”, 

que por lo general es “1” en el caso del bit. 

 

SMCLK : Sub-main clock (Reloj subprincipal). SMCLK es configurable igual que 

MCLK, pero es usado para módulos individuales periféricos. 

 

Spy-Bi-Wire : Protocolo de depuración que utiliza únicamente 2 “hilos” para la 

comunicación con el microcontrolador. Este protocolo fue desarrollado por la 

empresa Texas Instruments. 

 

Tstg : Temperature Storage. Temperatura a la cual se puede almacenar el 

dispositivo. 

 

VCC: Voltaje en corriente directa o voltaje de alimentación.  

 

Vector de reset : Locación de memoria de 16 bits que almacena la dirección de 

memoria donde se encuentran las instrucciones a ejecutarse en caso de que el 

dispositivo reciba la orden de realizar un reset.  

 

VFB: Voltaje Fuse Blow. Voltaje necesario para quemar el fusible de protección 

de la interfaz JTAG, también llamada Spy-bi-wire 

 

VLOCLK : Very Low power Clock (Reloj de bajo consumo). Reloj de bajo 

consumo con frecuencia típica de 12 KHz. 

 

VSS: Voltaje negativo de alimentación. 

 

Word, palabra : Término utilizado para referirse a un dato de 16 bits de 

longitud. 
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ANEXO B 

HOJAS DE DATOS, DESCRIPCIÓN  Y DETALLES 

TÉCNICOS DEL MICROCONTROLADOR MSP430F2013 

 

B.1  FUNCIÓN DE LOS TERMINALES DEL MSP430X20X3 

 



  B-2 
 

 

 

 



  B-3 
 

 

 

B.2  INFORMACION DE LAS APLICACIONES (MODULOS) DEL 
MSP430X20X3 
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B.3  FUENTES DE INTERRUPCION 
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B.4  MAPA DE LAS DIRECCIONES DE MEMORIA DE LOS 

PERIFERICOS 
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B.5  CARACTERÍSTICAS ELÉCTRICAS SOBRE LOS VALORES 

RECOMENDADOS DEL MSP430X20X3 
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B.6  SET DE INSTRUCCIONES   
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B.7  FAQ: PREGUNTAS MÁS FRECUENTES  
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B.9  MENUS DE COMANDOS DEL EMULADOR C-SPY 
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C.1  HOJA DE DATOS DEL INTEGRADO MAX-232 
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ANEXO D 
 

D.1  TABLA DE CARACTERES DISPONIBLES EN LA 

MEMORIA ROM DEL DISPLAY LCD 
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ANEXO E 

COMUNICACIÓN CON LOS PERIFÉRICOS 

 

E.1  MANEJO DEL MÓDULO “DISPLAY” 

 

;   Codigos a usar: 

;   Para la comunicacion I2C se requiere usar los siguientes codigos: 

;    

;   Recepcion de datos (comando, escritura o direccion de memoria) COD + NUMBYTES 

; 

;   1) envio de comando para el LCD (0001-0001): luego de enviado este codigo se  

;   debe enviar uno de los siguientes comandos: 

; 

;   Borrar la pantalla del LCD (borrar la memoria)  0000-0001 

;   Mover el cursor/memoria al inicio               0000-0010 

;   Seteo del modo de entrada (bits opcionales)     0000-01DC 

;   C = Sentido del cursor    0=Decrementar/1=Incrementar 

;   D = Desplazamiento        0=No desplazo/1=Desplazo 

;   Estado del LCD (tiene bits opcionales):         0000-1LCP 

;   L = Estado del LCD        0=Apagado / 1=Encendido 

;   C = Cursor del LCD        0=Apagado / 1=Encendido     

;   P = Parpadeo del cursor   0=No parpadea / 1=Parpadea 

;   Desplazamiento Cursor/Pantalla(bits opcionales) 0001-DM00 

;   M = Moviento              0=Desplazo cursor/1=Desplazo display 

;   D = Direccion             0=Izquierda/1=Derecha 

; 

;   2) Escritura en LCD (caracteres): se enviara (0010-0001) y a continuacion el  

;   caracter a escribir, tomando en cuenta los codigos del LCD 

; 

;   3) Seteo de locacion de memoria LCD (0011-0001): luego de enviado este codigo se 

;   debe enviar la direccion de memoria respectiva, disponiedo de 80 bytes en total 

;   (de 0 a 79), internamente de convertira al valor requerido: 

;   de  0-39: primera linea => de 00H a 27H 

;   de 40-79: segunda linea => de 40H a 67H 
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; 

;   4) Estado de la BackLight (con bit de opcion) - (010B-0000): Permite encender 

;      o apagar la luz de BackLight del display (solo se envia 1 byte) 

;      B = Estado Backlight   0=Apagado / 1=Encendido 

; 

;   5) Apagado Automatico (con bit de opcion) - (011T-0000): Permite encender o  

;      apagar el timer interno de apagado automatico del display (1 minuto) 

;      T = Estado del Timer  0=Apagado/Encendido 

; 

;      NOTA: apagara TODO el display, asi que debe usarse la opcion siguiente  

;      para activar correctamente el Display 

;  

;   6) Encender o apagar Todo el LCD - (100E-0000):Permite apagar o encender 

completamente el LCD 

;      ademas al encender se regresa al estado anterior en que quedo el mismo 

;      E = Estado del LCD    0=Apagado/Encendido 

;    

;   7) Presentar mensajes predeterminados en pantalla: (1100-XXXX) a continuacion 

;      debe enviarse el numero de mensaje a presentar, siendo posible 256 textos  

;      diferentes. La lista de texto esta presentada el la parte de constantes.  

;      Cada texto esta predeterminado su lugar de ubicacion. Para los textos que 

;      requieren seteo de valores extras, debe enviarse el numero de bytes extras 

;      para presentar esos valores, el valor predeterminado de XXXX es 0001 (1 byte), 

;      debe sumarse los bytes que seran enviados como valores extras para dicho mensaje. 

;      El mensaje ubicara cada valor en pantalla de acuerdo a su programacion.  

; 

;   Envio de Datos: (lectura de memoria) 

;    

;   8) Simplemente se enviara el caracter que la memoria tenga disponible ese 

;      momento, es decir, si se requiere un caracter de una ubicacion de memoria  

;      especifica, DEBE enviarse previemante la direccion de memoria. EL Master 

;      simplemente envia la peticion de lectura y recibe el byte. 

 

;OJO: los textos estan justificas en un espacio de 16 caracteres 

;                   '*-*-*-*-*-*-*-*-' 

;Valores a guardar en la memoria de informacion 

            RSEG    INFO 
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; Menu general 

Texto_1_1   DB      'Controlador V1.0' 

Texto_1_2   DB      'A-Memoria  X-Fin' 

;Texto_1_2   DB      'A-Memoria B-User' 

;Menu Memoria 1 

Texto_2_1   DB      'Total:    992 B ' 

Texto_2_2   DB      'Usada:        B ' 

;Menu Memoria 2 

Texto_3_1   DB      ' Memoria Llena! ' 

Texto_3_2   DB      ' Total:    992 B' 

;Menu salidas 

Texto_4_1   DB      'Controlador y PC' 

Texto_4_2   DB      ' ! CONECTADOS ! ' 

 

E.2  MANEJO DEL MÓDULO “TECLADO” 

 

;   Codificacion para la comunicacion I2C 

; 

;   1) El teclado al detectar una tecla detendra su funcionamiento en espera del  

;      polling, si no se detecta ninguna tecla y se le hace polling, se envia 

;      (0000-0000) que significa: numero de bytes a enviar=0 

;  

;      Cuando se detecta una o mas teclas se envia el numero de teclas detectadas 

;      y a continuacion las teclas detectadas, estas teclas se detectan solamente  

;      si se presionan simultáneamente 

 

E.3  MANEJO DEL MÓDULO “SALIDAS” 

 

;   Rev:1.0 27-04-2009: se establece codificacion de envio y recepcion: 

; 

;   Recepcion: siempre se reciben 1 byte, este indicara la funcion y el numero de  

;   bytes consecutivos enviados junto a este, tendra la siguiente estructura: 

;   (CODF-NUMB), CODF= codigo de la funcion. NUMB= numero de bytes (0-15 bytes) 

;    

;   despues de analizar el primer byte, almacenara en el buffer los bytes  
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;   correspondientes y llamara a la funcion requerida. 

; 

;   las funciones posibles son (recibido desde MASTER): 

;   Modulo de RX 

;   1) recepcion del valor a guardar(1000-0010) CODF=1000 NUMB=2(0010) 

;   2) recepcion del estado de las salidas(1010-0001) CODF=1010 NUMB=1(0001) 

;   3) Borrado de memoria (1110-0000) CODF=1110 NUMB=0 

;      si se recibe este byte debe borrarse la memoria Flash donde se encuentran 

;      los datos capturados, comenzando desde cero con la captura 

;   4 y 5) si se recibe (1010-0000) significa que se desactiva el control 

;      de salida externo, Si se recibe (1011-0001) significa que se activa el control 

;      de salida externo ademas del byte de salida actual, recepcion del estado  

;      de las salidas externo(1011-0001) CODF=1010 NUMB=1(0001) 

; 

;   Modulo de TX (Primero Master envia peticion!) 

;   TX1) peticion de envio del estado de las salidas(0010-0000) CODF=0010 NUMB=0 

;      Master espera la recepcion de 1 byte con el estado de las salidas 

;      despues de enviar este byte (se deja indicando para TX este byte) 

;   TX2) peticion de envio del total de memoria capturada(0100-0000) CODF=0100 NUMB=0 

;      Master esperara 2 bytes con el tamaño total de bytes a recibir 

;      16 bits = 0 a 65535 bytes (0 en caso de no haber nada que enviar) 

;       Nota: el total de bytes disponibles es de 992. 

;      OJO: se complementa con la peticion siguiente: 

;   TX3) Peticion de envio de los datos de la memoria capturada (0110-0000) CODF=0110 

NUMB=0 

;      indica que ahora debe enviarse la memoria capturada. 

;        

;      al finalizar, si se borra o no la memoria depende del envio del comando. 

 

E.4  COMUNICACIÓN PROTOTIPO - PC 

 

'Version 0.2 
' 
'1)Conexion con el PC: se envia desde el PC el sigu iente byte: 
'byte = (1000|0000) Codigo PC 
'Se debe contestar con el siguiente byte 
'byte = (1000|0001) Codigo Micro 
'si el PC no recibe esta contestacion, dara por ter minada la 
comunicacion 
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' 
'Una vez establecida la comunicacion, el Micro envi ara los datos  
despues de recibir el codigo 
'de PC, para iniciar una nueva transmision debe el PC realizar una 
nueva peticion. 
'Si el micro o el pc no reciben una respuesta, term inara la 
comunicacion 
' 
' 
'OJO: la temporizacion la llevara el PC, transmitir a cada 250ms, pero 
el micro estara pendiente 
'cada 2 segundos, es asi que en caso de desconexion , el micro pasara a 
estar desconectado y el PC tambien 
' 
' 
'2)El valor de las salidas y entradas se enviara co mo un unico 
paquete, se recibira 
'primero un byte de anuncio y luego 9 bytes de dato s  
'Los 9 bytes estan determinados si no se ha impleme ntado el envio de 
otros datos! 
'Byte de anuncio: (0001|1001) (el numero 9 esta ind icado) 
' 
'Nota: las Salidas utilizaran la siguiente codifica cion de 1 byte: 
'Byte (0010|ABCD): A,B,C,D estado de la salida 1,2, 3,4 respectivamente 
' 
' 
'Al finalizar la recepcion, el PC debe enviar de nu eva cuenta el 
codigo de PC, 
'para volver a pedir un envio de datos. El byte de salidas es el 
mismo. 
' 
' 
'3) Se permitira Sobre-escribir el valor de las sal idas, sin importar 
el estado  
'actual seteado por el prototipo, se enviara un byt e que indique la 
activacion 
'o desactivacion del mismo: 
'(0011|000X) X=Activado/Desactivado= 1/0 
' 
' 
'4) la obtencion de datos de la memoria Flash del m icro se realiza 
primero enviando 
'del PC el byte (0100|0000), se espera el codigo de  envio de memoria 
(0100|0010),  
'a continuacion se envia el total de bytes capturad o LSB y MSB en ese 
orden (el numero 2 esta indicado) 
'Seguido el microcontrolador enviara los bytes corr espondientes sin 
esperar ninguna señal del PC 
' 
' 
'Si se reciben todos los bytes sin ningun problema,  el Pc puede o no 
enviar el  
'codigo de borrado de memoria (0101|0000), para ind icar la 
finalizacion el microcontrolador enviara 
'el codigo (0101|0001). El tiempo que tarda en borr ar la memoria es 
minimo. 
'  
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F.1  PROGRAMADOR PARA LOS DISPOSITIVOS DE LA 

FAMILIA MSP430-F20XX 

 

 

Fuente: Texas Instruments; SLAU176A.pdf. 

 

 


